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Setting Up the LaserWriter 8500

Main features of the printer
m Print quality The printer has a resolution of 600 dots per inch (dpi). Its
FinePrint feature smoothes text, and its PhotoGrade feature improves
graphic images.
m Speed The printer prints up to 20 pages per minute.
m Multiplatform support You can connect the printer to Mac OS, Windows, and
UNIX computers.
m Connectivity The printer offers LocalTalk, Ethernet, and parallel
connections.
m Automatic traffic control The printer can be connected to many computers
and networks using the printer’s LocalTalk, Ethernet, and parallel ports.
The printer prints only one user’s job at a time, but it manages incoming
print jobs from all ports so that no printing conflicts or problems occur.
m Fonts The printer supports both TrueType and PostScript™ fonts. The
printer has 136 built-in PostScript Level 3 fonts.
m Hard disk option You can attach an external SCSI hard disk to store
downloadable fonts.
m Energy saving The printer can automatically lower its power consumption
when it’s not being used.
m PostScript 3 The printer is based on the Adobe™ PostScript 3 imaging
language, which improves performance and image quality.
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m Flexible paper handling In the standard configuration, you can print up to 650
sheets (500 in the standard paper cassette plus 150 in the multipurpose
tray) without changing paper. You can easily add two 500-sheet feeder and
cassettes and a 75-envelope cassette (replaces a 500-sheet cassette). The
printer supports large paper sizes (up to 13" x 20") and full-bleed printing
for most paper sizes. The printer also supports duplex printing (printing on
both sides of the paper) when the optional duplex printing unit is attached.

Choosing a place for the printer
Choose a flat, stable area with adequate room around the printer. The area
should be well ventilated and away from direct sunlight or sources of heat,
cold, or humidity.
Allow enough space
to open the door.

Allow space to open the top cover.

IMPORTANT Keep the printer’s
vents unobstructed for proper operation
and cooling.

Make sure you have
enough space to open
the paper cassette.

See Appendix D, “Technical Information,” for more information about the
physical requirements of the printer.
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Important safety instructions
WARNING This equipment is intended to be electrically grounded. Your
printer is equipped with a three-wire grounding plug—a plug that has a
third (grounding) pin. This plug will fit only a grounded AC outlet. This
is a safety feature. If you are unable to insert the plug into the outlet,
contact a licensed electrician to replace the outlet with a properly
grounded outlet. Do not defeat the purpose of the grounding plug!

For your own safety and that of your equipment, always take the following
precautions.
Disconnect the power plug (by pulling the plug, not the cord) if any of the
following conditions exists:
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your printer is exposed to rain or any other excess moisture
m your printer has been dropped or the case has been otherwise damaged
m you suspect that your printer needs service or repair
m you want to clean the case (use only the recommended procedure
described in Chapter 10)
Be sure that you always do the following:
m Keep the printer’s vents free from obstruction.
m Keep your printer away from sources of liquids, such as washbasins,
bathtubs, shower stalls, and so on.
m Protect your printer from dampness or wet weather, such as rain, snow, and
so on.
m Read all the installation instructions carefully before you plug your printer
into a wall socket.
m Keep these instructions handy for reference by you and others.
m Follow all instructions and warnings dealing with your system.
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WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.

Unpacking the printer
IMPORTANT The printer weighs approximately 60.5 pounds (approximately

27.5 kilograms). Don’t lift it by yourself.

`
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1

Remove the molded foam packing material located on either side of the printer.

2

Lift the printer out of the box and remove the printer from the plastic bag.

3

Make sure you have everything shown here:

LaserWriter 8500 printer

Toner cartridge

Power cord

CD-ROM disc
(Some printers come
with floppy disks instead.)
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4

You also need to obtain whatever cables your networks require.
Parallel interface cable

LocalTalk connecting kit

Ethernet transceivers
and cables
10 BASE-T

5

Remove any packing tape on the printer.

6

Remove the paper cassette from its packing material and remove any packing tape.

Installing the toner cartridge
The toner cartridge contains the dry powder that the printer uses instead of
ink. Each cartridge lasts approximately 14,000 pages, depending on the kind
of printing you do. If you use the printer to produce more graphic images
than text, you may need to change cartridges more often.
WARNING Use only toner cartridges designed for use with your printer.

Other cartridges will not fit and may damage the printer.
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1

Open the multipurpose tray and then the printer top cover.

If you’re replacing a toner cartridge, remove the old cartridge.
To remove an old cartridge, grasp the orange handles on the cartridge and pull
toward you.
2

Take the cartridge out of its packaging.

3

Distribute the toner powder by gently rocking the cartridge back and forth.
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4

Firmly pull the tab directly away from the cartridge to remove the sealing tape.

WARNING Pull the tab straight out of the cartridge. Don’t pull too quickly

or at an angle—either might damage the seals on the cartridge.

5

Align the rollers on the sides of the toner cartridge with the arrows inside the printer,
then slide the cartridge into the printer. Make sure the toner cartridge is inserted all the
way and properly seated inside the printer.

Note the position of the arrow on top of
the cartridge and inside the printer.
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6

Close the printer.

The top cover clicks into place.
Note: If the printer’s top cover does not close properly, the toner cartridge is
not installed correctly. Check to make sure the toner cartridge is properly
inside the printer.

Wait to install the printer options
If you purchased any of the following options, wait to install them until
you’ve connected the printer to your network:
m duplex printing unit
m paper and envelope cassettes
m memory
By waiting, you can ensure the printer is working correctly (thus simplifying
troubleshooting).

Loading paper
You can load paper into the paper cassette or the multipurpose tray, or both.
The multipurpose tray can hold up to 150 sheets of paper of various sizes, as
well as envelopes, transparencies, and sheets of labels. See Appendix D for a
complete list of paper sizes that can be used with the multipurpose tray. The
exact number of sheets the multipurpose tray can hold depends on the weight
of the paper. You can also use the tray for manual feed jobs.
The paper cassette can hold up to 500 sheets of paper—U.S. letter size, U.S.
legal size, executive, A4, or B5. See Appendix D for a complete list of paper
sizes that can be used with the paper cassette.

Setting Up the LaserWriter 8500

9

The cassette can accept papers in long-edge feed (LEF) and short-edge feed
(SEF) orientation. Use LEF whenever possible. LEF orientation typically
results in reduced printing time.

long-edge feed (LEF)

short-edge feed (SEF)

The cassette automatically senses paper orientation, so you don’t have to
specify it every time you print.
Note: The multipurpose tray cannot automatically sense paper orientation.
Do not use SEF orientation with the multipurpose tray.

Choosing paper
The printer prints on standard laser-quality or photocopier paper (16- to
28-pound stock). For the best results, Apple recommends 20-pound stock.
The printer can accept stock of up to 32 pounds from the multipurpose tray.
You can also expect excellent results on most colored and textured papers.
The printer produces high-quality transparencies for overhead projection.
Medium-weight photocopier transparencies work best. If you experience
difficulties when attempting to print transparencies with automatic feed, use
manual feed instead.
WARNING Do not use heat-transfer (thermal) transparencies in the

printer. They will not print properly and may separate in the printer.
To avoid paper problems, keep the following potential trouble sources
in mind:
m Temperature Some letterheads are printed with low-temperature dyes that
vaporize and smear at the temperatures inside the printer. Some glossy,
coated letterheads may lose their coating in the printer. Similarly, some
envelopes may seal or come unglued during printing. Using high-quality
stationery and envelopes should ensure satisfactory results.
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m Paper texture The printer may not print well on rough or highly textured
paper. Try a few sheets to test the quality.
m Paper finish The printer may not print well on some papers with a glossy
finish. Again, test a few sheets of any unusual paper stock you wish to use.

Loading paper into the cassette
1

Prepare a stack of paper.

You can load up to 500 sheets of 20-pound photocopier paper. Make sure the
edges are even on all sides before inserting the stack of paper.
2

Remove the plastic cover from the paper cassette.
Push down on paper tray.

Remove the plastic cover to load paper.

3

If necessary, push down gently on the paper tray until it rests against the bottom of the
cassette and locks into place.
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4

Set the length guide to match your paper’s length. Move the length guide by tilting it
forward and then sliding it into place. Make sure the guide fits into the marked slots.

The cassette is marked with positions for various paper sizes.
Squeeze handles together and slide guide
to fit the size of paper you are using.
Opposite guide will travel in unison.

Tilt slightly forward and slide guide
to fit the size of paper you are using.

5

Set the width guide to match your paper’s width. Move the width guide by pinching the
colored tabs and sliding it into place.

To improve print performance, it is recommended that you load paper in the
long-edge feed (LEF) orientation whenever possible.
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6

Slide the stack of paper into the cassette, making sure the paper is under the brackets at
the front of the cassette.

Push the paper down if necessary, but don’t overload the cassette, or the paper
may jam when you print.
Make sure the paper fits
under these corner brackets.
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7

Place the plastic cover on top of the cassette and slide the cassette into the printer.

Push the cassette in all the way.
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Loading three-hole punched paper and letterhead paper
If printing SEF, load three-hole punched paper face up, with the holes toward
the left side of the cassette. Load letterhead paper face up, with the tops of the
pages at the back of the cassette (opposite the handle end).
If printing LEF, load three-hole punched paper face up, with the holes toward
the front of the cassette. Load letterhead paper face up, with the tops of the
pages toward the left side of the cassette.
Align letterhead and three-hole
punched paper as shown.
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Loading paper into the multipurpose tray
The multipurpose tray can hold up to 150 sheets of various sizes, as well as
envelopes, transparencies, and sheets of labels. The exact number of sheets
the multipurpose tray can hold depends on the weight of the paper.
You can use the multipurpose tray for all your printing jobs. You can keep
a small stack of paper in the tray and let the printer feed the paper
automatically, or you can use the multipurpose tray for manual feed printing.
Note: Load paper in the multipurpose tray in the LEF orientation.
To open the multipurpose tray:
1

16

Chapter 1

Gently open the door.

2

Adjust the guides to match your paper’s length or width and place the paper in
the tray.

Be sure not to adjust the guide so tightly against the stack that it causes
binding or rumpling of the paper.

Slide the width guides so
that they rest against the paper.

3

Close the multipurpose tray door.

Note: Some paper sizes may be too large to close the multipurpose tray door.
For these paper sizes, leave the multipurpose tray door open.
For more information on printing with the multipurpose tray, see Chapter 6 if
you have a Mac OS–based computer, or see Chapter 7 or Chapter 8 if you
have a DOS- or Windows-based computer.
Loading three-hole punched paper or letterhead paper in the multipurpose tray
Load three-hole punched paper face up, with the holes toward the front of the
multipurpose tray. Load letterhead paper face up, with the tops of the pages
toward the left side of the tray.
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Connecting the printer
You can connect the printer to many computers and networks using the
printer’s LocalTalk, Ethernet, and parallel ports. The printer prints only one
user’s job at a time, but it manages incoming print jobs from all ports so that
no printing conflicts or problems occur.
Note: If you are connecting the printer to a network with routers that
combine LocalTalk and EtherTalk into one logical zone, only one printer port
should be connected to the network. Apple recommends Ethernet.

LocalTalk port
Twisted-pair Ethernet port
AAUI Ethernet port
Communication switch
1284C parallel port
SCSI connector for hard disk

Port

Network protocols

Computer

LocalTalk

AppleTalk

Mac OS

Ethernet

AppleTalk (EtherTalk)

Mac OS

Novell NetWare

Windows

Novell ATPS

Mac OS

TCP/IP

UNIX, Mac OS, Windows

—

Windows and DOS

Parallel

Note: Do not connect both an Ethernet AUI adapter and an Ethernet twistedpair cable to your printer at the same time. The printer will always use the
twisted-pair connection.
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Connecting to a LocalTalk network
If you have an existing LocalTalk network, here’s how to add the printer to it.
1

Obtain a LocalTalk connecting kit.

Connector box

LocalTalk cable

LocalTalk connecting kits come in many varieties. Yours may look different.
2

Plug the connector box into the LocalTalk port (ˆ) on the printer.

3

Connect the printer to the network in one of these two ways:

m To connect the printer to the end of a LocalTalk network, use the LocalTalk
cable to connect the empty socket of the nearest device’s connector box to
the printer’s connector box.
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m To connect the printer between two devices on a LocalTalk network,
disconnect one LocalTalk cable from the connector box of the device
immediately to the left or right of the printer and plug it into the new
printer’s connector box. Then use the new LocalTalk cable to connect the
free socket on the printer’s connector box to the socket you freed on the
other device’s connector box.

What to do after connecting to a LocalTalk network
m If you wish to connect the printer to other networks, or to connect the
printer directly to an IBM PC or compatible computer, see the appropriate
sections later in this chapter.
m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.
See Chapter 2 for more information about setting up the printer on a
LocalTalk network, or Appendix B for information about setting up the
printer on a NetWare network running ATPS.
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Connecting directly to a single Mac OS–based computer
Use this method to connect a single Mac OS–based computer to the printer.
1

Obtain two LocalTalk connecting kits.

2

Plug one LocalTalk connector box into the computer’s printer ([) port.

3

Plug one end of the cable into the LocalTalk connector box on the computer.

4

Plug the second LocalTalk connector box into the printer’s LocalTalk (ˆ) port.
Printer
port

ˆ

LocalTalk
port
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What to do after connecting to a single Mac OS–based computer
m If you wish to connect the printer to other networks, or to connect the
printer directly to a Windows or DOS computer, see the appropriate
sections later in this chapter.
m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.
See Chapter 2 for more information about setting up the printer on a
LocalTalk network, or Appendix B for information about setting up the
printer on a NetWare network running ATPS.

Connecting to an Ethernet network
A single Ethernet cable can carry a number of network protocols, including
AppleTalk (called EtherTalk when it’s on an Ethernet network), Novell
NetWare, and TCP/IP (Transmission Control Protocol/Internet Protocol).
You can connect the printer to your network with an Ethernet AUI adapter or
twisted-pair Ethernet.
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To connect the printer to an Ethernet network running any combination of
these protocols, follow these steps:
1

Obtain a twisted-pair cable or an Ethernet transceiver and a length of Ethernet cable
appropriate for your network’s medium type—thin or thick.
IMPORTANT Do not connect both an Ethernet AUI adapter and an Ethernet

twisted-pair cable to your printer at the same time. The printer will always
use the twisted-pair connection.

Apple Ethernet
thin coaxial transceiver

Apple Ethernet
AUI adapter

2

Plug the short cable from the transceiver into the Ethernet port (G) on the printer.

3

Connect the printer to the Ethernet network in one of these three ways:

m To connect the printer to the end of an Ethernet network, use the Ethernet
cable to connect the empty socket of the nearest device’s transceiver to the
printer’s transceiver, as shown here.
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m To connect the printer between two devices on an Ethernet network,
disconnect one Ethernet cable from the transceiver of the device
immediately to the left or right of the printer and plug it into the new
printer’s transceiver. Then use the new Ethernet cable to connect the free
socket on the printer’s transceiver to the socket you freed on the other
device’s transceiver.

m To connect the printer to an Ethernet hub, see the documentation that came
with the Ethernet hub.

What to do after connecting to an Ethernet network
m If you wish to connect the printer directly to a Windows or DOS computer,
see the next section.
m If you’re finished connecting the printer, skip to “Adjusting Communication
Settings,” later in this chapter.
See Chapters 2, 3, and 4 for more information about setting up the printer for
different network interfaces.
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Connecting to a Windows or DOS computer with a parallel cable
1

Obtain a parallel interface cable like this one.

25-pin D sub
connector

2

1284C
connector

Use the parallel cable to connect the computer to the printer:
Attach the cable’s smaller connector
to the parallel port on the printer.
Secure the clips.
Attach the cable's larger connector to
the parallel port on your computer.
(Your computer’s parallel port may be
in a different location.)

What to do after connecting directly to a Windows or DOS computer
m Read the rest of this chapter.
m See Chapter 3 for more information about setting up the printer.
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Connecting the power and turning on the printer
Once you’ve connected the printer to your networks, you’re ready to start up
the printer. Follow these steps to make sure everything is working correctly.
1

Make sure the printer is turned off.

‘ Paper Jam light
» Paper Out light
’Toner Low
U Ready/In Use light

Communication
switch

On position

Off position

2

Plug in the printer.

Insert the socket end of the power cord into the recessed receptacle on the
back of the printer. Plug the other end into a grounded (three-hole) AC outlet.
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3

Press the “|” on the power switch to turn the printer on.

The printer takes a minute or two to warm up, and then it automatically prints
a startup page. It prints the startup page every time you restart. You can
turn the startup page off using either the Apple Printer Utility (described
in Appendix A) or the Apple LaserWriter Utility for Windows (described in
Appendix A).
The startup page shows how the printer is set up, including the network
connection types and what options are attached to the printer.
The startup page should look clean and sharp. If it is spotty, too light or too
dark, or otherwise unclear, switch the printer off and on to print a second
page. Try this two or three times if necessary. If the output doesn’t improve, or
if the printer won’t print the startup page, refer to Part III, “Troubleshooting.”
4

Save the startup page. It contains information you may need to complete your
network setup.

5

Check the status lights.

After the startup page is printed, the Ready/In Use/POS light glows steadily.
All other lights should be off. If any other lights are on, see Chapter 12.

Saving energy
When you save energy, you save natural resources and reduce pollution. If
you’re concerned about energy consumption, you can take advantage of the
printer’s built-in energy-saving feature. The printer enters an energy-saving
mode 60 minutes after finishing printing. You can adjust the time before it
enters energy-saving mode by using the Apple Printer Utility for the Mac OS
or the Apple LaserWriter Utility for Windows.
You can also save energy on the printer, as well as on all other printers
(including those without energy-saving features), by taking these steps:
m If you know you won’t be using the printer for a while—say, overnight—
turn it off.
m Use the page preview feature provided in many programs to check page
layout rather than printing a draft.
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Adjusting communication settings
Though you can adjust many of the printer’s communication settings, the
normal settings work for most environments. To make sure the printer is set
up to use the normal settings, check the communication switch on the left side
of the printer to make sure it’s in the Normal (in) position. The settings are
listed in Appendix D.

Why customize communication settings?
Though the standard communication settings work well for most
environments, you might want to customize communication settings to turn
off network interfaces you don’t need. For example, if you know the printer
will never receive a NetWare message over the network, you can turn off the
interface and stop the printer from sending out unnecessary NetWare packets.

How to customize communication settings
To customize communication settings, use either of the following two
programs:
m Apple Printer Utility for the Mac OS (see Appendix A for details on how
to use the program)
m Apple LaserWriter Utility for Windows (see Appendix A for details on
how to use the program)

What to do next
Finish preparing the printer and completing the network connections by
reading one or more of the following chapters:
m Chapter 2 explains how to administer the printer on an AppleTalk or
TCP/IP network and how to help Mac OS users start using the printer.
m Chapter 3 explains how to administer the printer on a Novell NetWare or
TCP/IP network and how to help Windows and DOS users get started using
the printer. It also explains how to set up a direct connection to an IBM PC
or compatible computer.
m Chapter 4 explains how to set up the printer on a TCP/IP network and how
to help UNIX® users get started using the printer.
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2

Setting Up the Printer for Mac OS Users

Note: For instructions on setting up the printer for access by Mac OS client
computers on a NetWare network, see Appendix B.

System requirements
To use the printer software, your Mac OS–based computer must have system
software version 7.1.1 or later and at least 4 megabytes (MB) of memory
(8 MB recommended). If your system software is an earlier version, you need
to obtain a system software upgrade from your computer or software dealer.
Installing all the printer software and fonts requires approximately 9 MB of
free space on your hard disk.

Initial AppleTalk setup
The printer comes with software and fonts for use with Mac OS–based
computers. Before Mac OS users can print, the printer administrator must
connect the printer to the network, install the printer software and fonts, and
configure the printer.
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Step 1: Installing the printer software
IMPORTANT Do not install the printer software by dragging files to your hard

disk. If you do, the files won’t be properly decompressed and won’t work.
Installing from the CD-ROM disc
1

Quit any programs that are open.

2

Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)
3

Insert the CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.
Note: Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.
4

Double-click the disc icon to open the disk, if necessary.

5

Double-click the Mac_OS folder, if necessary.

6

Double-click the Apple LaserWriter Software folder, if necessary.

7

Double-click the Install Software folder, if necessary.

8

Read the Before You Install file to check for late-breaking news.

9

Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.
10

Click Continue.

After a moment, the License Agreement dialog box appears.
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11

Read the license agreement and click Agree if you agree to the terms.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to Easy Install.
Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, and the Desktop Printer Utility.
Custom Install lets you specify what portions of the software you would like
to install, for example, the Apple Printer Utility.
IMPORTANT The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.
12

Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.
13

Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.
14

Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back
on now.
After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer.
You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Desktop Printer Utility and Read Me files.
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Creating installation disks from the CD-ROM disc
You can create installation floppy disks from the CD-ROM disc. You’ll need
six blank floppy disks. To create installation disks, follow these steps:
1

Insert the CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.
Note: Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.
2

Double-click the disc icon to open the disc, if necessary.

3

Double-click the Mac_OS folder, if necessary.

4

Double-click the Make Floppies folder.

5

Double-click the Disk Images folder.

6

Double-click the Disk Copy application.

7

Choose Make a Floppy from the Utilities menu.

8

Locate the first disk image (in the Disk Images folder) and click Open.

9

Insert a blank 1.4 MB floppy disk.

10

Click Start to start the copy process.

The image is copied onto the floppy disk.
11

Repeat Steps 7–10 until all disk images have been copied.

Be sure to label the disks.
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Installing from the floppy disks
To install the printer software on a Mac OS–based computer, follow these
steps:
1

Quit any programs that are open.

2

Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)
3

Make sure the disks are locked.

4

Insert the first floppy disk into a disk drive.

The disk’s icon appears on the desktop.
Note: If you are installing from floppy disks made from the CD-ROM disc,
the floppy disk label may be different.
5

Double-click the disk icon to open the disk, if necessary.

6

Read the Before You Install file to check for late-breaking news.

7

Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.
8

Click Continue.

After a moment, the License Agreement dialog box appears.
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9

Read the license agreement and click Agree if you agree to the license terms.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to Easy Install.
Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, and the Desktop Printer Utility.
Custom Install lets you specify what portions of the software you would like
to install, for example, the Apple Printer Utility.
IMPORTANT The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.
10

Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.
11

Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.
12

Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back
on now.
After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer.
You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Desktop Printer Utility and Read Me files.
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More information about the Installer program
In some circumstances, you may want to perform a custom installation. For
example, you may want to install the Apple Printer Utility on your system in
order to change the default settings in the printer. To install the Apple Printer
Utility, choose Custom Install from the pop-up menu in the Installer. A list of
choices appears. Click Apple Printer Utility to select it, then click the Install
button. (You can also use the Custom Remove item in the menu to remove
printer software you no longer want to use.)

Step 2: Choosing the printer
Before you use your printer for the first time, you must use either the Chooser
or the Desktop Printer Utility to select the printer and set up the printer
software. See “Using the Desktop Printer Utility” later in this chapter for
more information about using the Desktop Printer Utility.
Once you select the printer in the Chooser, you won’t need to repeat this step
unless you change printers or change the way your printer is connected.
1

Choose the Chooser from the Apple (K) menu.

The Chooser window appears.
2

Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.
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3

Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.

The name of your printer appears in the right half of the Chooser (along with
the names of any other available LaserWriter printers). (Your Chooser may
not look exactly like the illustration.)

4

Click the name of your printer.

You’ve now selected the printer for printing.
If this is the first time you’re using the printer, you must set up the printer
software. When the printer software has been set up, a small printer icon
appears beside the printer name. If your printer software has already been set
up and an icon appears beside the printer name, skip to step 6. To set up the
software, continue with step 5.
5

Set up the printing software.

m To let the Chooser identify the type of printer and automatically set up the printer
software, click Create.

By the way: Double-clicking the printer name is a shortcut for clicking the
name and clicking Create.
m To set up the printer software manually, press the Option key and click Create.
Click the name of the PostScript Printer Description file to be used with
the printer and click Select.
A small printer icon appears beside the printer name.
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6

If you want, you can repeat steps 4 and 5 to create desktop printer icons for other
printers.

7

Close the Chooser.

The new desktop printer icon for the printer appears on the desktop.

Note: If the desktop printer icon has a generic icon, then the Chooser was
closed without clicking the Create button. Open the Chooser, re-select the
printer, and click Create. A generic icon can also appear if the printer
software is not installed correctly. Reinstall the software and choose the
printer again.

A generic icon means the Create button in the Chooser wasn’t
clicked or the printer software is not installed correctly.

You can drag this icon to any position you want on your desktop or place it in
a folder on your startup disk.
The last desktop printer created becomes the default printer. Your documents
will automatically be printed on the default printer. For more information
about switching between available printers, see “Switching Between Printers,”
in Chapter 6.
If this is your only desktop printer, you can’t get rid of the icon by dragging it
to the Trash. (The icon will reappear if you do.) If you don’t want to use
desktop printer icons, see “Turning Off or Removing the Desktop Printing
Software,” in Chapter 6, for more information.
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Step 3: Naming the printer and setting its zone
Once connected to an AppleTalk network, the printer appears on the network
with the name LaserWriter 8500. You can change this name, if you wish, by
using the Apple Printer Utility (if you installed it as part of a custom
installation, this utility is located in the Apple LaserWriter Software folder).
If more than one printer of the same name is on a network, one will be
temporarily renamed each time it is turned on. To reduce confusion, name the
printer immediately.
When a printer is connected to an EtherTalk network with multiple logical
zones, you can also set which zone the printer will be in. You can set the
printer’s zone with the Apple Printer Utility.
Note: If you change the printer’s name or the zone name, you need to reselect
the printer from the Chooser. Be sure to drag the old printer icon to the Trash.
See Appendix A for more information on using the Apple Printer Utility.

Step 4: Making sure everything is working
The best way to make sure everything is set up correctly is to print something.
As a simple print test, open and print one of the Read Me files that is in the
Apple LaserWriter Software folder.
1

Locate the Apple Printer Software Read Me file in the Apple LaserWriter Software folder.

2

Open the Apple Printer Software Read Me file and choose Print from the File menu
(or drag the Read Me file onto the desktop printer icon).

The Print dialog box appears. If the printer’s name does not appear in the
dialog box, see “Step 2: Choosing the Printer.”
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3

Click Print.

If the document doesn’t print, check the steps you followed in Chapter 1 for
connecting and turning on the printer. Also check that you have followed all
the software installation steps presented in this chapter. Make sure that you
have installed the toner cartridge and loaded paper into the paper cassette.
Check that no packing material or paper has caused a jam in the printer.
If the printer still does not print, turn to the troubleshooting chapters.
Indicator lights on the front of the printer blink to signal errors and printing
conditions, such as lack of paper or a paper jam. You can also double-click
the desktop printer icon to check the status messages that appear in the
Desktop PrintMonitor.

Setting Up for TCP/IP
To set up a printer on a TCP/IP network, you need to assign an IP address for
the printer. If you’re on a LocalTalk or EtherTalk network, you can set the IP
address with the Apple Printer Utility. If you’re on a TCP/IP-only network,
see Appendix A for information on setting the IP address. For more
information on the Apple Printer Utility, see Appendix A. For information on
assigning IP addresses with telnet, see Chapter 4.
Next, use the Desktop Printer Utility to choose the printer and to create a
desktop printer icon. For more information on using the Desktop Printer
Utility, see “Using the Desktop Printer Utility”, next.
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Using the Desktop Printer Utility
Use the Desktop Printer Utility (located in the Apple LaserWriter Software
folder) to choose a new printer or to create special desktop printers. When
you double-click the utility, the following window appears.

Choosing a new printer on the AppleTalk network
1

In the Desktop Printer Utility window, select Printer (AppleTalk) from the list and
click OK.

2

In the dialog box that appears, make the necessary changes.

To select a PostScript Printer
Description file for the printer,
click Change.
To select a printer to print on,
click Change.
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3

Choose Save from the File menu.

4

Enter a name for the desktop printer icon and click OK.

Choosing a printer on a non-AppleTalk network
You can also use the Desktop Printer Utility to choose a printer that is not on
an AppleTalk network; however, you’ll need to know the printer’s IP address.
1

In the Desktop Printer utility, select Printer (LPR) from the list and click OK.

To select a PostScript Printer
Description file for the printer,
click Change.
To select a printer to print on,
click Change.

2

In the Internet Printer section, click the Change button.

The Internet Printer dialog box appears.

3

Enter the printer’s IP address and queue name, then click OK.

4

Choose Save from the File menu.

5

Enter a name and location for the desktop printer icon and click OK.
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Creating special desktop printers
You can create two special desktop printers: a desktop printer that is not
associated with any printer, and a desktop printer that converts files to
PostScript format.
If you’re working on a PowerBook computer, for example, and no printer is
available, you can print your files on a desktop printer that is not associated
with any printer. The spooled files remain in this desktop printer until you
connect your computer to a networked printer. You can then drag the files to
the printer’s desktop printer icon to be printed. This saves you the time of
having to reopen each file once you have access to a printer.
The PostScript translator desktop printer is also not associated with a printer.
It converts files to PostScript format, and places the PostScript file into a
folder that you define with the utility.
1

In the Desktop Printer Utility window, select Printer (no printer connection) or Translator
(PostScript) from the list and click OK.

2

In the dialog box that appears, make the necessary changes.

This dialog box is
used for desktop
printers not
associated with a
printer.

To select a PostScript Printer
Description file for the printer,
click Change.

This dialog box is
used for PostScript
translator desktop
printers.

To select a PostScript Printer
Description file for the printer,
click Change.
To select a new folder where the
PostScript files are to reside,
click Change.
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3

Choose Save from the File menu.

4

Enter a name and location for the desktop printer icon and click OK.

Making changes to the printer setup
If you change installable options on your printer, such as adding a 500-sheet
cassette and feeder, you must set up the printer again.
1

Select the desktop printer icon for the printer you want to set up.

2

Choose Change Setup from the Printing menu.

3

Click Auto Setup.

Printer options are displayed in the Setup dialog box. (Your screen may not
look exactly like the illustration.)

4

To change any options (for example, to change the 500-sheet cassette and feeder to
“Installed and Preferred”), select an option from the Change pop-up menu and select its
new value from the To pop-up menu.

5

When you’re done, click OK.
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Configuring the printer
You can change some of the printer’s default settings using the Apple Printer
Utility. For more information on the Apple Printer Utility, see Appendix A. If
you want to install any options, see Chapter 5. Then you can install the
printer software on Mac OS–based computers on your network as explained
in “Installing the Software From a Server,” next.

Installing the software from a server
You can get Mac OS users started with the printer and the new printer
software in whatever way you’re used to. If you’d prefer not to pass around the
software disks, you can place the software on a server, as explained in the next
section. If you prefer, you can of course install the software on each user’s
computer yourself. If you have the users install their own software, make sure
you give them
m the printer software and instructions for installing it
m the name of the AppleTalk zone in which the printer is located
m the name you gave the printer if you renamed it with the Apple Printer
Utility

Installing onto a server
If you prefer that users install their software from a network server rather
than pass around the original floppy disks or CD-ROM disc, you must copy
the LaserWriter installation software to a server as follows.
Preparing a server using the CD-ROM disc
The CD-ROM disc shipped with the printer contains a network installation
folder. To prepare a server:

44

Chapter 2

1

Insert the CD-ROM disc into the CD-ROM drive.

2

Double-click the disc icon, if necessary.

3

Double-click the Mac_OS folder, if necessary.

4

Double-click the Apple LaserWriter Software folder, if necessary.

5

Drag the Install Software folder from the CD to your server.

Preparing a server using the floppy disks
1

Create a new folder on the server and rename it (for example, Network Install).

2

Insert the first floppy disk.

3

Drag the LaserWriter Disk 1 icon onto the icon of the folder.

IMPORTANT You must drag the disk icon rather than copy the contents of the

disk directly.
4

Repeat steps 2 and 3 for each printer disk.

5

Open the folder you created in step 1.

The contents of each disk are contained in a folder named for that disk.
6

Open the LaserWriter Disk 1 folder.

7

Select the Installer and Installer Script icons and drag the icons from the LaserWriter
Disk 1 folder to the folder you created in step 1.

The Installer and the Installer Script need to be in the same window as the
folders for the disks you copied.
IMPORTANT Be sure to tell the users in your group where to find the software

and the name of the folder to look for on the server.
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Installing the printer software from the server
After you’ve copied the software to the server as described earlier in
“Preparing a Server Using the CD-ROM Disc,” users can install the software
on their own computers by following these steps:
1

Turn off any automatic virus-detection programs on your computer before installing the
software.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)
2

Log on to the server from the computer where you want to install the software.

3

Open the folder that contains the printer software.

4

Double-click the Installer icon.

A window describes the installation.
5

Click the Continue button.

6

Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files.
7

Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.
8

Click the Restart button.

The software is now installed and the printer is ready for use. If you turned
off any automatic virus-detection programs on your computer, turn them back
on now.
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What to do next
The printer is now setup on your AppleTalk or TCP/IP network for your
Mac OS client. The table below can help you decide which chapter to go
to next.
If you want to

See

Set up the printer for Windows, DOS, or NetWare users

Chapter 3

Set up the printer for UNIX users

Chapter 4

Install options

Chapter 5

Print from a Mac OS–based computer

Chapter 6

Print from a Windows 3.1 or DOS computer

Chapter 7

Print from a Windows 95 or Windows NT computer

Chapter 8
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3

Setting Up the Printer for Windows,
DOS, and NetWare Users

System requirements for Windows 95
To use the printer, your computer system must meet these requirements:
m IBM PC or compatible, with an 80486 or higher CPU
m hard disk drive
m at least 8 megabytes (MB) of random-access memory (RAM)
m Microsoft Windows 95
m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks
m If you’re using the printer on a network, you must set up your network
client software. You can use Client Software for NetWare Network from
Microsoft as your network client software.
Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.
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System requirements for Windows 3.1
To use the printer, your computer system must meet these requirements:
m IBM PC or compatible, with an 80386 or higher CPU
m hard disk drive
m at least 4 MB of RAM
m Microsoft Windows 3.1 or higher or Windows for Workgroups 3.11
or higher
m MS-DOS version 3.3 or higher (5.0 or higher recommended)
m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks
Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.

System requirements for Windows NT
To use the printer, your computer system must meet these requirements:
m IBM PC or compatible, with an 80386 or higher CPU
m hard disk drive
m at least 12 MB of RAM
m Microsoft Windows NT 3.5.1 or 4.0
m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks
Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.
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Setting up for DOS-based printing
If you will be printing from DOS applications only, you do not need to install
any of the software that came with the printer. However, you must install the
DOS PostScript driver if one exists for your DOS application. The DOS
PostScript driver is usually supplied with the DOS application. Follow your
application’s instructions for installation and printing. See also “Printing From
DOS Applications” in Chapter 7.
Note: You cannot print from the DOS prompt or from a DOS application that
does not have a PostScript driver.

Setting up for parallel port printing
Your printer uses a 1284C parallel port. By default, your printer’s parallel port
is ready to receive data, and you should not need to make any changes to
either your computer’s or the printer’s parallel port setting.

Installing the printer software for Windows 95, Windows NT, and Windows 3.1
You must install the printer software on each computer that will print on the
printer. You can do so by using the installation program that comes on the
software disks included with the printer.
Note: Be sure you have Windows installed on your computer before
installing the printer software.
To install the Windows printer software, follow these steps. These instructions
assume that you have a mouse or similar pointing device. If you do not, see
the instructions that came with Windows to find out how to perform these
steps using a keyboard.

Installing from the CD-ROM disc
1

Start your operating system (Windows 95, Windows NT, or Windows 3.1).

Before installing the software, make sure the Control Panel and Printers
folder are closed.
2

Insert the CD-ROM disc into the CD-ROM drive.
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3

4

Open the directory on the CD corresponding to your operating system:
If you are using

Open the directory

Windows 95

WIN_OS\WIN_95\APPLE\DISK1

Windows NT

WIN_OS\WIN_NT\APPLE\DISK1

Windows 3.1

WIN_OS\WIN_31\APPLE\DISK1

Double-click the SETUP.EXE file.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.
5

Click Next (or Continue if using Windows 3.1) if no other applications are open.

If you have open applications, click Cancel (or Exit if using Windows 3.1) to
stop the installation. Close all other applications and start the installation
process again.
The software license agreement appears.
6

Click Accept if you agree to the licensing terms.

A message appears that lets you view the ReadMe file for late-breaking news.
7

Click Yes to view the ReadMe file.

8

When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome dialog box is displayed that allows you to select Express
Installation or Custom Installation.
Express Installation installs the PostScript printer driver, creates the Apple
LaserWriter Software program group, and installs the ReadMe file.
Custom Installation lets you specify what portions of the software you would
like to install. For example, use Custom Installation to install the Apple
LaserWriter Utility for Windows, which you use to name the printer and
perform various printer administrative functions.
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9

Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.
If you are using

Go to the section

Windows 95

Completing Your Installation on a Windows 95 Computer

Windows 3.1

Completing Your Installation on a Windows 3.1 Computer

Windows NT 4.0

Completing Your Installation on a Windows NT 4.0 Computer

Windows NT 3.5

Completing Your Installation on a Windows NT 3.5 Computer

Completing your installation on a Windows 95 computer
1

Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program on your hard disk.
2

Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.
3

Enter a new directory for the setup program or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).
4

Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.
5

Select the drive that holds your CD from the Drives list box.

6

Select Disk 3 from the Directories list.

7

Select LaserWriter 8500 from the PostScript Printer Descriptions Available list and
click Next.

8

Select LPT1 if the printer is connected to your local computer.

9

Click Next.

The Add Printer dialog box appears.
10

Name your printer and select other options as necessary.
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11

Click Next.

The Properties dialog box appears.
Note: If you are using the printer on a network, select the PostScript tab, then
select Advanced. Deselect the “Send CTRL+D after job” option.
12

Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.
13

Click Add Another to install another Apple LaserWriter printer.

Repeat for each printer you want to install.
14

When you’re done, click Exit.

Installation is complete.
15

Choose how to proceed:

To configure your printer software for TCP/IP, see “Initial TCP/IP Setup for
Windows 95 and Windows NT,” later in this chapter.
For users connected via the parallel cable, the default printer driver settings
should suffice.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.

54

Chapter 3

Completing your installation on a Windows 3.1 computer
1

Click Restart Windows.

After Windows restarts, the Adobe PostScript Printers control panel appears.
2

Select the drive that holds your CD from the Drives list box (or select
WIN_OS\WIN_31\APPLE\DISK2).

3

Select LaserWriter 8500 from the PostScript Printer Descriptions Available list and click
Install.

The PostScript printer driver files are installed on the hard disk. A message
appears telling you that the driver software was successfully installed.
4

Click OK to dismiss the message.

5

Select another Apple LaserWriter printer, if you want, and click Install.

Repeat for each printer you want to install.
`

6

When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you've installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.
Installation is complete.
7

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
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Completing your installation on a Windows NT 4.0 computer
The Add Printer Wizard window appears and lets you specify how your
printer is connected (local or network).
1

Select how your printer is connected (local or network) and click Next.

2

If your printer is connected locally, select the port to assign to the printer and click Next.

The printer manufacturer and model window appears.
3

Select Apple as the manufacturer and LaserWriter 8500 as the printer model.

Files are copied to your hard disk.
4

Name your printer and select other options as necessary.

5

Click Next.

6

Select whether the printer is to be shared on the network.

7

If the printer is to be shared, type the printer’s shared name and select the operating
systems of all computers that will be printing on this printer.

The Add Printer Wizard appears and lets you print a test page if you want.
8

Select Yes and click Finish.

A test page is printed.
Installation is complete.
9

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
To configure your printer software for TCP/IP, see “Initial TCP/IP Setup”
later in this chapter.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
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Completing your installation on a Windows NT 3.5 computer
1

Double-click the Print Manager icon in the Main group.

The Print Manager window appears.
2

Choose Create Printer from the Printer menu.

The Create Printer window appears.
3

Type the printer’s name as you want it to appear in the Print Manager window and in
your application’s Print dialog box.

4

Select Other from the Driver pop-up menu.

The Install Driver window appears.
5

Select the drive that holds your CD from the Drives list box and click OK.

6

Select LaserWriter 8500 from the list and click OK.

Files are copied to your hard disk and the Create Printer window appears
again.
7

Click OK.

The PostScript Printer Setup window appears.
8

Click OK.

Installation is complete.
9

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
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Installing the printer software on a server for users to share
You can install the software on a server for users who share the server’s copy
of Windows. Follow the steps in “Installing From the CD-ROM Disc” and
specify the appropriate server volumes and paths. Be sure that the client
workstations have access to the server volumes and paths.
Copying the software to a server
You can also copy the software folders from the CD-ROM disc to a hard disk.
Your users can install the software from the server as described in “Installing
From the CD-ROM Disc,” earlier in this chapter.

Creating floppy disks from the CD-ROM disc
From a Windows 95 or Windows NT computer
You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 95.
1

Insert the CD-ROM disc into the CD-ROM drive.

2

Double-click the My Computer icon.

3

Double-click the drive that holds your CD.

A window appears that displays the contents of the CD.
4

Insert a blank floppy disk into the A: drive (or B: drive).

5

Double-click the drive that holds your floppy disk.

A window appears that displays the contents of the floppy disk.
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6

Open the WIN_OS directory.

7

Drag the contents of the WIN_95\APPLE\DISK1 or WIN_NT\APPLE\DISK1 directory from
the CD window to the floppy disk window.

8

Repeat steps 4 through 7 using the WIN_95\APPLE\DISK2 and WIN_95\APPLE\DISK3
directories or WIN_NT\APPLE\DISK2 and WIN_NT\APPLE\DISK3 directories.

From a Windows 3.1 computer
You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 3.1.
1

Open the File Manager.

2

Insert the CD-ROM disc into the CD-ROM drive.

3

Insert a blank floppy disk into the A: drive (or B: drive).

4

From the File Manager, open the WIN_OS\WIN_31\APPLE\DISK1 directory on the CD.

5

Choose Copy from the File menu.

6

Type *.* in the Source field and A: (or B:) in the Destination field.

The files are copied to the floppy disk.
7

Repeat steps 3 through 6 using the WIN_OS\WIN_31\APPLE\DISK2 directory.

Installing from the floppy disks
Installing on a Windows 95 computer
1

Find the Windows disks containing the printer software and make sure they’re writeprotected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.
2

Start Windows 95.

Before installing the software, make sure the Windows control panel and
Printer folder are closed.
3

Insert LaserWriter Disk 1 for Windows 95 into a floppy disk drive.

Note: If you are installing from disks made from the CD, the floppy disk
labels may be different.
4

Click the Start icon on the Task-Bar and select Run.
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5

Type A:\SETUP or B:\SETUP (depending on which drive holds your installation
disk) in the command line field and click OK.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.
6

Click Next if no other applications are open.

If you have open applications, click Cancel to stop the installation. Close
all other applications and start the installation process again.
The software license agreement appears.
7

Click Accept if you agree to the licensing terms.

A message appears that lets you view the ReadMe file for late-breaking news.
8

Click Yes to view the ReadMe file.

9

When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome message is displayed that allows you to select Express Installation
or Custom Installation.
Express Installation installs the PostScript printer driver, creates the Apple
LaserWriter Software program group, and installs the ReadMe file.
Custom Installation lets you specify what portions of the software you would
like to install. Use Custom Installation to install the Apple LaserWriter
Utility for Windows, which you use to name the printer and perform various
printer administrative functions.
10

Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.
Insert other printer disks (and click OK) as the program asks for them.
11

Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program on your
hard disk.
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12

Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.
13

Enter a new directory for the printer drivers or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).
14

Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.
15

Eject LaserWriter Disk 2 for Windows 95 and insert LaserWriter Disk 3 for Windows 95.

The PostScript PPD files are located on LaserWriter Disk 3 for Windows 95.
16

Choose A: or B: (depending on which drive holds your installation disk) from the
Drives list box.

17

Select LW 8500 from the PostScript Printer Drivers Available list and
click Next.

18

Select LPT1 if the LaserWriter 8500 is connected to your local computer.

19

Click Next.

The Add Printer dialog box appears.
20

Name your printer and select other options as necessary.

21

Click Next.

The Properties dialog box appears.
22

Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.
23

Click Add Another to install another Apple LaserWriter printer. Repeat for each printer
you want to install.

You can install other Apple LaserWriter printers supported by the software.
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24

When you’re done, click Exit.

Installation is complete.
25

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
To configure your printer software for TCP/IP, see “Initial TCP/IP Setup for
Windows 95 and Windows NT” later in this chapter.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
Installing on a Windows NT 4.0 computer
1

Find the Windows disks containing the printer software and make sure they’re writeprotected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.
2

Start Windows NT.

Before installing the software, make sure the Windows control panel and
Printer folder are closed.
3

Insert LaserWriter Disk 1 for Windows NT into a floppy disk drive.

Note: If you are installing from disks made from the CD, the floppy disk
labels may be different.
4

Click the Start Icon on the Task-Bar and select Run.

5

Type A:\SETUP or B:\SETUP (depending on which drive holds your installation
disk) in the command line field and click OK.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.
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6

Click Next if no other applications are open.

If you have open applications, click Cancel to stop the installation. Close
all other applications and start the installation process again.
The software license agreement appears.
7

Click Accept if you agree to the licensing terms.

A message appears that lets you view the ReadMe file for late-breaking news.
8

Click Yes to view the ReadMe file.

9

When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome message is displayed that allows you to select Express Installation
or Custom Installation.
Express Installation installs the PostScript printer driver, creates the Apple
LaserWriter Software program group, and installs the ReadMe file.
Custom Installation lets you specify what portions of the software you would
like to install. Use Custom Installation to install the Apple LaserWriter
Utility for Windows, which you use to name the printer and perform various
printer administrative functions.
10

Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.
Insert other printer disks (and click OK) as the program asks for them.
The Add Printer Wizard window appears and lets you specify how your
printer is connected (local or network).
11

Select how your printer is connected (local or network) and click Next.

12

If your printer is connected locally, select the port to assign to the printer and click Next.

The printer manufacturer and model window appears.
13

Click Have Disk.

14

Select A:\ and click OK.
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15

Select the LaserWriter 8500 and click Next.

Files are copied to your hard disk.
16

Name your printer and select other options as necessary.

17

Click Next.

18

Select whether the printer is to be shared on the network.

19

If the printer is to be shared, type the printer’s shared name and select the operating
systems of all computers that will be printing on this printer.

The Add Printer Wizard appears and lets you print a test page if you want.
20

Select Yes and click Finish.

A test page is printed.
A message appears that asks you to insert the Windows NT Workstation
CD-ROM disc.
21

Click Next.

22

Click Browse.

23

Select A:\i386 from the Lookin pop-up menu and click Open.

24

Click OK.

Files are copied to your hard disk.
Installation is complete.
25

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
To configure your printer software for TCP/IP, see “Initial TCP/IP Setup”
later in this chapter.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
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Installing on a Windows NT 3.5 computer
1

Find the Windows disks containing the printer software and make sure they’re
write-protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.
2

Start Windows.

Before installing the software, make sure the Windows control panel and
Printers folder are closed.
3

Insert LaserWriter Disk 1 for Windows NT into a floppy disk drive.

4

From the Windows Program Manager, choose Run from the File menu.

5

Type A:\SETUP or B:\SETUP (depending on which drive holds your installation
disk) in the command line field and click OK.

After a few moments, a message appears telling you to close all other
applications before continuing with this installation.
6

Click Continue if no other applications are open.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.
The software license agreement appears.
7

Click Accept if you agree to the licensing terms.

A message appears that lets you view the ReadMe file for late-breaking news.
8

Click Yes to view the ReadMe file.
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9

When you have finished reading the ReadMe file, choose Exit from the File menu in the
Microsoft Write application.

A Welcome message is displayed that allows you to select Express Installation
or Custom Installation.
Express Installation installs the PostScript printer driver, creates the Apple
LaserWriter Software program group, and installs the ReadMe file.
Custom Installation lets you specify what portions of the software you would
like to install. Use Custom Installation to install the Apple LaserWriter
Utility for Windows, which you use to name the printer and perform various
printer administrative functions.
10

Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.
11

Insert Disk 3 when the program asks for it and click OK.

A window appears when the installation is complete.
12

Click OK.

13

Double-click the Print Manager icon in the Main group.

The Print Manager window appears.
14

Choose Create Printer from the Printer menu.

The Create Printer window appears.
15

Type the printer’s name as you want it to appear in the Print Manager window and in
your application’s Print dialog box.

16

Select Other from the Driver pop-up menu.

The Install Driver window appears.
17

Type A:\ and click OK.

18

Select LaserWriter 8500 from the list and click OK.

Files are copied to your hard disk and the Create Printer window appears
again.
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19

Click OK.

The PostScript Printer Setup window appears.
20

Click OK.

Installation is complete.
21

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.
Installing on a Windows 3.1 computer
1

Find the Windows disks containing the printer software and make sure they’re
write-protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole.
2

Start Windows.

Before installing the software, make sure the Windows control panel and
Printers folder are closed.
3

Insert LaserWriter Disk 1 for Windows 3.1 into a floppy disk drive.

4

From the Windows Program Manager, choose Run from the File menu.

5

Type A:\SETUP or B:\SETUP (depending on which drive holds your installation
disk) in the command line field and click OK.

After a few moments, a message appears telling you to close all other
applications before continuing with this installation.
6

Click Continue if no other applications are open.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.
The software license agreement appears.
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7

Click Accept if you agree to the licensing terms.

A message appears that lets you view the ReadMe file for late-breaking news.
8

Click Yes to view the ReadMe file.

9

When you have finished reading the ReadMe file, choose Exit from the File menu in the
Microsoft Write application.

A Welcome message is displayed that allows you to select Express Installation
or Custom Installation.
Express Installation installs the PostScript printer driver, creates the Apple
LaserWriter Software program group, and installs the ReadMe file.
Custom Installation lets you specify what portions of the software you would
like to install. Use Custom Installation to install the Apple LaserWriter
Utility for Windows, which you use to name the printer and perform various
printer administrative functions.
10

Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.
Next, the Installer asks you to restart Windows.
11

Click Restart Windows.

After Windows restarts, the Adobe PostScript Printers control panel appears.
12

Remove LaserWriter Disk 1 for Windows 3.1 and insert LaserWriter Disk 2 for
Windows 3.1.

13

Select A: or B: (depending on which drive holds your installation disk) from the
Drives list box.

14

Select the LaserWriter 8500 and click Install.

The PostScript printer driver files and other software are installed on the hard
disk. A message appears telling you that the driver software was successfully
installed.
15
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Click OK to dismiss the message.

16

Select another Apple LaserWriter printer, if you want, and click Install. Repeat for each
printer you want to install.

You can install other Apple LaserWriter printers supported by the software.
17

When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you’ve installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.
18

Click OK to dismiss the message.

Installation is complete.
19

Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice.
For instructions on using the Apple LaserWriter Utility for Windows, see
Appendix A.
To configure your printer software with NetWare, see “Initial Novell NetWare
4.1 Setup,” later in this chapter.

Installing onto a Windows NT 3.5x server or non-Intel computer
Follow these steps to install the software on a Windows NT 3.5x server or
non-Intel computer.
1

Copy the PRINTER.INF file located in the D:\WIN_OS\WIN31_NT\APPLE\DISK2 directory
of your CD-ROM disc to a temporary directory on your hard disk drive.

This example uses C:\TEMP as the temporary directory.
2

If you are installing onto a Windows NT 3.5x server:

m Open the PRINTER.INF file with Notepad.
m Search for the [Source Media Description] session.
m Comment out the line for the NT Workstation.
m Remove the comment from the line for the NT Server.
m Save the file and exit Notepad.
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3

Place your Windows NT CD-ROM disc into the CD-ROM drive.

This example uses D: as the CD-ROM drive. Be sure to use the letter that
corresponds to your CD-ROM drive.
4

Double-click the “MS-DOS command prompt” icon in the Main program group.

5

Change to the appropriate directory by typing:
D:
CD \i386

The i386 directory is for Intel computers. Change this directory according to
your system. For example, use \PPC for a PowerPC™ computer.
6

Expand the PostScript driver components to your temporary directory. The following
command expands the files to the C:\TEMP directory.
EXPAND -R PSCR*.* C:\TEMP

Five files are expanded to your temporary directory: PSCRIPT.CNT,
PSCRIPT.DLL, PSCRIPT.HLP, PSCRIPT.SEP, and PSCRIPTUI.DLL.
7

Double-click the Print Manager icon located in the Main program group.

8

Select Create Printer from the Print Manager’s Printer menu.

The Create Printer dialog box appears.
9

Select Other in the Driver Combo box.

10

Type the location of your PRINTER.INF file when prompted by the Install Driver
dialog box.

A list of printer drivers appears.
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11

Select the printer driver that corresponds to your printer and click OK.

12

Follow the instructions on the screen.

13

Click Continue and OK to complete the installation.

Initial TCP/IP setup for Windows 95 and Windows NT
To install the printer onto a TCP/IP network, follow these steps.
1

Do an Express Installation of the printer software, as described earlier in this chapter.

2

Do a Custom Installation to install the Apple LaserWriter Utility and the Apple Port
Monitor Utility.

3

Assign an IP address for your printer.

You can assign an address from a RARP or BOOTP server, or a static address
using the Apple LaserWriter Utility. A static address is recommended. For
more information on assigning an address through RARP or BOOTP, see
Chapter 4. For information on using the Apple LaserWriter Utility, see
Appendix A.
4

Click the Start icon on the Task-Bar, select Settings, and click Printers.

5

Select the printer and choose Properties from the File menu.

6

Choose the Details tab and click Add Port.

The Add Port window appears.
7

Select Other, then Apple IP Monitor, and click OK.

Your computer polls the network for available LaserWriter 8500 printers.
8

Select the printer and click Add.

To verify you have the correct printer, match the name in the list that appears
with the IP Printer Name located on the printer’s startup page.
9

If your printer is not on the local subnet, press “Locate non-local printer,” and enter the
printer’s IP address.

The printer is now set up on your TCP/IP network for your Windows 95 or
Windows NT clients.
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Initial Novell NetWare 4.1 setup
NetWare 4.1 uses a hierarchical tree database, called NetWare Directory
Services (NDS). NDS is different from the flat-file database called the
bindery used in earlier versions of NetWare. The printer does not support
NDS. A NetWare command, SET BINDERY CONTEXT, allows a single level
of the NDS directory tree to be specified as a virtual bindery location. Each
time you use the NetWare 4.1 file server, set the file server’s bindery context
by typing SET BINDERY CONTEXT at the console prompt.
Note: The printer can be seen in a NDS hierarchy if you install the Apple
Network Utility for NDS. When you define the printer as a PSERVER or
RPRINTER, you must use SET BINDERY CONTEXT.
The superuser account name in NetWare 4.xx is Admin, where NetWare 3.xx
used Supervisor. The Supervisor account still exists in NetWare 4.xx for
backward compatibility, but it can’t be seen in the NDS directory tree. The
Admin account gives you full access to the entire NetWare Directory Services
tree. The Supervisor account only lets you see objects that are in its bindery
context location in the tree. When following the steps below for setting up
your printer on NetWare 4.1 as PSERVER, always use the NetWare Admin
account.
Make sure that the NetWare network is set up and operating according to the
instructions in the Novell NetWare documentation.
You should have access to the NetWare Printer Console utility, PCONSOLE,
on the computer from which you will be setting up the printer and have the
administrative privileges necessary to make changes to the network.

Step 1: Choosing an operating mode
When setting up your printer for a NetWare network, you have a choice of
three operating modes:
m PSERVER mode, in which the printer emulates NetWare’s PSERVER
software and functions as a dedicated print server
m RPRINTER mode, in which the printer functions as a remote printer
m ATPS (AppleTalk Print Spooler) mode, in which the printer functions as a
remote AppleTalk printer
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In PSERVER mode, the default, print jobs are stored in a queue on a
specified file server and retrieved by the printer.
In RPRINTER mode, the printer depends on the NetWare print server
software—either a NetWare Loadable Module (NLM), an RPRINTER.EXE
executable file, or a value-added process (VAP) running on top of the
operating system—to manage printing. Print jobs are stored in a queue on a
specified file server. When the printer is ready to print a job, the NetWare
print server software copies the job to the printer.
In ATPS mode, the printer uses its AppleTalk protocol support to
communicate with the Novell ATPS NetWare Loadable Module (NLM). The
NLM (included in the NetWare for Macintosh package from Novell) extends
full queue and spooling services to Mac OS clients from a server-based
software process.
There are advantages to each type of operating mode. Your choice depends on
your networking environment and the types of jobs you will be printing.
Regardless of your choice, you can locate the printer anywhere on the
network.
What to do next
Once you decide how you want to set up the printer, proceed as follows:
m PSERVER To set up the printer as a print server, read about how to use
PCONSOLE in the next section. Then
m if you want a simple setup, read “Step 2, Option A: Setting Up the
Printer as a Print Server (Using PCONSOLE),” later in this chapter.
m if you want to assign a password, read “Step 3: Assigning a Password for
the Print Server (Optional),” later in this chapter.
m RPRINTER To set up the printer as a remote printer, read about how to use
PCONSOLE in the next section. Then skip to “Step 2, Option B: Setting
Up the Printer as a Remote Printer (RPRINTER Mode),” later in this
chapter.
For both PSERVER and RPRINTER, you must also follow the instructions in
“Step 4: Setting Up the PostScript Printer Driver for NetWare Clients,” later
in this chapter.
For more information about using the Apple LaserWriter Utility, see
Appendix A.
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Using PCONSOLE
PCONSOLE is a DOS-based utility for configuring printers on a NetWare
network. This chapter provides information on the set of basic PCONSOLE
operations required to set up the printer. PCONSOLE is not provided with the
printer. It comes with your NetWare software. Detailed information about
PCONSOLE can be found in your NetWare documentation.
The descriptions of PCONSOLE in this manual use keyboard commands to
navigate through the program and perform operations. With the installation of
a DOS mouse driver, you can also use a mouse to make selections and choose
options.
The table below lists some basic PCONSOLE commands.
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Command key

Description

Esc (Escape)

Returns to the previous level

Del (Delete)

Deletes a selected item

F7

Cancels changes

Alt-F10

Exits the program

Ins (Insert)

Inserts a new item for a list

F1

Displays online help

Arrow keys

Cycles through menu selections or entry fields

Step 2, option A: Setting up the printer as a print server
(using PCONSOLE)
There are five parts to setting up the printer for PSERVER mode:
m Creating a print server
m Creating a printer
m Creating a print queue
m Setting your printer to PSERVER mode
m Restarting the printer to have the changes take effect
Creating a print server
1

Restart the printer to print a startup page; then obtain the NetWare Printer Name.

The NetWare Printer Name is the name of the printer on a NetWare network.
It is also the default print server name.
2

Type SET BINDERY CONTEXT at the NetWare file server’s console prompt to
ensure that the context has been set.

Be sure to write the context down; you will need it later.
3

Log in to the NetWare file server from a DOS client using the Admin account.

4

At the DOS prompt, type PCONSOLE and press Enter.

If you are asked for a password, type your password and press Enter.
5

Use the arrow keys to highlight Change Context in the menu and press Enter.

6

Change the PCONSOLE utility’s context to match the context set on the server (which
you wrote down in step 2), by pressing the Ins key and selecting the correct context.

7

Use the arrow keys to highlight Print Servers in the menu and press Enter.

8

Press the Ins key. Then type the NetWare Printer Name (provided on the printer’s startup
page) and press Enter.

The print server is created.
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Creating a printer
1

Select the name of the print server you specified in the previous procedure and
press Enter.

2

Use the arrow keys to highlight Printers in the Print Server Information menu and
press Enter.

This will let you configure the new print server.
3

Press the Ins key to display printers in your current context in the NetWare Directory
Services tree.

Note: You may have created a printer earlier. This example assumes that the
printer has not yet been created.
4

Press the Ins key to create a new printer in the NetWare Directory Services tree.

Make sure that the context listed at the top of the screen still lists the server’s
bindery context that was set earlier. If not, change to the correct context
before creating the printer.
5

At the prompt, type the new printer name and press Enter.

This name will be used for reference, so use a name that will be meaningful
to the NetWare administrator or to other users who may wish to check the
printer’s status. This step creates the printer object in the NDS tree.
6

Select the name of the printer you specified and press Enter.

This adds the printer to the Serviced Printers list of the print server.
7

From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure and press Enter.

This brings up the Printer Configuration menu.
8

From the Printer Configuration menu, use the arrow keys to highlight Printer Type and
press Enter.

9

From the Printer Type menu, use the arrow keys to highlight Other/Unknown and
press Enter.

This makes your selection active and brings you back to the Printer
Configuration menu.
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10

From the Printer Configuration menu, use the arrow keys to highlight “Banner type.”
Change the banner type from Text to PostScript.

Creating a print queue
1

From the Printer Configuration menu, use the arrow keys to highlight “Print queues
assigned” and press Enter.

This displays the Print Queue menu list.
2

Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree.

For this example, you will create a new queue.
3

Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context before
creating the print queue.
4

At the prompt, type the new queue name and press Enter.

You are asked for the NetWare volume on which to store your NetWare print
queue jobs. With NetWare 4, the NetWare queue does not have to exist on the
SYS volume. You can place the queue on any volume you choose. Use the Ins
key to select the volume from the directory tree (you may need to navigate to
a different context to select the volume desired).
5

Select the name of the queue you specified above and press Enter.

This adds the queue to the Print Queue list of the printer.
6

Press the Esc key until you are prompted to save your changes.

Setting your printer to PSERVER mode
1

Start Windows, if it’s not already running.

2

Start the Apple LaserWriter Utility application.

3

Select your printer.

4

Select Print Server Configuration from the Network menu.

Setting Up the Printer for Windows, DOS, and NetWare Users

77

5

Select the printer you want to configure.

You can identify the printer from the NetWare printer name that is printed on
the printer’s startup page.
IMPORTANT After the printer is turned on, it advertises itself on the NetWare

network for five minutes only to reduce network traffic. If you don’t see your
printer’s name in the list of printers, turn the printer off and back on. Make
sure the NetWare file server is running, and verify that the NetWare file
server and the printer are using the same Ethernet frame type. If the Ethernet
frame types do not match, see “Connecting to a Network Printer Manually”
in Appendix A. See also “Novell NetWare Troubleshooting” in Chapter 12.
6

Select the printer you want, then click Configure.

7

Enter the PSERVER name.

Use the same printer name you used in PCONSOLE (if you are not using the
default name).
8

Enter the same NetWare password that you entered with PCONSOLE.

9

Enter the names of file servers that the printer will service.

10

Click Add.

11

Click OK.

12

Enter the queue scan time.

The queue scan time is the number of milliseconds that the printer will wait
before checking each file server that it can access.
13

Click Send.

Restarting the printer
1

Turn the printer off and then back on again.

2

Send a print job to the printer to ensure it is working.

What to do next: The next section covers setting up the printer as a remote
printer. If you want to assign a password on the server, see “Step 3: Assigning
a Password for the Print Server (Optional).” Otherwise, see “Step 4: Setting
Up the PostScript Printer Driver for NetWare Clients.”
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Step 2, option B: Setting up the printer as a remote printer
(RPRINTER mode)
There are six parts to setting up the printer for RPRINTER mode:
m Creating a print server
m Creating a printer
m Creating a print queue
m Setting your printer to RPRINTER mode
m Starting PSERVER on your NetWare 4.1 file server
m Restarting the printer to have the changes take effect
Creating a print server
1

Turn the printer off and back on; then retrieve the printer’s startup page.

2

Type SET BINDERY CONTEXT at the server’s console prompt to ensure that the
context has been set.

Write the context down; you will need it later when creating the printer in the
NetWare Directory Services tree.
3

Log in to a NetWare file server from a DOS client using the Admin account.

4

At the DOS prompt, type PCONSOLE and press Enter.

5

Use the arrow keys to highlight Change Context in the menu and press Enter.

6

Change the PCONSOLE utility’s context to match the context set on the server (which
you wrote down in step 2) by pressing the Ins key and selecting the correct context.

7

Use the arrow keys to highlight Printer Servers in the menu and press Enter.

8

Press the Ins key. Then type a descriptive name for your printer server.

Use a name that will identify the object at a glance (for example,
“8500_Server”).
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Creating a printer
1

Select the name of the print server you specified in the previous procedure; then
press Enter.

2

Use the arrow keys to highlight Printers in the Print Server Information menu and
press Enter.

This lets you configure the new print server.
3

Press the Ins key to display printers in your current context in the NetWare Directory
Services tree.

4

Press the Ins key to create a new printer in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If this is not the case, change the context to the
correct context before creating the printer.
5

At the prompt, type the new printer name and press Enter.

6

Select the name of the printer you specified in the previous procedure and press Enter.

This adds the printer to the Serviced Printers list of the print server.
Creating a print queue
1

From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure and press Enter.

A Printer Configuration menu appears.
2

From the Printer Configuration menu, use the arrow keys to highlight Printer Type and
press Enter.

3

From the Printer Type menu, use the arrow keys to highlight Other/Unknown and
press Enter.

This makes your selection active and brings you back to the Printer
Configuration menu.
4
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From the Printer Configuration menu, use the arrow keys to highlight “Banner type.”
Change the banner type from Text to PostScript.

5

From the Printer Configuration menu, use the arrow keys to highlight “Print queues
assigned” and press Enter.

The Print Queue list appears.
6

Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree.

For this example, you will create a new queue.
7

Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context first
before creating the print queue.
8

At the prompt, type the new queue name and press Enter.

You are asked for the NetWare volume on which to store your NetWare print
queue jobs. With NetWare 4.xx, the NetWare queue does not have to exist on
the SYS volume. You can place the queue on any volume you choose. Use the
Ins key to select the volume from the directory tree. You may need to navigate
to a different context to select the volume desired.
9

Select the name of the queue you specified in the previous step and press Enter.

This adds the queue to the Print Queue list of Printers.
10

Press the Esc key until you are prompted to save your changes.

Setting your printer to RPRINTER mode
1

Start Windows, if it’s not already running.

2

Open the Apple LaserWriter Software program group and double-click the Apple
LaserWriter Utility icon.

3

Select the printer to configure and click OK.

4

Choose Print Server Configuration from the Network menu.

5

Click the printer you want, then click Configure.

Use the printer’s NetWare printer name to identify the printer to configure.
6

Click Remote Printer.
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7

Enter the name of the print server NLM in the Remote Printer Name field.

8

Enter the same printer number used by PCONSOLE for this printer.

9

Click Send.

Starting PSERVER on your NetWare 4.1 file server
m Start PSERVER on your 4.1 file server by typing LOAD PSERVER
<Print_Server_Name>.

Restarting the printer
1

Turn the printer off and then back on again.

2

Send a print job to the printer to ensure it is working.

What to do next: If you want to assign a password on the server, see “Step 3:
Assigning a Password for the Print Server (Optional),” next. Otherwise, see
“Step 4: Setting Up the PostScript Printer Driver for NetWare Clients.”

Step 3: Assigning a password for the print server (optional)
You can use PCONSOLE to assign a password for printing privileges.
However, if you assign a password in PCONSOLE, you must also use the
Apple LaserWriter Utility for Windows to specify the same password, as
described in “Setting Your Printer to PSERVER Mode” in “Step 2, option A:
Setting Up the Printer as a Print Server (Using PCONSOLE)” earlier in this
chapter. (The password specified in PCONSOLE tells the file server what to
expect; the password specified with the Apple LaserWriter Utility tells the
printer what to send.)
1

Select Print Servers from the Available Options menu in PCONSOLE and press Enter.

The list of print servers appears.
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2

Select the name of the print server for which you want to assign a password and
press Enter.

The Print Server Information menu appears.
Printers
Information and Status
Users
Operators
Serviced Netware Servers
Description
Password
Audit
3

Select Password and press Enter.

4

At the prompt, type the password and press Enter.

PCONSOLE asks you to retype the password. (The characters are not
displayed as you type.)
5

Retype the password and press Enter.
IMPORTANT Record the password for later use. If multiple file servers will be

served by the same printer, the same password must be used on each server.
6

Press Esc once; then press Enter.

7

To return to the Available Options menu, press Esc three times.

Step 4: Setting up the PostScript printer driver for NetWare clients
For Windows 95
1

Click the Start icon on the Task-Bar and select Printer Settings.

2

Select the printer you want to use.

3

Select Properties from the File menu.

4

Click the Detail Property tab.

5

Click Add Port.
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6

Click Browse to view the available print queues that have been defined with PCONSOLE.

7

Select the print queue you want to use and click OK.

8

Click OK again.

9

Click OK to close the Property dialog box.

For Windows 3.1
1

In Windows, double-click Control Panel.

2

Double-click Printers.

3

Select the printer you want to use.

4

Click Connect.

The Connect dialog box opens.
5

Click Network.

The NetWare Printer Connections dialog box opens.
6

Select the queue and the port the printer is assigned to.

7

Click Capture. Then click Close to close the dialog box.

8

Select the queue and port combination you specified in step 6 and click OK.

9

In the Printer control panel, select the LaserWriter 8500 as the default printer and
click Close.

Step 5: Making sure everything is working
When you have finished configuring your printer as a dedicated print
server or a remote printer, you can print, from a Windows application, a
document such as the ReadMe file to verify that you can print on the printer.
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Installing Apple Network Utility for NDS
The Apple Network Utility allows you to use the following printers with
NetWare 4.1 or 4.1.1 with NetWare Directory Services (NDS).
m Apple LaserWriter 8500
m Apple LaserWriter 12/640 PS
m Apple LaserWriter 16/600 PS
When you install the Apple Network Utility on your NetWare server, the
Apple Print Server NDS object is created. You can use the Apple Print Server
NDS object to add printers and print queues.
Note: Use the Apple Network Utility only if your network uses NDS. If your
NetWare network uses bindery emulation, use the Apple LaserWriter Utility
to configure the above printers on your NetWare network.

Installing fonts and Adobe Type Manager
You can install fonts and Adobe Type Manager for use with your computer
and the printer. See the documentation accompanying Adobe Type Manager
for information on installing and using the software.
Use the Adobe Type Manager to install the PostScript 3 fonts located in the
PS3_FNTS directory.
Note: PostScript 3 fonts are available for Windows 3.1 and Windows 95 only.

What to do next
The printer is now set up on your network. The table below can help you
decide which chapter to go to next.
If you want to

See

Set up the printer for UNIX users

Chapter 4

Install options

Chapter 5

Print from a Mac OS–based computer

Chapter 6

Print from a Windows 3.1 or DOS computer

Chapter 7

Print from a Windows 95 or Windows NT computer

Chapter 8
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4

Setting Up the Printer for UNIX Workstations
or TCP/IP Users

Note: The printer is a PostScript-only printer. Non-PostScript files will not
print, even though the Ready/In Use light flashes briefly and stops.

Initial TCP/IP setup
Before UNIX users can use the printer, the printer administrator must assign
an IP address for the printer, as described in the following sections.

Background information
TCP/IP (Transmission Control Protocol/Internet Protocol) is a protocol
commonly used to connect systems over Ethernet networks. Every TCP/IP
device must have a unique IP address. Much of the initial work the printer
administrator must do is related to assigning an IP address (and other
associated information) to the printer.

Step 1: Installing the printer software
You don’t need to install any special UNIX software to administer the printer.
You can control many features of the printer’s TCP/IP interface by using the
Apple Printer Utility program on a Mac OS–based computer or the Apple
LaserWriter Utility for Windows on a Windows-based computer (see
Appendix A).
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Step 2: Obtaining an IP address for the printer
To be recognized on your TCP/IP network, your printer must be assigned an
IP address. Most sites have a network administrator who dispenses IP
addresses for all new network devices. Contact your network administrator for
an IP address for the printer.
WARNING If your TCP/IP network contains devices with duplicate or

incorrect IP addresses, you may experience unpredictable network
behavior, or your network may cease to function. Make sure you obtain
a valid and unique IP address for the printer.

Step 3: Assigning an IP address to the printer
When you unpack the printer, it has a unique, permanent factory-assigned
Ethernet address, but no IP address. To assign an IP address to the printer,
you can use any one of the following methods:
m ping assignment. Any printer administrator with superuser privileges can
use this method, which is sometimes called gleaning. If your network has
neither RARP nor BOOTP services, and you have no access to Windows or
Mac OS–based computers, you must use this method.
Note: This method works only when the printer has no IP address. If the
printer has an IP address, you must use telnet. (For more information
on using telnet, see “Configuring the Printer,” later in this chapter.)
m Apple Printer Utility for the Mac OS and Apple LaserWriter Utility for Windows. If
your network includes a Mac OS–based computer or Windows computer,
you can use one of these utility programs to set the printer’s IP address.
m RARP (Remote Address Resolution Protocol). If your network has a RARP
server, you can use this method.
m BOOTP (Bootstrap Protocol). If your network has a BOOTP server, you can
use this method.
These methods are described in the sections that follow. Read the section that
applies to you and skip the others.
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How the printer obtains an IP address during normal operation
When the printer is initially installed, it has no IP address. The address is
shown as 0.0.0.0. When the printer is turned on, it attempts to obtain an
IP address through RARP and BOOTP. If successful, the printer retains this
address in nonvolatile memory and continues to use it unless it receives a
different address from RARP or BOOTP when it is restarted.
When the IP address is set through the Apple Printer Utility for the Mac OS,
the Apple LaserWriter Utility for Windows, or telnet, the printer no longer
makes an RARP or BOOTP request when restarted. An IP address set in this
manner is called a permanent address. For more information on using these
utilities, see Appendix A.
If the IP address is set through ping assignment (described below), the
printer attempts to obtain an address through RARP and BOOTP when
turned on. If the printer does not receive configuration information through
RARP and BOOTP, the printer uses an address of 0.0.0.0.
To disable RARP and BOOTP requests completely, set the IP address
permanently through telnet or one of the other utilities.
Printer IP address assignment, option A: Using ping assignment
Any UNIX administrator with superuser privileges can use the ping
assignment method to assign the printer’s IP address. ping does not store
the IP address in the printer’s nonvolatile memory. You have to set the IP
address with ping after each restart of the computer, or set the IP address
permanently with telnet.
Note: This method works only when the printer has no IP address. If
you’ve already set the printer’s IP address, you cannot change it by using
this method.
1

Turn on the printer and save the startup page that it prints.

2

Log in as root to any UNIX workstation on the same subnet as the printer.
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3

Add the following line to the /etc/hosts table on your workstation:

printer_IP_address

printer_IP_name

You obtain the printer IP address from your network administrator. You
choose the printer IP name yourself (if it was not assigned by the network
administrator). It must follow the naming convention of your system, which
generally means it must contain fewer than 32 characters and no special
characters.
Example
80.20.4.78
4

LaserWriterFloor2

Type the following command to force an entry into your system’s arp table:
arp -s hostname

printer_Ethernet_address

The hostname is the same name you used in step 3. You obtain the Ethernet
address from the startup page that prints automatically when you turn on the
printer. The address appears next to the top icon on the page.
Example

If your startup page shows that your Ethernet address is 08:00:07:2b:48:fb,
type
arp -s LaserWriterFloor2
5

08:00:07:2b:48:fb

Type the following ping command to assign the IP address to the printer:
ping printer_IP_name

The printer IP name is the same name you used in steps 3 and 4.
Example
ping LaserWriterFloor2

The ping command sends an ICMP Echo Request packet to the printer.
The destination fields in this packet contain the printer’s Ethernet address and
its IP address. The printer accepts the ICMP packet because it recognizes its
own Ethernet address. It then sets its own IP address to the address contained
in the packet’s IP destination address field.
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Note: Setting the IP address works only with ICMP packets that specify the
printer’s Ethernet address in their destination field. Multicast or broadcast
packets will not be accepted.
Normally, the ping command would result in a message telling you the
device received the ping command; however, the printer will not respond
this first time, though it will respond normally in the future.
The address is now stored in the printer’s memory, and you’re ready to test
whether the printer is working.
6

To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:
ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.
If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.
7

Skip to “Step 4: Configuring Users’ Workstations,” later in this chapter.

Printer IP address assignment, option B: Using Mac OS or Windows utilities
If you have a Mac OS–based computer connected to the printer, you can use
the Apple Printer Utility to assign the printer’s IP address, as described in
Appendix A.
If you have a Windows-based computer connected to the printer, you can use
the Apple LaserWriter Utility for Windows to assign the printer’s IP address,
as described in Appendix A.
After you have assigned the printer’s IP address, skip to “Step 4: Configuring
Users’ Workstations,” later in this chapter.
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Printer IP address assignment, option C: Using a RARP or BOOTP server
If your network has a RARP or BOOTP server on the same subnet as the
printer, you can use it to assign the IP address to the printer. Each time the
printer is turned on, it will automatically broadcast a request to RARP and
BOOTP servers, which will search a configuration file that maps the printer’s
built-in Ethernet address to the IP address that you assign.
RARP and BOOTP servers should be maintained by your network
administrator. Configuration depends on the network configuration protocol
and server you select. Your administrator may ask you for the Ethernet
hardware address, which is located on the startup page of your printer.
For troubleshooting information about RARP and BOOTP, see Chapter 12.

Step 4: Configuring users’ workstations
You can now set up users’ workstations.
m If you’re using Sun Solaris, see “Configuring Sun Solaris OpenWindows,”
next or “Configuring Sun Solaris CDE,” later in this chapter.
m If you’re using Sun OS version 4.1, see “Configuring Sun OS Version 4.1,
A/UX, or Other BSD Systems,” later in this chapter.
m If you’re using HP-UX, see “Configuring HP-UX Version 9.x,” later in this
chapter.
m If you’re using IBM AIX, see “Configuring IBM AIX Version 3.x,” later in
this chapter.
m If you’re using a Silicon Graphics workstation, see “Configuring Silicon
Graphics IRIX v5.3,” later in this chapter.

92

Chapter 4

Configuring Sun Solaris OpenWindows
1

Log in as root.

2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
4

Run admintool.
admintool &

5

Select Printer Manager.

6

From the Edit menu, choose Add Printers and then “Add Access to Remote Printer.”

7

Enter the queue name that you want to use in the Printer Name field.

8

Enter the hostname in the Print Server field.

9

Select BSD in the Print Server OS field.

10

Click Add.

11

Choose Modify Printer from the Edit menu.

12

Set File Contents to PostScript.
IMPORTANT Setting File Contents to anything else will result in errors when

you try to print ASCII files. The PostScript setting will print all file types
correctly.
13`

Confirm that Accept Print Jobs and Enable Print Queue are set to Yes.

14

Click Apply.
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15

Exit admintool and test the installation by printing a file.

You can print PostScript or text files by typing one of the following
commands:
lpr -P <printer name> <filename>

or
lp -d <printer name> <filename>

Configuring Sun Solaris CDE
1

Log in as root.

2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
4

Run admintool.
admintool &

5

From the Browse menu, choose Printers.

6

From the Edit menu, choose Add and then “Access to Printer.”

7

Enter the queue name that you want to use in the Printer name field.

8

Enter the printer’s hostname in the Print Server field.

9

Click Add.

10

Exit admintool.

11

In a terminal window, type:
lpadmin -p <printer name> -I postscript

This command converts all non-PostScript jobs to PostScript before
forwarding the job to the printer. If this command is not entered, text jobs
sent to the printer using the lp and lpr command will not print.
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Configuring Sun OS version 4.1, A/UX, or other BSD systems
1

Log in as root.

2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
If you’re using Network Information Service (NIS), see the NIS manual for
instructions on setting up an IP name and address.
4

Make sure the lpd daemon is running on the Sun OS system by typing the following
command at the UNIX prompt:
ps aux | grep lpd

If the lpd daemon is running, you should see output similar to
root 135 0.0 0.0

52

0 ? IW Oct 17 0:01 /usr/lib/lpd

If the lpd daemon is not running, you will not see any output. Start the
daemon by logging in as root and typing this command at the UNIX
prompt:
/usr/lib/lpd

You can verify that the daemon is running by using the ps command
described in this step.
Note: To start the lpd daemon automatically when the system boots, add
the lpd command to the /etc/rc file. The following is an example of an
/etc/rc file (syntax varies across operating systems):
if [ -f /usr/lib/lpd ] ; then
rm -f /dev/printer /var/spool/lpd.lock
/usr/lib/lpd;echo -n ' printer'
fi
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5

Add the following entry to the /etc/printcap file:

printer_queue_name|[description_of_ printer]:\
:lp=:mx#0:rm=printer_IP_name:\
:rp=lp:\
:sd=path_to_this_queue’s_spool_directory:\
:lf=path_to_this_queue’s_log_ file:

Fill in the parameters in italics as follows:
m Replace printer_queue_name with the name the user should use to
reference the printer.
m Replace description_of_ printer with a comment describing the printer.
m Replace printer_IP_name with the IP name you assigned to the printer in
“Step 3: Assigning an IP Address to the Printer,” earlier in this chapter.
m Replace path_to_this_queue’s_spool_directory with the pathname of the
unique directory created for this queue.
m If you wish, replace path_to_this_queue’s_log_ file with the unique
pathname of the file where error information from the lpd command will
be logged.
Here’s an example of a printcap entry:
Example
GarysLW|[LaserWriter_8500]:\
:lp=:mx#0:rm=LaserWriterFloor2:\
:rp=GarysLW:\
:sd=/usr/spool/lpd/GarysLW:\
:lf=/usr/spool/lpd/printerlog:
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6

Create and set the privileges for the spool directory specified in step 5:
mkdir path_to_this_queue’s_spool_directory
Example
mkdir
chown
chgrp
chmod

7

/usr/spool/lpd/GarysLW
daemon /usr/spool/lpd/GarysLW
daemon /usr/spool/lpd/GarysLW
775 /usr/spool/lpd/GarysLW

To test the connection, type the ping command from a workstation on the same
subnet as the printer:
ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.
If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.
8

Try printing by using this command:
lpr -Pqueue_name

filename

Note that there’s no space between -P and queue_name.
Example
lpr -PGarysLW file.postscript

If everything is working, the pages will print. If there’s a problem, see the
troubleshooting suggestions in Chapter 12.
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Configuring HP-UX version 9.x
Note: The printer is a PostScript-only printer. Non-PostScript files will not
print, even though the Ready/In Use light flashes.
You must configure the printer as a remote printer, not as a network printer.
1

Log in to the system console as root.

The System Administration Manager (SAM) uses a screen-oriented interface
that works best at the console.
2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
4

Run the SAM utility by typing sam at the UNIX prompt.

5

Select the following options, in order, from the SAM menu:
Printers and Plotters
Printers/Plotters
Actions
Add a Remote Printer/Plotter (Do not select “Add a Network

Printer.”)
A form appears for you to define a remote printer.
6

Enter information into the remote printer form as follows:

m Printer name Type the local queue name users will use as the name for
the printer.
m Remote system name Type the IP name assigned to the printer as described
in “Step 3: Assigning an IP Address to the Printer,” earlier in this chapter.
m Remote printer name Type raw
m Remote cancel model Used for remote printer job removal; type rcmodel

98

Chapter 4

m Remote status model Used for remote printer queue status; type rsmodel
m Printer class Optional
m Make this the system default printer? Check the box to make this printer the
default printer for all workstations on this segment of the network.
m Allow anyone to cancel requests Check this box if anyone should be able to
cancel requests.
m Remote printer on a BSD system? Because this printer is a Berkeley-style
remote printer, check this box.
7

Select the OK button.

A message appears asking you whether you want to add the printer to the
Printer’s subpanel.
8

Click Yes or No.

9

Click OK.

10

Choose Exit from the File menu.

11

Click the Exit SAM button.

12

To test the connection, type the ping command from a workstation on the same
subnet as the printer:
ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.
If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.
13

Test printing with the following command:
lp -d queue_name

filename
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If test printing doesn’t work
If the test document doesn’t print, check the configuration by following
these steps:
1

Check whether the rlp daemon is running. At the UNIX prompt, type
ps -e | grep rlp

If the process is running, you see one or more lines of text; if it is not
running, you see no response.
2

If rlp is running—that is, you saw one or more lines of text in step 1—kill the process
by typing
kill -15 process_number_ from_step_1

3

Make sure the following entry is in the /etc/inetd.conf file:
printer stream tcp nowait root /usr/lib/rlpdaemon
rlpdaemon -i

This line tells inetd to start the rlp daemon automatically when a print
request is made (if it’s not already running).
4

Make sure the following entry is in the /etc/services file:
printer 515/tcp spooler

5

Start inetd by typing the following command at the UNIX prompt:
/etc/inetd -c

6

Repeat the steps in “Configuring HP-UX Version 9.x.”

Configuring IBM AIX version 3.x
1

Log in as root.

2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
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4

At the UNIX prompt, type the following to run the SMIT utility:
smit

5

To add a remote queue, choose the following items from the SMIT menu:
Print System Management
Add a Print Queue
Remote
Standard Processing

A form appears for you to define a remote printer.
6

Enter information into the remote printer form, as follows:

m Name of queue to add Type the local queue name users will use as the name
for the printer.
m Host name of remote server Type the printer IP name assigned to the printer
as described in “Step 3: Assigning an IP Address to the Printer,” earlier in
this chapter.
m Name of queue on remote printer Type text if you want to append a carriage
return to the end of each line to be printed or raw if you don’t. (Since the
printer doesn’t otherwise need this remote printer queue name, it uses the
name as a flag to determine whether it should add a carriage return to the
end of each line.)
m Type of print spooler or remote server Select BSD.
7

Click Do.

8

Click Done.

9

Choose Exit from the Exit menu.
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10

To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:
ping printer_IP_name

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.
If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 12.
11

Try printing by using this command:
lpr -Pqueue_name

filename

Note that there’s no space between -P and queue_name.

Configuring Silicon Graphics IRIX v5.3
1

Log in as root.

2

Assign an IP address and IP name to the printer, as described in “Step 3: Assigning an
IP Address to the Printer,” earlier in this chapter.

3

The IP address must be entered in any of the following: DNS, NIS, or the /etc/hosts
file.

The most straightforward configuration is to use /etc/hosts. However,
your network administrator may choose to use DNS or NIS.
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4

In the Printer Manager, choose Add from the Printer menu.

5

Enter the queue name that you want to use in the Printer Name field.

6

Choose Network connection type.

7

Enter the printer’s IP name in the Remote Host Name field.

8

Click Apply.

9

Exit the Printer Manager and test the installation by printing a file.

Configuring the printer
Though the printer itself has no control panel, you can configure it by using
programs on computers connected to the printer:
m On Mac OS–based computers, use the Apple Printer Utility and the
Chooser’s setup function, described in Appendix A.
m On Windows-based computers, use the Apple LaserWriter Utility for
Windows, described in Appendix A.
m On UNIX-based workstations, log in to the TCP/IP Printer Configuration
Utility using the UNIX telnet program.

Using telnet and the TCP/IP Printer Configuration Utility
You can use telnet, a TCP/IP terminal emulation program, to log in to the
printer’s Configuration Utility. Changing the printer configuration affects all
users of the printer. You can use the utility to
m print a configuration page
m show information about the TCP/IP interface
m turn PostScript banner pages on or off for TCP/IP print jobs
m change the printer’s IP address
m set the TCP/IP subnet mask
m identify the default gateway IP address
m enable or disable TCP/IP connection timeout checking
m change the password for this utility
m reset the printer’s TCP/IP interface
m restore all settings to the factory defaults
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Logging in to the TCP/IP Printer Configuration Utility
To run the utility, follow these steps:
1

Use telnet to log in to the printer’s TCP/IP Printer Configuration Utility by typing
telnet printer_IP_name

The printer responds by displaying a message on your screen welcoming you
to the Configuration Utility.
2

Enter a password.

The first time you log in to the printer, it requires you to assign a password
to the utility. The password must be between five and ten characters long. The
characters you type do not appear on the screen.
Subsequently, you enter the password to use the utility. The characters you
type do not appear on the screen.
Note: You can change the password using this utility, as explained later in
this chapter.

Printing the configuration page
The configuration page shows setup information for the printer itself and for
all of the network interfaces.
1

Go to the main menu of the TCP/IP Printer Configuration Utility.

2

Type 1 and press Enter.

Displaying information about the printer’s TCP/IP interface
To see information displayed on your screen about the printer’s TCP/IP
interface, follow these steps:
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1

Go to the main menu of the TCP/IP Printer Configuration Utility.

2

Type 2 and press Enter.

Turning the banner page on or off
The banner page feature prints an identification page at the beginning of each
document. The banner page is printed using the PostScript page-description
language.
To turn the banner page on or off for all jobs sent through the TCP/IP
interface, follow these steps:
1

From the main menu of the TCP/IP Printer Configuration Utility menu, press 3 and Enter.

Two choices are displayed: one to turn the feature on, the other to turn it off.
2

Type the number of your choice and press Enter.

Viewing or changing the printer’s IP address
You must initially set the the printer’s IP address using one of the methods
described in the section “Step 3: Assigning an IP Address to the Printer,”
earlier in this chapter. Subsequently, you can use the TCP/IP Printer
Configuration Utility to change the address or to store it permanently in the
printer’s nonvolatile memory.
1

From the main menu of the TCP/IP Printer Configuration Utility menu, press 4 and Enter.

Two choices are displayed. The first choice—“Use Network Protocol”—sets
the IP address to 0.0.0.0. When the printer is restarted, it uses BOOTP
and RARP. The second choice is the equivalent of using the Apple Printer
Utility for Mac OS or the Apple LaserWriter Utility for Windows.
.

2

To change the address, press 2 and then Enter.
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3

Type the IP address in the following format, then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.
To indicate that you don’t want the printer to have an IP address, type
0.0.0.0 and press Enter. (This is identical to choosing “Use Network
Protocol” in step 1.)
WARNING If your TCP/IP network contains devices with duplicate IP

addresses, you may experience unpredictable network behavior, or your
network may cease to function. Make sure you obtain a valid and
unique IP address for the printer.

Setting the subnet mask
If your network includes subnets, you can set the subnet mask. Obtain the
subnet mask from your network administrator.
WARNING Use this option with care. If you enter an invalid subnet mask,
you may not be able to access the printer.

1

From the main menu of the TCP/IP Printer Configuration Utility menu, press 5 and Enter.

2

When requested to do so, type the IP address of the subnet mask in the following format,
then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.
To indicate that you don’t want to specify a subnet mask, type 0.0.0.0 and
press Enter.

Setting the default gateway address
If your local network is attached to other networks, you can specify the IP
address of your local gateway. Whenever the printer needs to send messages
to another network, it will use this gateway. Obtain the gateway address from
the network administrator.
1
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From the main menu of the TCP/IP Printer Configuration Utility menu, press 6 and Enter.

2

When requested to do so, type the IP address of the gateway in the following format,
then press Enter:

XXX.XXX.XXX.XXX, where each XXX is a number between 0 and 255.
Note: If you enter an invalid address for the gateway or if the gateway goes
down, the printer may not be able to communicate with remote networks.

Enabling or disabling connection timeout checking
The timeout feature automatically breaks TCP/IP connections that are idle for
more than 5 minutes. Under most circumstances, you should leave this
function enabled.
1

From the main menu of the TCP/IP Printer Configuration Utility menu, press 7 and Enter.

2

Follow the instructions on your screen.

Changing the password for this utility
1

From the main menu of the TCP/IP Printer Configuration Utility menu, press 8 and Enter.

2

When requested to do so, type a 5–10 character password.

The characters you type do not appear on the screen.

Resetting the printer’s TCP/IP interface
If you’re having problems with your TCP/IP connection to the printer and
can’t solve the problem by any other means, you may want to try resetting the
printer’s TCP/IP interface.
m From the main menu of the TCP/IP Printer Configuration Utility menu, press 9
and Enter.
IMPORTANT If you reset the printer while a document is printing, it may not

finish printing.
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Restoring settings to their factory defaults
To restore the settings to their factory defaults:
m From the main menu of the TCP/IP Printer Configuration Utility menu, press 10
and Enter.
WARNING This option erases the utility’s password and the printer’s IP

address. You must reset the address as described in “Step 3: Assigning
an IP Address to the Printer,” earlier in this chapter.

IMPORTANT If you choose this option while a document is printing, it may not

finish printing.

Quitting the Configuration Utility
1

Go to the main menu of the TCP/IP Printer Configuration Utility.

2

Press Enter.

3

If you’re asked if you want to save changes, type Y and press Enter to save the
changes, or just press Enter to discard the changes.

What to do next
The printer is now set up on your network.
You don’t need any special software to use the printer. On most UNIX
systems, you use either the lpr or lp command to print documents over a
TCP/IP network.
Examples for lpr
lpr -PGarysLW postscript.file
Examples for lp
lp -d GarysLW postscript.file

The way you print and choose printing options can differ from one
application program to another. To find out more about printing from your
application programs, read the documentation that came with the programs.
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Installing Options

The printer has several user-installable options. You can add a duplex printing
unit, two additional 500-sheet feeders and cassettes, an external SCSI hard
disk, and an envelope cassette (the envelope cassette can replace any
500-sheet cassette). You can also increase the printer’s random-access
memory (RAM).
This chapter provides instructions for attaching an external SCSI hard disk
and increasing RAM.
Instructions for installing paper-handling options are included with each
option.
WARNING When installing any of the options described in this chapter,

be sure the printer is turned off.
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The following illustration shows how the printer looks with an optional
duplex printing unit and two 500-sheet feeders and cassettes.

Duplex printing unit

500-sheet feeders
and cassettes
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Adding a hard disk
You can attach one external SCSI hard disk to the printer. The hard disk
provides space for font storage.
When you connect a disk to your printer to store fonts, documents will print
faster because your computer will rarely need to download a font to the
printer. You’ll also improve network performance because less information is
transferred over network cables.
When you do download fonts, you can choose to download them either to a
hard disk or to the printer’s RAM. Downloading them to a disk stores them
there permanently (or until you remove them). If you have a Mac OS–based
computer, you can initialize the disk and download fonts to it by using the
Apple Printer Utility (see “Downloading Fonts to the Printer or an Attached
Hard Disk” in Appendix A). If you have an IBM PC or compatible computer,
you can initialize the disk and download fonts to it by using the Font
Downloader in the Printer Setup dialog box (see “Downloading Fonts”
in Chapter 7).
You must use a SCSI system cable to connect the first external hard disk to
the external SCSI port. For each additional hard disk you connect to the
printer, you need a SCSI peripheral cable, which links two SCSI devices.
You’ll also need a SCSI terminator connected to the last device in the SCSI
chain (if it doesn’t have an internal terminator).
IMPORTANT The external hard disk you connect to the printer must supply

5 volts DC termination power to the SCSI bus to work properly. Check the
documentation that came with the hard disk for information about SCSI
voltage.
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If you are considering connecting an external hard disk to your printer, keep
these points in mind:
m The printer requires a SCSI 40 MB (or larger) hard disk.
m The printer must be able to tell how much storage space is available on
the disk.
m Some hard disks have internal SCSI terminators. There should be no more
than one terminator in addition to the one in the printer.
m The hard disk must be able to deliver at least 5 volts of termination power.

Setting the SCSI ID number
You assign a SCSI ID number by setting the SCSI ID switch on the back
panel of the disk. Follow these steps.
`

1

Make sure the hard disk and printer are turned off.

2

Set the SCSI ID according to the hard disk manufacturer’s specifications.
IMPORTANT Before you turn on the printer, be sure to turn on the external

hard disk. If you turn on the printer first, it will not recognize an external
hard disk drive. When this happens, the printer may not start up properly, and
you won’t be able to print anything. To fix this problem, make sure all the
hard disks are turned on, then restart the printer.

Connecting a previously used hard disk
The printer recognizes disks formatted for use with the Adobe printer file
system (AFS) format. The printer will not recognize disks using other
formats. If you attach such a disk to the printer, you need to reinitialize the
disk before you can use it and then reload any fonts from your computer.
Reinitializing erases everything, including all fonts previously stored on
the disk.
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If you are not sure of the disk format, connect the hard disk to the printer as
described in “Connecting a Single External Hard Disk” next. Start the Apple
Printer Utility (see Appendix A for more information on the Apple Printer
Utility). If the hard disk is not listed in the Disks panel, then you must
initialize the hard disk.

Connecting a single external hard disk
1

Turn off the printer.

2

Attach the SCSI system cable to the SCSI port on the printer.

3

Attach the other end of the SCSI system cable to either SCSI port on the hard disk.

4

If necessary, attach a cable terminator to the other SCSI port on the hard disk.

5

Turn on the hard disk.

6

Turn on the printer.

Increasing the printer RAM
Your printer comes with 16 megabytes (MB) of random-access memory
(RAM) soldered onto the controller board. You can increase the memory size
of the printer up to 48 MB to provide faster performance on complex
documents, documents containing many fonts, and duplex printing.
Adding RAM allows more fonts to be downloaded to the printer at one time;
provides more space to store the data needed for large or complex images;
increases the space available for font caching, or maintaining recently used
fonts in memory for faster access the next time they are needed; and enables
duplex printing.
IMPORTANT The instructions provided here explain how to install memory in

your printer yourself. If you wish, you can also contact an Apple-authorized
dealer to install more memory for a service fee.
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The printer has one Single Inline Memory Module (SIMM) slot for installing
additional RAM.You can purchase additional RAM for the printer in units of
4, 8, 16, and 32 MB. You can purchase 4 MB RAM expansion kits from
Apple-authorized dealers. You can also purchase RAM expansion kits from
many electronics and computer outlets. For information about the RAM
specifications required to expand your printer’s memory, see Appendix D.
WARNING Don’t handle the memory SIMMs until you have discharged

any static electricity that may have built up. To discharge static
electricity, touch any metal part of the printer.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
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Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter
and A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes

Removing the printer’s side cover
WARNING Make sure the printer is turned off.

1

If necessary, turn the printer so that the left side is accessible.

2

Loosen the two thumbscrews on the back of the printer.

3

Slide the side cover to the back until it stops, and then pull the cover towards you to
remove it.

Installing SIMMs
The printer’s circuit board has one Single Inline Memory Module (SIMM)
slot for installing additional memory. RAM is provided on SIMMs that you
insert into the slot.
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Depending on the amount of memory you have in the printer, you may need
to remove a SIMM in order to insert one that has more memory. For example,
if you have 20 MB of RAM in your printer and want to upgrade to 48 MB of
RAM, you must remove the 4 MB RAM SIMM and install a 32 MB RAM
SIMM.
1

Hold the bag containing your SIMM and touch any metal part of the printer. Then open
the bag containing the SIMM.

This prevents any static electricity from discharging into the SIMM and
damaging it.
2

Insert the SIMM into the connector at an angle, and gently press the SIMM down at a
horizontal angle until the retaining clips on each end of the connector snap and fasten
the SIMM in place.

Hold the SIMM vertically over the slot, aligning the connectors and notches
with the circuit board’s connector. One edge of the SIMM has a distinctive
notch that you can use to judge the orientation and alignment of the SIMM
with the connector. This notch, on the left edge of the SIMM, should be on
the left side as you install the SIMM.

Notch
Insert the card
straight in.

Gently angle
the card back.

Snap the card into
the retaining clips.
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WARNING When installing a SIMM, avoid touching the printer’s circuit

board with hands or tools to avoid damaging or scratching the printed
circuits.
To remove a SIMM, carefully spread the retaining clips at both ends of the
installed SIMM. Then rotate the SIMM upward until it can be pulled free of
the slot.
You’ve now installed the expanded memory. You need only replace the side
cover to complete the installation.

Replacing the side cover
To replace the cover on the printer, follow these steps.
1

Slide the cover’s top tab under the lip on the side of the printer.

2

Line up the tabs inside the side cover with the receiving slots on the printer.

3

Gently place the side cover on the printer and slide forward.

Slide top of cover under lip
before sliding cover forward.

Line up the tabs
with the receiving slots.
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4

With the cover properly positioned, tighten the two thumbscrews on the back of the
printer.

5

Next, configure the printer software to use the additional memory.

For configuration instructions, see “Configuring Your Printer Software for
New Options,” next.
If you want to check that you have properly installed the additional printer
memory, turn the printer back on and check the startup page. The amount of
printer memory should be listed there.
The printer does self-diagnostic tests each time it is turned on. During this
testing, the printer verifies the amount of memory installed. If the diagnostics
test determines that the installation is not correct, the Paper Out and the
Paper Jam lights flash alternately. Check that you have installed the SIMMs
properly in the correct slots. If this does not resolve the problem, contact an
Apple-authorized dealer.

Configuring your printer software for new options
After installing more memory or paper options, you need to update the
printer software on each computer connected to the network. You can
reconfigure the printer software using the desktop printer icon or the Chooser
on Mac OS–based computers or the Windows Setup dialog box on Windowsbased computers.
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Configuring the printer from a Mac OS–based computer
From the desktop printer icon
1

Select the desktop printer icon for the printer.

2

Choose Change Setup from the Printing menu.

The LaserWriter Setup dialog box appears.

3

Click Auto Setup.

4

Click OK.

From the Chooser
If no desktop printer icon exists for the printer, you must configure your
printer using the Chooser.
1

Choose the Chooser from the Apple (K) menu.

The Chooser appears.
2

Click the LaserWriter 8 icon.

3

Click a zone name to select the zone of the printer, if your network has zones. If your
network doesn’t have zones, skip to step 4.
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4

Double-click the printer name.

The printer software automatically checks the printer’s options and selects the
correct settings.
5

Close the Chooser.

Designating the 500-sheet feeder and cassette as the preferred paper source
After installing a 500-sheet feeder, you can specify that the printer use the
500-sheet feeder as the preferred paper source. When you choose Auto Select
as the paper source in the Mac OS Print dialog box, the printer will draw
paper from the 500-sheet feeder if it holds the appropriate size paper. To
designate the 500-sheet feeder as the preferred source, you must manually
configure the printer software.
1

Select the desktop printer icon for the printer.

2

Choose Change Setup from the Printing menu.

The LaserWriter Setup dialog box appears.
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3

Click Auto Setup.

4

Select “Cassette (Optional 1)” from the Change pop-up menu.

5

Select “Installed and Preferred” from the To pop-up menu.

6

Click OK.

Configuring the printer from a Windows 3.1–based computer
1

From the Program Manager, double-click the Print Manager icon to display the Print
Manager.

2

Select the printer from the list of Printers.

3

Choose the Setup command from the Options menu to display the Setup dialog box for
your printer.

The Setup dialog box contains buttons that display other dialog boxes
containing additional printer settings.
4

Click the Features button.

The Features dialog box appears.
5

Set controls in this dialog box to set up the optional features that you have installed on
your printer.

6

Click OK to close the Features dialog box.

7

Click OK to close the Setup dialog box.

Configuring the printer from a Windows 95–based or
Windows NT computer
1

From the Task-Bar, click Start and then select “Printers from Settings.”

2

Click the printer icon for the printer on which you want to update the software.

3

Choose Properties from the File menu.

4

Click the Device Options panel (in Windows 95) or the Device Settings panel (in
Windows NT).

5

Set the controls in the panel for the optional features that you have installed on your
printer.

6

Click OK to close the Properties dialog box.
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Printing Envelopes
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Maintenance

Part II contains information you need to use a printer
that has already been set up. You can find setup
instructions in Part I.

II
part

6

Mac OS Users

The printer comes with software and fonts for use with Mac OS–based
computers. This chapter describes the standard printing and page setup
options of the LaserWriter 8 printer driver and the desktop printer software
supplied with your printer.

Printing
On a Mac OS–based computer, printing functions are controlled through the
Page Setup and Print dialog boxes, which are accessed through the File menu.
Most Mac OS application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)
The default settings the printer uses for all documents can be changed with
the Apple Printer Utility. For more information about the Apple Printer
Utility, see Appendix A.

125

Selecting page setup options
The Page Setup dialog box allows you to specify certain aspects of your
document, such as its page size, format, and orientation, as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document, it will closely resemble its final printed form.
1

Choose Page Setup from the File menu.

The Page Setup dialog box appears.
2

Select the page setup options you want.
To see a dialog box that lets you select
enhancements to the printed image, choose
PostScript Options from this pop-up menu.
Use this pop-up menu
to identify the printer
you want to use.
Use this pop-up menu
to identify the paper
size you are using.

Click here to see a list
of the currently
selected dimensions.
(To return to the
picture, click again.)

When the selections
are set the way you
want, click OK.
This picture illustrates your choice of paper and
orientation, and it reflects changes as you make them.

m Select US Letter Small or US Legal Small to prevent pagination
differences when printing on different printers. These paper sizes have the
same physical size as US Letter and US Legal, but have larger margins.
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3

To print using special effects, choose PostScript Options from the pop-up menu on the
upper left side of the dialog box. (If you don’t want to choose print options, skip to
step 4.)

The PostScript Options dialog box appears.

m Select Flip Horizontal to flip the page image horizontally.
m Select Flip Vertical to flip the page image vertically.
m Select Invert Image to print a black-and-white reversed image.
m Select Substitute Fonts to substitute the fonts Helvetica®, Times®, and
Courier for the Mac OS screen fonts Geneva, New York, and Monaco,
respectively. The substitution occurs even if TrueType outline fonts are
available for Geneva, New York, and Monaco. Text sizes in the printed
document are scaled to compensate for size differences between the
corresponding families of screen and printer fonts.
m Select Smooth Text to smooth edges of letters when your printer is printing
fonts as bitmapped fonts.
m Select Smooth Graphics to smooth ragged edges of lines in bitmapped
graphics.
m Select Precision Bitmap Alignment to make printed bitmapped graphics
more precisely match the screen image.
m Select Unlimited Downloadable Fonts to print the document using as many
downloadable fonts as you need. The fonts will be sent to the printer, used,
and then removed from the printer’s memory. The document will be
printed more slowly.
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4

Click OK to close the Page Setup dialog box.

You can make the printer’s current page setup settings the default software
settings by holding down the Option key and clicking OK. (Some programs
may not support this method of setting defaults.)

Printing documents
When you are printing from a Mac OS–based computer, most application
programs display a Print dialog box, in which you specify print options such
as the number of copies you want printed, whether to print all or part of a
document, and which paper tray or cassette will be the paper source.
Some application programs also add more choices to the Print dialog box.
For information about such options, refer to the documentation that came
with the program.
1

Choose Print from the File menu.

The Print dialog box appears.
2

To define a single
paper source, click
“All pages from.”
Then choose a paper
source from the
pop-up menu.

To use your
settings as the
default settings,
click Save Settings.
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Select the options you want.

To print the document
on paper, choose
Printer. To save it as a
PostScript or EPS file,
choose File.
To print a
transparency or sheet
of paper that you feed
by hand, choose
Manual Feed as the
paper source.

To see dialog boxes
that let you select
more options,
choose a setting
from the Settings
pop-up menu.

To print multiple
copies in
numerical order,
click Collated.

To define multiple
paper sources, click
“First page from.”
Then choose one
paper source from
each of the
pop-up menus.

IMPORTANT The names that appear in the paper source menus depend on the

paper sources of your printer and the paper sizes you choose in the Page
Setup dialog box.
m To have the printer automatically select the paper tray that holds the size of
paper chosen for the document, choose Auto Select as the paper source.
By the way: If you use the Auto Select printing feature to draw paper
automatically from any source that holds the correct size paper, use the
Apple Printer Utility or Apple LaserWriter Utility for Windows to define
the size of paper that the multipurpose tray holds. The printer software can
then determine correctly when to draw paper from the multipurpose tray.
For more information about defining the size of paper in the multipurpose
tray, see Appendix A.
m You can print on other printers by choosing their name from the
Destination pop-up menu. Only printers that have desktop printer icons
created with LaserWriter 8 are listed.
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3

When you’ve made the selections you want, choose another setting from the Settings
pop-up menu, if you wish. Then click Print.

m To print a cover page, choose Cover Page from the Settings pop-up menu.
m To choose settings for printing grayscale images, choose Color Matching
from the Settings pop-up menu.
m To turn on PhotoGrade or FinePrint, choose Imaging Options from the
Settings pop-up menu.
m To duplex print and set the number of pages per sheet, choose Layout from
the Settings pop-up menu.
m To print to a file, choose File from the Destination pop-up menu and
choose “Save as File” from the Settings pop-up menu.
m To turn on background printing, choose Background Printing from the
Settings pop-up menu.
m To set program-specific options (such as page order), choose the program’s
name from the Settings pop-up menu.
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Printing a cover page automatically
The LaserWriter 8 printing software can automatically print a cover page that
provides information about the printed document, such as the document’s
name and the date and time of printing. You can set the printer to print the
cover page at the beginning or the end of the document.

1 Choose Cover
Page from the
Settings pop-up
menu.

2 Make the selection
you want.

3 To define a different paper
source for the cover page, choose
one from the pop-up menu.
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Printing grayscale documents
When you print a document containing shades of gray, you can choose to
maximize either image quality or speed.
Make the selection you want.

1 Choose Color
Matching from the
Settings pop-up
menu.

2 Make the selection
you want. For fastest
printing, choose Black
and White. Choose
Color/Grayscale when
printing grayscale.

Printing with FinePrint or PhotoGrade
FinePrint smoothes out lines and curves and enhances text and line graphics
that would normally appear jagged. For documents that require the finest
quality text that the printer can produce, turn FinePrint on.
PhotoGrade enhances the printed look of images, such as scanned or digital
photographs, to produce added clarity, finer shading, and better contrast. For
documents that require images to be printed with the best quality that the
printer can produce, turn PhotoGrade on. For documents that contain both
text and high-quality images, turn PhotoGrade on and FinePrint off.
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Having both FinePrint and PhotoGrade on can affect how images print. For
documents that have many images and require high-quality reproduction,
you may want to turn FinePrint off. To determine the effect of printing
using FinePrint and PhotoGrade, you can print portions of a document
with FinePrint and PhotoGrade turned on or off to see the differences in
printed output.

1 Choose Imaging
Options from the
Settings pop-up
menu.

2 Make the selection
you want.
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Printing on both sides of the paper
With the optional duplex printing unit, you can print on both sides of the
paper (often called duplex printing or two-sided printing). You can only use
duplex printing from the paper cassettes.
Note: You cannot use duplex printing from the multipurpose tray.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter
and A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes

1 Choose Layout
from the Settings
pop-up menu.

2 Use the “Pages per
sheet” pop-up menu to
choose 1, 2, 4, 6, 9, or
16 pages per sheet.
(The printer reduces or
enlarges pages to fit
the layout.)

This picture
illustrates your
choice of pages per
sheet and direction,
and it reflects
changes as you
make them.
3 To use duplex printing, select
“Print on Both Sides” and
select the binding orientation.
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Binding determines how pages are printed when you are printing on both
sides of the paper. If you want the binding orientation along the side of the
paper (as in a book or magazine), click the left binding button. If you want
the binding orientation along the bottom of the paper (as in a calendar), click
the right binding button.

Printing to a file
You can save your document as a PostScript file, an EPS file, or an Adobe
Portable Document Format (PDF) file.

1 Choose
“Save as File”
from the Settings
pop-up menu.

2 Make the selection
you want.

You can save the file
as ASCII or Binary.
Binary files are
typically smaller.

Font inclusion lets you
print the font on any
computer without
relying on font
substitution.

Background printing and setting the print time
With background printing turned on, you can use your computer for other
work while you’re printing. Once background printing is turned on, it is in
effect whenever you print, until you turn it off. When you click Print in the
Print dialog box, a message appears for a moment to tell you the document is
being prepared. Once the message disappears, you can continue other work.
Your computer may pause occasionally while it processes the document
for printing.
When foreground printing is turned on, you must wait until the document has
finished printing before you can use your computer for other work. However,
your document may be sent to the printer faster when foreground printing is
turned on.
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You can also specify when your document should be printed in relationship to
other documents that are also being printed.

1 Choose
Background Printing
from the Settings
pop-up menu.
2 Make the selection
you want.

Reporting errors
You can specify what happens when a PostScript error occurs or when the
paper cassette runs out of paper. For PostScript errors, you can have the
printer provide no reporting, provide a summary of the print error on your
computer screen (when using foreground printing), or print a page reporting
the error. When the printer is out of paper, you can have the printer use
another cassette with the same paper size or display an alert message.
If you select “Switch to another cassette with same paper size,” the printer
will get paper from its input trays in the following order: standard cassette,
multipurpose tray, optional 500-sheet cassette #1, optional 500-sheet
cassette #2.
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IMPORTANT If you have the same size paper in your paper cassettes and
multipurpose tray and have tray switching turned on, the printer may draw
paper from any paper source that has the correct size paper (even if you
select a specific paper source from the Print dialog box). If you want to print
from a specific paper source only, do not select “Switch to another cassette
with same paper size.”

1 Choose Error
Handling from the
Settings pop-up
menu.
2 Make the selection
you want.
The default is set in
the Apple Printer
Utility.

Printing with a desktop printer
You can also print documents without leaving the Finder, using one of the two
methods described here. These methods are particularly efficient when you
have a number of documents from the same application that you want to print
at once.
m Drag the icons of the documents (from one application) to the desktop icon
of the printer you want to use.

or
m Select the icons of the documents you want to print and choose the Print
command from the File menu. The documents will be printed on the
default printer. (See “Switching Between Printers,” next.)
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In either case, the computer shows you the Print dialog box so you can choose
printing options. Make your choices, then click the Print button.
After a few moments, the first document starts to print. If background
printing is turned on, you can continue working while the document is
printing. You can also monitor and control the documents that are waiting to
print. (See “Monitoring Printing,” later in this chapter.)

Switching between printers
If you have more than one printer available, you can select which you want to
use. The printer you select is called the default printer. All your documents
will be printed on the default printer until you select a new one.
A bold outline indicates that this is the default printer,
the printer you will use until you indicate otherwise.

A plain outline indicates that this is not the default printer.

To change the default printer, use one of these four methods, as described in
the next sections.
m Drag the document you want to print to a desktop printer icon, and it will
automatically become the default printer.
m Select the desktop printer icon and use the Printing menu to set the printer
as the default.
m Select a new printer using the Chooser or the Desktop Printer Utility.
m Select a new printer from the Printer menu—the printer icon toward the
right side of the menu bar (if installed)—or Control Strip.
Note: Switching between printers may change how much information you
can fit on a page. It’s best to choose a printer before you spend much time
formatting the document.
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Drag the document you want to print to a desktop printer icon
Drag the icon of any document you want to print to the icon of the printer
you want to use. (See “Printing With a Desktop Printer,” earlier in this
chapter.)
Printing PostScript files as text
To print a PostScript file as text, hold down the Option key and drag the
document to the icon of the printer you want to use.

Select the printer using its desktop printer icon
If you already have a desktop printer icon for the printer you want to use,
follow these steps to select the printer without immediately printing anything
on it:
1

Click the icon of the desktop printer you want to use.

A Printing menu appears on the menu bar at the top of the screen.
2

Choose the Set Default Printer command from the Printing menu.

Until you choose another printer, the Print command will send your
documents to this printer.
Shortcut: Select a desktop printer and press x-L to make that printer the
default printer.

Select a new printer using the Chooser
If you don’t have a desktop printer icon for the printer you want to use, you
can select the printer using the Chooser. The Chooser then creates a desktop
printer icon for the printer that you select.
For more information on using the Chooser to select a printer, see “Step 2:
Choosing the Printer” in Chapter 2.
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Select a new printer using the Desktop Printer Utility
If you don’t have a desktop printer icon for the printer you want to use, you
can select the printer using the Desktop Printer Utility. The Desktop Printer
Utility then creates a desktop printer icon for the printer that you select.
For more information on using the Desktop Printer Utility to select a printer,
see “Using the Desktop Printer Utility” in Chapter 2.

Select a new printer from the Printer menu (the printer icon in the
menu bar) or the Control Strip
A printer icon is created next to the Help menu when you install the
LaserWriter software. Only printers that have desktop icons associated with
them are listed in the Printer menu. Selecting a printer from this menu makes
that printer the default printer.
Note: Use Custom Install to install the Printer menu.
If the Control Strip was installed when you installed the LaserWriter software,
a Printer menu appears in the Control Strip. Selecting a printer from this
menu makes that printer the default printer.

Working with desktop printer icons
To create a desktop printer, select the printer using the Chooser. After you
click Create, the icon appears on your desktop. See “Select a New Printer
Using the Chooser” under “Switching Between Printers,” the previous section
in this chapter.
You can also do the following with desktop printer icons:
m Throw away the icon. Drag the icon to the Trash. You can’t throw away a
desktop printer icon while the printer is printing a document.
Note: You must always have at least one printer icon on your startup disk.
If you throw away the last icon, it will immediately be created again on the
desktop folder.
m Rename the icon. Rename the icon as you would any other Finder icon.
Click the name to highlight it, then type the new name. This changes the
name of the icon, not the name of the printer.
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m Move the icon. You can drag the icon anywhere you like. The icon can
remain on the desktop or be placed in a folder.
m Create an alias for the icon. You can create an alias for the icon as you would
for any Finder icon, by selecting the icon and choosing the Make Alias
command from the File menu. The alias can be moved anywhere on
or off the desktop or placed in a folder.

Determining the status of a printer by looking at its icon
You can tell the status of a printer by looking at its desktop icon:
Plain icon indicates a printer
that is not currently chosen
for printing.

Stopped icon indicates you have
stopped the print queue.

Default icon indicates the printer
you have currently chosen to
print on.

Error icon indicates there is an
error on this printer. Double-click
the icon to see a message.

Printing icon indicates a
document is printing on
this printer.

Disabled icon indicates the
Desktop Printing extension is
turned off or the LaserWriter
extension is no longer in the
Extensions folder.

Monitoring printing
If you are using background printing, you can use the desktop printer features
to monitor and control the documents that are waiting to print.
1

Double-click the desktop printer icon you’re interested in.
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A window opens listing the documents that are printing or waiting to print:
Select a document
that’s on hold and
click the Resume Job
button to resume
printing.

Select a document and click the Set Print
Time button to specify when the document
should be printed.

Select a document and click
the Remove button to cancel
the print request.
Document currently printing

Select a document
and click the Hold Job
button to put a print
request on hold.

Column titles (click to sort)
Documents waiting to print

Watching the status messages can be helpful when troubleshooting printing
problems. When more than one job is waiting to be printed, a list of print
jobs appears in the waiting list, showing the order in which they will be
printed (when sorted by print time.)
2

Choose what you’d like to do.

m To cancel a print request, select it by clicking its title or icon and click the
Remove button. (You can select more than one item at a time by holding
down the Shift key while clicking.) You can also drag the icon for the print
request to the Trash. Note that these methods delete only the print request
(also referred to as a spool file), not the document itself.
m To put a print request on hold, select it and click the Hold Job button. The
print request will stay on hold until you select it again and click the
Resume Job button. You can also put the document that’s currently printing
on hold by dragging it to the list of documents waiting to print (lower part
of the window).
m To indicate that a print request is urgent, select it and click the Set Print Time
button. In the dialog box that opens, click Urgent. This moves the print
request to the top of your list.
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m To indicate that a print request should not print until a specified time, select it and
click the Set Print Time button. In the dialog box that opens, click At Time,
then set the time you want.
m To change the order of the items waiting to print, change their place in the list by
dragging their titles up or down in the list.
m To sort the list of documents waiting to print, click the title of the column you
want to sort by. For example, to sort by the name of the document, click
Document Name. (You can also sort by choosing the commands in the
View menu.) The column title you sorted by is underlined. Sorting the
items does not change the order in which they will print. To see that order,
sort by Print Time.
m To temporarily stop all documents from printing on this printer, choose Stop Print
Queue from the Printing menu in the Finder menu bar. To resume using the
printer, choose Start Print Queue from the Printing menu.
Shortcut: Pressing the Option-Shift keys changes the Hold Job and Resume
Job buttons to Stop Queue and Start Queue.
Shortcut: The Printing menu for starting and stopping the print queue is
available without opening the window for the printer, so long as the
printer’s icon is selected on the desktop.
m To move a print request from one printer to another printer of the same type (for
example, from a LaserWriter 8500 to a LaserWriter 12/640 PS), drag the
icon for the print request to the icon of the printer where you want to move
it. The printing software won’t let you move a print request to an
incompatible printer. For example, you can’t move a request from a
LaserWriter printer to a StyleWriter printer.
m To get information about the printer, choose Get Printer Info from the Printing
menu. Status, configuration, and font information is displayed.
m To change the printer setup (for example, when you add or remove printer
options, such as the duplex printing unit), choose Change Setup from the
Printing menu.
m To change the manual feed alerts, choose Show Manual Feed Alert from the
Printing menu. A checkmark by this command means that the manual feed
alert message will appear.
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Turning off or removing the desktop printing software
You can remove an individual desktop printer icon by dragging it into the
Trash. If you have only one desktop printer, you can’t get rid of the icon by
dragging it to the Trash. (The icon will reappear if you do.)

Turning off the Desktop PrintMonitor
If you don’t want to use desktop printers, you can turn off the Desktop
PrintMonitor using the Extensions Manager (available on Mac OS versions
7.5 or later).
To turn off the Desktop PrintMonitor:
1

Open the Extensions Manager control panel in the Control Panels folder.

2

Click to deselect (remove the checkmark next to) Desktop PrintMonitor, Desktop Printer
Menu (if installed), Desktop Printer Spooler, and Desktop Printer Extension (if using a
version of Mac OS earlier than 8.0) in the panel.

3

Click the close box to close the control panel.

4

Restart your computer.

Removing the desktop printing software
The desktop printing software uses both the Desktop PrintMonitor and the
PrintMonitor software. The Desktop PrintMonitor requires 200–400K of
memory in addition to the memory required by the PrintMonitor. If you don’t
want to use the desktop printing software, you can remove it.
To remove desktop printing software:
1
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Restart your computer with the extensions off by holding down the Shift key and
choosing Restart from the Special menu. Hold the Shift key down until the message
“Extensions off” appears or until your normal desktop appears.

2

Drag the following files from the Extensions folder (inside the System Folder) to
the Trash:

m Desktop PrintMonitor
m Desktop Printer Menu
m Desktop Printer Spooler
m Desktop Printer Extension (if using a version of Mac OS earlier than 8.0)
3

If you have the Control Strip installed on your system, drag the Printer Selector file
(located in the Control Strip Module folder) to the Trash.

4

Restart your computer.

Making changes to the printer setup
If you turn off desktop printing and add or remove printer options, you must
set up the printer again using the Chooser.
1

Choose the Chooser from the Apple (K) menu.

The Chooser window appears.
2

Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.
3

Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.

4

Click the name of your printer.

5

Click Setup.

The Setup dialog box appears.
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6

Select the option that you want.

m Click Auto Setup to let the Chooser identify the type of printer and
automatically set up the printer software.
m Click Select PPD to choose a PostScript Printer Description file for the
printer.
m Click Printer Info to view printer information such as its name, available
memory, and so on.
m Click Configure to set up options that you’ve added to the printer.
7

Click OK.

Using the Apple Printer Utility
The Apple Printer Utility program supplied with the printer software allows
the printer administrator to control various aspects of how the printer works.
For information about using the Apple Printer Utility, see Appendix A.
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Printing from Windows applications
After you have connected the printer to your computer and installed and set
up the printer software, you’re ready to start printing. This section explains the
basic steps required to print a document, though the details can vary from one
program to another. To find out more about printing from your programs,
read the documentation that came with them. If you have Windows NT, print
using the TCP/IP protocol or AppleTalk protocol. See your Windows NT
manual for information on configuring TCP/IP.
To print a document from a Windows program, the program must be open
and the document window must be active.
1

Choose Print from the File menu.

In most cases, a Print dialog box appears in which you can select options,
including the number of copies and the pages to print. Depending on your
program, the Print dialog box may offer other options.
2

In the dialog box, select the options you want and click Print.
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Selecting page setup options
The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, input paper tray source, and orientation.
You can change these settings for every document you create. It’s
recommended that you set your page setup options when you first create a
document. Then, as you view and format the document, it will closely
resemble its final printed form.
1

Choose Page Setup (sometimes called Print Setup) from the File menu.

The Page Setup dialog box appears.
2

Select the page setup options you want and click OK.

Setting printer driver options
You can change the PostScript Printer Driver default options. For example,
you can change the pre-set paper orientation to Portrait or Landscape.
You set printer options in the printer driver Setup dialog box, which you can
open in three ways, as explained in the sections that follow:
m from the Control Panel
m from your application
m from the Print Manager
Note: When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterward. Settings you change in an application’s Print dialog box
override print options you set in the Setup dialog box.
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Opening the printer Setup dialog box from the Control Panel
1

From the Program Manager, double-click the Control Panel icon to display the
Control Panel.

2

Double-click the Printers icon to display the Printers dialog box.

3

Select the printer you want to set up from the Installed Printers list.

4

Choose Setup to display the Setup dialog box for the printer.

You can also use the Printers dialog box to select a default printer, to switch
the Print Manager on and off, and to connect your printer to a different port.
Opening the printer Setup dialog box from your application
Most applications have a Print Setup command in their File menus.
1

Choose the Print Setup command from the File menu.

This command usually displays the Print Setup dialog box.
2

If you are using more than one printer, select the printer you want to set up.

3

Click the Options (or Setup) button to display the Setup dialog box.

Note: The names of the commands and buttons used to display the printer
Setup dialog box vary from program to program. See your program’s
documentation for the precise command and button names it uses.
Opening the printer Setup dialog box from the Print Manager
1

From the Program Manager, double-click the Print Manager icon to display the
Print Manager.

2

Select the printer you want to set up from the list of Printers.

3

Choose the Setup or Printer Setup command from the Options menu.

4

Select the printer you want to set up and click Setup.

Windows 3.1 and DOS Users

149

Selecting printer options in the Setup dialog box
You can change the most commonly used printer settings from the Setup
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional
Printer Options,” next.) The previous sections explain how to open the
Setup dialog box.
The Paper tab dialog box is displayed first.
Use PostScript for normal printing. Use
Encapsulated PostScript to create a file that
can be placed in a document of a program
that accepts EPS images.

Rotated Landscape
prints text and
images in landscape
orientation, but
reverses the top and
bottom of the page,
most useful when
you’re printing with
three-hole punched
paper.
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Additional printer options
In addition to the Paper tab, other tabs display settings for
m PostScript
m Fonts
m Features
m Job Control
m Watermark
PostScript
Click the PostScript tab to display the PostScript tab dialog box, which
controls color printing, the communication protocol, and PostScript Level 2
features.
Click Default to report the printable area
to applications. Click None to report paper
dimensions to applications.

A value of zero
means the job is
never canceled.

Click Default if your printer is connected to your
computer or to a network by its parallel port. A Ctrl-D will
be sent before and after your print jobs. Click None if
your printer is connected by its Ethernet port.
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Fonts
Click the Fonts tab to display the Fonts tab dialog box. This dialog box
controls the way the driver prints TrueType fonts used in your documents.
The driver can download available TrueType fonts as TrueType fonts (Type
42), substitute available PostScript fonts for TrueType fonts, or automatically
create PostScript versions of TrueType fonts and download them to the
printer when you print.

m Send TrueType Fonts to This Printer as: Tells the driver what kind of PostScript
fonts to create for TrueType fonts. Select one of these options:
m Type 1 to synthesize outline PostScript fonts.
m Type 3 to synthesize bitmapped PostScript fonts.
m Type 42 to package TrueType fonts for the PostScript printer.
m Don’t Send to use TrueType fonts that are resident in the printer or are
supplied by print-manager software. (No TrueType fonts are resident on
the printer when it is shipped from the factory.)
IMPORTANT For information about using Font Downloader, see “Downloading

Fonts,” later in this chapter.
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Features
Click the Features tab to display the Features tab dialog box, which lets you
configure the printer software to use optional printing features that you install
on the printer. Use this dialog box to set up any optional features you may
purchase, such as additional memory or the 500-sheet feeder and cassette.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter and
A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes
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Job Control
Click the Job Control tab to display the Job Control tab dialog box, which
controls such options as when the PostScript header and the PostScript error
handler are sent to your printer.

Select this option to
send a special
PostScript error
handler with every
document you print.
The error handler
prints a page with a
PostScript error
message when a
document fails to
print correctly.

m PostScript Header The PostScript header contains instructions that a
PostScript printer needs to print documents created by the driver. If
your printer is connected directly to your computer only, you can save
time by choosing the Download button to send the PostScript header only
once—when you switch on your printer. Download Each Job tells the
driver to send the PostScript header with every document. Already
Downloaded tells the driver not to send the PostScript header with
documents. Download tells the driver to send the header when you choose
the Download button.
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Watermark
Click the Watermark tab to display the Watermark tab dialog box, which
contains options for defining, editing, and deleting watermarks.
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Edit Watermark
Choose the Edit button in the Watermark tab dialog box to display the Edit
Watermark dialog box.

Downloading fonts
The printer uses downloadable PostScript fonts, which are a type of soft font.
The PostScript printer driver automatically downloads Type 1 fonts from your
computer’s hard disk to the printer’s memory as needed for each document
that you print. You can also use the driver to manually download fonts to the
printer’s memory or hard disk when you don’t want to download fonts for each
document. Manually downloading fonts can speed printing.
Note: The printer has a set of built-in fonts that do not need to be
downloaded. These fonts are listed in “Printer Fonts” in Appendix D.
Whether it is better to let Windows download fonts automatically or to
manually download fonts yourself depends on the number of fonts and
frequency with which they are used in a document and the size of your
printer’s memory.
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Downloading a Type 1 font to a PostScript printer usually takes from 15 to 20
seconds. When a program prints a document containing a font that is not
resident in your printer, Windows automatically downloads the font with the
document. However, after the document prints, any fonts that have been
downloaded with the document are cleared from the printer’s memory. This
means that each time you print a document that contains fonts not resident in
the printer, the fonts must be downloaded.
By contrast, when you manually download a Type 1 font with the Font
Downloader, the font remains in printer memory (RAM) until you switch off
or restart the printer or when memory limitations are exceeded. Manually
downloading frequently used fonts therefore reduces printing time because
the fonts do not have to be sent to the printer each time they are used. Keep in
mind, however, that fonts manually downloaded to RAM reduce the overall
amount of memory available for printing and so may affect the printing of
documents that do not contain the downloaded fonts.
In addition to downloading fonts, you can also use the Font Downloader
to perform various printer management tasks, such as adding a hard disk (or
other font storage device), listing and removing downloaded fonts, manually
downloading PostScript language files, clearing the printer font cache, and
resynchronizing your printer with the Windows driver.
See your network administrator for more information about performing these
tasks on your network, or choose the Help button in the Font Downloader
dialog box to see instructions for these tasks.
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Downloading fonts manually to RAM or to the hard disk
Fonts need to be downloaded only once. Users who want to use fonts that
have already been downloaded should use the Job Control tab dialog box
(described earlier in this chapter) to turn on Do Not Download Fonts.
Otherwise, the fonts will be downloaded again, wasting time and system
resources.
1

From the Program Manager, open the Control Panel.

2

Double-click the Printers icon.

The Printers dialog box appears.
3

If it is not already selected, select the printer from the Installed Printers list.

4

Click Setup.

The Setup dialog box appears.
Note: You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.
5

Click Fonts.

6

Click Font Downloader.

The Font Downloader dialog box appears.
7

Select the destination from the Destination Memory list box.

8

Select the fonts you want to download from the Fonts Available list.

Fonts that are already present in the printer’s ROM do not need to be
downloaded. For a list of these fonts, see Appendix D or print a list of font
samples by choosing Print Font Samples in the Apple LaserWriter Utility
for Windows.
9

Click Download.

The Font Downloader informs you of its progress as it downloads fonts.
Note: While downloading, you can use other programs, but you can’t print.
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10

After you are finished downloading fonts, click Exit.

You are returned to the Setup dialog box.
11

Click OK to close the Setup dialog box.

12

Click Close to close the Printers dialog box.

13

Choose Exit from the Settings menu to close the Control Panel.

You can confirm that the fonts were downloaded by printing a list of font
samples with the Apple LaserWriter Utility for Windows.

Using a hard disk
You can add an external hard disk to the printer. A hard disk can store many
fonts so they don’t need to be downloaded each time you use them, thus
expediting your printing. Chapter 5 explains how to connect a hard disk.
After the hard disk is connected, you must add it to the device list and, if
necessary, initialize it, as explained in the next two sections.

Adding a hard disk to the device list
1

From the Program Manager, open the Control Panel.

2

Double-click the Printers icon.

The Printers dialog box appears.
3

If it is not already selected, select the printer from the Installed Printers list.

4

Click Setup.

The Setup dialog box appears.
Note: You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.
5

Click Fonts.

6

Click Font Downloader.

The Font Downloader dialog box appears.
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7

Click Device Installer.

A dialog box opens.
8

Click Add New.

Another dialog box opens.
9

Make sure “Magnetic disk” is selected, then click Add.

10

Complete the dialog box as follows:

m Fill in the Available Memory box with the number of kilobytes your hard
disk can store.
m If you have Font Metrics files for the fonts, you can select the Read Font
Metrics Files checkbox.
m Make sure the Volatile checkbox is not selected.
m Make sure the Writable checkbox is selected.
11

Click Add.

A dialog box opens.
12

Type a name for the hard disk.

13

Click a button to indicate which SCSI number the hard disk has.

14

Click OK.

You return to the Device Installer dialog box.
15

Click Close.

If the hard disk is already initialized in Adobe AFS format, you can now
download fonts as described in “Downloading Fonts” earlier in this chapter. If
not, go on to initialize the hard disk.
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Initializing the hard disk
If you attach a hard disk to the printer to store fonts, you might need to
initialize it (if it is not already in Adobe AFS format) before you can use it.
You can do so by following the steps below.
WARNING Initializing the hard disk erases all the data on it. Initialize the
hard disk only if you’re sure it’s not already initialized in Adobe AFS
format (for example, if it’s new) or that it’s OK to erase it.

1

From the Program Manager, open the Control Panel.

2

Double-click the Printers icon to display the Printers dialog box.

3

If it’s not already selected, select the printer from the Installed Printers list.

4

Click Setup.

The Setup dialog box appears.
Note: You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.
5

Click the Fonts tab.

6

Click Font Downloader.

The Font Downloader dialog box appears.
7

Click Other.

A dialog box opens.
8

Click the Format Device button, then click OK.

9

Select the disk name and click OK.

Initializing the hard disk takes a few minutes. The Ready/In Use light on the
printer blinks until initialization is complete.
When initialization is complete, you can download fonts to the hard disk. See
“Downloading Fonts,” earlier in this chapter.
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Printing to a PostScript file
As an alternative to printing your document on the printer, you can save a
PostScript language description of your document as a disk file. PostScriptlanguage descriptions of documents can be useful for
m creating document archives
m printing documents without using the program that created them (at a
service bureau, for example)
m diagnosing printing problems
You may also want to print an encapsulated PostScript (EPS) file. You can use
EPS files to export single pages from one program to another. EPS files can
include any combination of text, graphics, and images, but they do not
describe complete documents. For example, by saving an EPS file, you can
insert a page of a document created with one program as an illustration in a
document created by another program.
Note: PostScript files are normally ASCII text files that can be opened with
any word-processing program. However, if you select the “Send Data in
Binary” option in the PostScript Options dialog box, the PostScript files may
include binary characters that make them unsuitable for use with a word
processor.
You can use either of two methods to create PostScript files. If your program’s
Print dialog box has a “Print to File” checkbox, you can use this checkbox to
create a PostScript file; this is the preferred method. Refer to your program
documentation for information. If your program’s Print dialog box does not
have a “Print to File” checkbox, however, you need to make temporary
changes to your printer setup to create a PostScript file, as described next.
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Using the driver to print to a PostScript file
Using the driver to print to a PostScript file is a three-step process. First
change your printer setup, then use your program to create the file, and finally
reset your printer setup for normal printing.
Step 1: Changing your printer setup to print to a PostScript file
1

From the Program Manager, open the Control Panel and double-click the Printers icon.

The Printers dialog box appears.
2

If it is not already selected, select the name of the PostScript printer that you are using
from the Installed Printers list.

3

Select Connect.

The Connect dialog box appears.
4

Select FILE from the Ports list box.

You may have to scroll through the list to find this selection.
5

Choose OK to close the Connect dialog box and return to the Printers dialog box.

6

Choose Setup.

The driver Setup dialog box appears.
7

After changing (or confirming) your printer settings, choose OK to close the dialog box.

Note: Choose settings in the PostScript Options dialog box that will produce
a file that prints correctly on the destination printer. For example, select the
“Use PostScript Level 2 Features” option if you are sure that you will be
printing the file only on Level 2 printers. If you plan to use a printer that does
not support binary communication, disable the “Send Data in Binary” option.
The “Optimize for Portability” option creates PostScript files that print
successfully from different programs on a wide variety of printers and
imaging devices; it is recommended that you enable this option.
8

Choose Close to close the Printers dialog box.

9

Choose Exit from the Settings menu to close the Control Panel.

Your computer is now set up to create PostScript files when you choose the
Print command from a Windows program.
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Step 2: Printing to a PostScript file
1

Start the program and open the document for which you want to create a PostScript file.

2

If necessary, select the Print Setup command from the File menu, change the settings as
appropriate, and select OK.

3

Choose the Print command from the File menu.

Your program’s Print dialog box appears.
4

Choose OK.

A dialog box appears that asks you to name the file.
5

Enter a pathname and filename for the file.

If you don’t specify a pathname, the PostScript file is placed in your program’s
default directory.
6

Choose OK.

The PostScript file is created, and you are returned to your program.
Step 3: Restoring your printer setup options
After creating PostScript files, you need to restore your original printer setup
options before you can use your printer again.
1

From the Program Manager, open the Control Panel.

2

Double-click the Printers icon.

The Printers dialog box appears.
3

If it is not already selected, select the printer model from the Installed Printers list.

4

Choose Connect.

The Connect dialog box appears.
5

In the Ports list box, select the port to which your PostScript printer is connected.

6

Choose OK.

The Connect dialog box closes, and you are returned to the Printers
dialog box.
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7

If you changed any printer settings to print a PostScript file, choose Setup to display the
Setup dialog box. Undo any changes you made and then choose OK.

The Printers dialog box appears.
8

Select OK to close the Printers dialog box.

9

Choose Exit from the Settings menu to close the Control Panel.

Printing from DOS applications
If you are using DOS programs, refer to the manual that came with your
program and follow the instructions for using a PostScript printer. Most DOS
programs are PostScript-compatible.
Capturing a print queue for DOS printing
From DOS, you can use the NetWare CAPTURE command to map the
parallel port to a print queue.
m Log in to the NetWare network and enter the CAPTURE command, using the
following syntax:
CAPTURE /q=queue_name local=lptnumber server=server_name
job=new

Unless you specify otherwise, the command assumes that you are mapping
the LPT1 port to a queue.

Using the Apple LaserWriter Utility for Windows
The Apple LaserWriter Utility for Windows program supplied with the
printer software lets you control various aspects of how the printer works. For
information about using the Apple LaserWriter Utility for Windows, see
Appendix A.
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Windows 95 and Windows NT Users

Printing
On a PC, printing functions are controlled through the Page Setup and Print
dialog boxes, which are accessed through the File menu.
Most Windows application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)

Selecting page setup options
The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, format, and orientation, as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document it will closely resemble its final printed form.
1

Choose Page Setup from the File menu.

The Page Setup dialog box appears.
2

Select the page setup options you want and click OK.
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Printing documents
When you are printing from Windows, most application programs display a
Print dialog box, in which you specify print options such as the number of
copies you want printed, the layout, and which paper tray or cassette will be
the paper source.
Some application programs also add more choices to the Print dialog box. For
information about such options, refer to the documentation that came with the
program.
1

Choose Print from the File menu.

2

In the dialog box that appears, make the selections you want and click OK.

Setting printing properties
You can change the default properties of the PostScript printer driver. For
example, you can change the default paper orientation from Portrait to
Landscape.
You set printer options in the printer driver Properties dialog box, which you
can open in three ways, as explained in the sections that follow:
m from the Control Panel
m from the Printers folder
m from your application
Note: When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterwards. Settings you change in an application’s Print dialog box
override print options you set in the Properties dialog box.
Opening the printer Properties dialog box from the Control Panel
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1

Click the Start icon on the Task-Bar, select Settings, and click Control Panel.

2

Double-click the Printers icon.

3

Select the printer you want to change and choose Properties from the File menu.

Opening the printer Properties dialog box from the Printers folder
1

Click the Start icon on the Task-Bar, select Settings, and click Printers.

2

Select the printer you want to change and choose Properties from the File menu.

Note: The Printers folder that appears is the same Printers folder that you see
from the Control Panel.
Opening the printer Properties dialog box from your application
1

Choose Page Setup from the File menu.

2

Click Printer.

3

Select the printer you want to change and click Properties.

To change optional settings for a print job, click Properties and then make the
changes you want. If you save the changes, they usually persist from one file
to the next. However, if you exit the application and reopen it later, any
properties that you changed may be reset to their original default values.
You can also open the Properties dialog box from the Print dialog box.
Note: You will see fewer options when opening the Properties dialog box
from your application or from the Print dialog box. To see the complete set of
print options, open the Properties dialog box from the Printers folder or from
the Control Panel, as described above.
1

Choose Print from the File menu.

2

Click Properties.

Changing printer settings in Windows 95
You can change the most commonly used printer settings from the Properties
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional Printer
Options,” later in this chapter.) The previous sections explain how to open the
Properties dialog box.
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The Paper tab dialog box is displayed first.

Setting document margins
Choose the Unprintable Area button in the Paper tab dialog box to display
the Unprintable Area dialog box, which lets you set the page margins.
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Setting duplex printing options
Choose the More Options button in the Paper tab dialog box to display the
More Paper Options dialog box, used to specify duplex print settings.

Select “Flip on long edge” if you want the
binding orientation along the long edge of the
paper (as in a book or magazine). Select
“Flip on short edge” if you want the binding
orientation along the short edge of the paper
(as in a calendar).

The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter and
A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes
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Additional printer options
In addition to the Paper tab, other tabs display settings for
m Graphics
m Device Options
m PostScript
m Watermarks
m Fonts
m General
m Details
m Sharing
Graphics
Click the Graphics tab to display the Graphics tab dialog box, which controls
resolution and special printing features.
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Device Options
Click the Device Options tab to display the Device Options dialog box, which
lets you configure the printer software to use optional printing features that
you install on your printer. Use this dialog box to set up any optional features
you may purchase, such as additional memory or the 500-sheet feeder and
cassette.
FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting for the FinePrint feature to on or off. Users can
change this setting from the Print Options dialog box. To print high-quality
images, turn off FinePrint.
PhotoGrade enhances the look of printed images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. You can set the printer’s default to have PhotoGrade turned on or off.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter and
A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes
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When the printer runs out of paper in one tray, it can automatically switch to
another paper cassette or the multipurpose tray. By using automatic tray
switching between the 500-sheet paper cassette and the 150-sheet
multipurpose tray, you can print 650 sheets without reloading paper. If you
have the optional 500-sheet feeder and cassette, and it contains the same size
paper, automatic tray switching includes it as a paper source. If you have two
optional 500-sheet cassettes and feeders, you can print 1650 sheets without
reloading paper.

These options appear only when you open
the Properties dialog box from the Printers
folder.
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PostScript
Click the PostScript tab to display the PostScript tab dialog box, which
controls the output format.

These options appear only when you open
the Properties dialog box from the Printers
folder.

m PostScript output format Tells the driver to build PostScript document
descriptions that print as fast as possible when “Optimize for Speed” is
selected. Such document descriptions might not print successfully on
printers with limited memory. Select “Optimize for Portability” to tell the
driver to build PostScript document descriptions that print successfully on
many different printers. Select “Encapsulated PostScript” to tell the driver
to build an encapsulated PostScript document description, rather than a
PostScript description. Select “Archive format” to suppress many of the
printer settings that might prevent the file from printing. Choose this
option only if the file might be printed on unknown devices.
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Advanced PostScript options

Choose the Advanced button in the PostScript tab dialog box to display the
Advanced PostScript Options dialog box.

Select “Send
CTRL+D after job”
only if you are
connected via the
parallel port. For
network jobs,
deselect this option.
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Watermarks
Click the Watermarks tab to display the Watermarks tab dialog box, which
contains options for defining, editing, and deleting watermarks.

Deselect “In
background” if you
cannot see the
watermark on the
printed page.

Edit watermark

Choose the Edit button in the Watermarks tab dialog box to display the Edit
Watermark dialog box.
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Fonts
Click the Fonts tab to display the Fonts dialog box, which controls font
substitution. The Fonts tab is available only if you open the Properties dialog
box through the Printers folder.

Tells the driver to
ignore the Font
Substitution Table

Specifies how to
send TrueType or
PostScript fonts
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Displays the Font Substitution Table, used
to substitute PostScript fonts for TrueType
fonts

Lets you update the list of installed
PostScript fonts so that the printer driver
prints them correctly

General
Click the General tab to display the General tab dialog box, which lets you
insert comments about the printer and specify whether to use a separator
page between print jobs. The General tab is available only when you open the
printer Properties dialog box from the Printers folder.
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Details
Click the Details tab to display the Details tab dialog box, which controls the
printer port. The Details tab is available only when you open the printer
Properties dialog box from the Printers folder.

Maps a port to a
network path

Specifies how long
Windows 95 waits
for the printer to be
ready before
reporting an error
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Adds a new port or specifies
a network path
Removes a port from a network path

Specifies how long Windows 95 waits
for the printer to be online before
reporting an error

Sharing
The Sharing tab dialog box controls network sharing of the printer. Even if
you are not using NetWare, you can still share your printer with other users
on a Microsoft Network.
The Sharing tab is available only when you open the printer Properties dialog
box from the Printers folder. If you don’t see the Sharing tab from the Printers
folder, open the Network Control Panel. Select Microsoft Networks as your
Primary Network logon. Then select File and Print sharing. Select the options
you want and restart your system. Open the printer Properties dialog box
from the Printers folder. The Sharing tab should now be available.

Text in the Comment field is displayed to
users when they select a network printer.
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Changing printer settings in Windows NT
You can change the most commonly used printer settings from the Properties
dialog box.

Click the plus (+) icon
to view more option
information about
each topic.

The current settings
are shown next to
each option.

To change an option,
select it from the list
above and select its
new value here.

Using the Apple LaserWriter Utility for Windows
The Apple LaserWriter Utility for Windows program supplied with the
printer software lets the printer administrator control various aspects of how
the printer works. For information about using the Apple LaserWriter Utility
for Windows, see Appendix A.
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Printing Envelopes

Printing envelopes from the multipurpose tray
You can load a stack of ten envelopes in the multipurpose tray for automatic
printing. You can also print envelopes manually by feeding them one
envelope at a time.
This illustration shows how to load a stack of envelopes in the multipurpose
tray.
Stack the envelopes so that
the tops are to the right
and the flaps are down.

Slide the width guides so
that they rest against the envelopes.
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Adjust the width guide on the multipurpose tray to the size of the envelope.
If you print many envelopes: You can obtain an envelope cassette from an
Apple-authorized dealer that allows you to feed up to 75 envelopes
automatically.
WARNING Don’t use envelopes that have fasteners, snaps, or windows
with the printer. Also don’t use envelopes that seal with peel-off strips
or pressure-sensitive adhesives, that are curled or wrinkled, or that are
likely to discolor or melt at temperatures of about 400° F (200° C).
Printing on such materials can damage the printer.

For best results when printing envelopes, be sure to position your address
block properly in your word-processing document. You’ll need to print in
landscape (horizontal) orientation and to adjust the top and left margins with
your word-processing program’s page formatting controls.
Once you’ve set the top and left margins, type the return address, skip a few
lines (the exact number depends on the font you’re using and the way you
like your envelopes to look, so you’ll have to experiment), and type the
address block.
Printing an envelope
1

Open the multipurpose tray.

2

Adjust the width guide to fit the envelope.

3

Insert your envelope into the multipurpose tray.

4

Set your program to print widthwise on the envelope.

On a Mac OS–based computer, choose Page Setup from the File menu, select
the Landscape orientation icon, and click OK.
On a Windows 3.1–based computer, open the Printer Setup dialog box and
select Landscape in the Orientation option.
On a Windows 95–based computer, open the print Properties dialog box and
select Landscape in the Paper tab.
On a Windows NT–based computer, open the print Properties dialog box,
choose the Advanced tab, and select Landscape in the Orientation option.
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5

Set your program to print using the multipurpose tray.

On a Mac OS–based computer, choose Print from the File menu, select Manual
Feed or Multipurpose Tray from the Paper Source pop-up menu, and click
Print.
Note: If you select Manual Feed as the paper source, you will be alerted to
insert an envelope each time you print.
On a Windows 3.1–based computer, open the Printer Setup dialog box, select
the multipurpose tray from the Paper Source options, and click OK to close
the Setup dialog box. Choose the Print command from the File menu and
click OK.
On a Windows 95–based computer, open the print Properties dialog box and
select the multipurpose tray from the Paper Source option in the Paper tab.
On a Windows NT–based computer, open the print Properties dialog box,
choose the Advanced tab, and select the multipurpose tray from the Paper
Source options.

Printing envelopes with the optional envelope cassette
The optional envelope cassette positions the envelopes in the middle of the
tray. Be sure to set your word-processing program’s page formatting controls
accordingly.
Note: If the multipurpose tray and the optional envelope cassette have the
same size envelopes when automatic tray switching is on, the printer will use
the multipurpose tray first (if the multipurpose tray is set to the envelope
size). To use the envelope cassette, do one of the following:
m Choose the envelope cassette as the paper source in the Print dialog box.
m Change the optional envelope cassette to “Installed and Preferred” in the
Setup dialog box. (You can view the setup dialog box by selecting the
desktop printer icon and choosing Change Setup from the Printing menu.)
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1

Load the optional envelope cassette and insert it into the 500-sheet feeder.

See the instructions that came with the envelope cassette.
2

Set your program to print widthwise on the envelope.

On a Mac OS–based computer, choose Page Setup from the File menu, select
the Landscape orientation icon, and click OK.
On a Windows 3.1–based computer, open the Printer Setup dialog box and
select Landscape in the Orientation option.
On a Windows 95–based computer, open the print Properties dialog box and
select Landscape in the Paper tab.
On a Windows NT–based computer, open the print Properties dialog box,
choose the Advanced tab, and select Landscape in the Orientation option.
3

Set your program to print using the optional envelope cassette.

On a Mac OS–based computer, choose Print from the File menu, select the
cassette where the optional envelope cassette is installed from the Paper
Source pop-up menu, and click Print.
On a Windows 3.1–based computer, open the Printer Setup dialog box, select
the cassette where the optional envelope cassette is installed from the Paper
Source options, and click OK to close the Setup dialog box. Choose the Print
command from the File menu and click OK.
On a Windows 95–based computer, open the print Properties dialog box and
select the envelope cassette from the Paper Source option in the Paper tab.
On a Windows NT–based computer, open the print Properties dialog box,
choose the Advanced tab, and select the cassette where the optional envelope
cassette is installed from the Paper Source option.
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Note: If the multipurpose tray and the optional envelope cassette have the
same size envelopes when automatic tray switching is on, the printer will use
the multipurpose tray first (if the multipurpose tray is set to the envelope
size). To use the envelope cassette, do one of the following:
m Choose the envelope cassette as the paper source in the Print dialog box.
m Change the optional cassette to “Installed and Preferred” in the Setup
dialog box. (You can view the Setup dialog box by selecting the desktop
printer icon and choosing Change Setup from the Printing menu.)
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Maintenance

The printer is designed for trouble-free service. Maintenance involves little
more than putting in a new toner cartridge every 14,000 pages or so and
performing a few minor cleaning tasks. The recommended service interval is
200,000 pages to check and service wear on the rollers and fuser. This service
can be arranged through an Apple-authorized dealer.

Safety first
The fixing roller assembly in the printer operates at very high temperatures—
around 400° F (200° C). Allow the rollers to cool (approximately 40 minutes)
before performing maintenance and troubleshooting.

Precautions during maintenance
To prevent damage to the printer while performing maintenance, observe the
following precautions.
m Don’t lubricate the printer.
m Don’t attempt to disassemble the printer.
m Don’t place anything on top of the printer.
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Regular maintenance
The toner cartridge holds the toner powder that forms the printed images.
Each cartridge should yield about 14,000 pages. If you print many graphic
images, you may need to change cartridges more often. If your pages start to
look too light, or if you see vertical white regions in dark images, it may be
time to change the cartridge.
For ordering information, see “Options and Accessories” in Appendix D.

Replacing the toner cartridge
Whenever you install a new toner cartridge, you should also clean the interior
of the printer. To replace the toner cartridge, follow the instructions in
“Installing the Toner Cartridge” in Chapter 1.
WARNING Use only toner cartridges designed for use with your printer.

Other cartridges will not fit and may damage the printer.

Cleaning the exterior
Unplug the power cord and then wipe the exterior of the printer with a clean,
soft, damp cloth. Use a mild soap or detergent if necessary, but never use
an ammonia-based cleaner. Be careful not to get any liquid in the power
cord port.
WARNING Never use ammonia-based cleaners on or around the printer.

They may react chemically with the toner and with the printer’s
plastic case.
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Troubleshooting
Chapter 11

Fixing Paper and Image Problems

Chapter 12

Fixing Other Problems

Part III offers solutions to problems you might
encounter while using the printer.

III
part

11

Fixing Paper and Image Problems

This chapter provides solutions to problems you may encounter with paper
jams or print quality while using your printer. The first section discusses how
to read the printer’s indicator lights to help you identify and solve problems,
and how to clear paper jams. The rest of the chapter covers specific problems
that can occur when you are printing a document.
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Checking the indicator lights
The lights on the front panel of the printer indicate the printer’s operating
status.
Light

On

Off

Flashing

Paper Jam

There is a paper
jam.

Paper is OK.

Printer requires
service.

Paper Out

Paper cassette
is empty.

Paper supply is OK.

Printer is ready for
sheet of manual-feed
paper.

Toner Low

Toner is getting
low.

Toner level is OK.

Toner cartridge is
not installed.

Ready/In Use

Printer is ready
to use.

Printer cannot print
because of an error,
or the cover is open,
or the printer is
turned off.

Printer is warming up,
printing a startup
page, or processing
data for the next
print job.

If the Paper Out and Paper Jam lights flash alternately, or all four lights stay
on, the printer requires service. If you have just installed additional memory
(RAM) in the printer, there may be a problem with the memory. Open the
printer and make sure the SIMM is fully seated in the sockets and match one
of the supported configurations listed in Chapter 5 and in Appendix D.

Checking for and clearing paper jams
Occasionally a piece of paper may get stuck inside the printer during the
printing process. Follow these steps to find and clear a paper jam.
IMPORTANT If you experience paper jams after you first set up the printer,

check all areas of the printer to make sure that the packing materials have
been removed.
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1

Open the back door of the printer to see whether paper is jammed there. If so, gently pull
out the jammed paper.

2

Open the top cover of the printer and remove the toner cartridge. If the jam is around the
pressure roller area, remove the paper as shown here:
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3

Once you have removed the jammed paper, reinsert the toner cartridge and close the
top cover.

Note: You must open and close the top cover to reset the printer.
4

Remove the paper cassette to see whether the jam is in the paper cassette area. If so,
gently release or pull out the jammed paper.

Check that all paper edges are under the bracket at the front of the cassette.
Paper edges over the bracket are also considered paper jams.
5
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Check the paper exit area on top of the printer to see whether the paper is jammed there.
If so, gently pull the paper out.

Checking the optional 500-sheet feeder and cassette
1

Open the back door of the paper feeder to see whether paper has jammed there. If so,
gently pull out the jammed paper.
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2

Remove the paper cassette to see whether the jam is in the paper cassette area. If so,
gently release or pull out the jammed paper.

Check that all paper edges are under the bracket at the front of the cassette.
Papers edges over the bracket are also considered paper jams.
If you have removed the jammed paper, open and close the top cover to reset
the printer.
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Checking the optional duplex printing unit
1

Open the duplex printing unit’s top door to see whether paper has jammed there. If so,
gently pull out the jammed paper.
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2

Open the duplex printing unit’s lower back door to see whether the jam is around the
paper guide for the duplex printing unit. If so, gently pull out the jammed paper.

Note: If you opened the duplex printing unit’s top or back door, it is not
necessary to open and close the top cover to reset the printer.

Avoiding paper and envelope jams and wrinkling
Some papers or envelopes may jam or wrinkle as they pass through the
printer.
If you experience paper jams, loosen up the stack of paper by fanning it
before you load it into the paper cassette. Be sure not to overload the cassette.
With stiffer paper stock, try printing the paper from the multipurpose tray,
which provides a straighter feed into the printer than the cassettes.
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Problems with printed documents
This section provides remedies for problems in the appearance of a printed
document.
The quality of grayscale art could be better.

Turn on the PhotoGrade feature, as described in Chapter 6 for Mac OS users
and Chapters 7 and 8 for Windows users. Also try turning off the FinePrint
feature.
Paper curls when you print on it.

Use only 16- to 24-pound laser-quality or photocopy bond paper for automatic
feed and 16- to 32-pound paper for manual-feed printing. If you are using the
correct weight and the paper still curls, try using a different brand of paper.
Use paper that has been in a sealed wrapper; paper that has been out for a
long time may have too much moisture in it.
Toner does not stay fixed on the paper.

If the toner does not stick to the paper, try using different paper. Best results
are obtained with laser-quality or photocopy bond paper.
The printer prints on only part of the paper, printing is off-center, or images are out
of place.

Make sure that you have selected the appropriate paper source, paper size,
and orientation in your printing software. (On a Mac OS–based computer,
click the Page Image icon in the Page Setup dialog box; if you want to narrow
the margins to print on more of the page, you can select Larger Print Area in
the Options portion of the Page Setup dialog box.)
Check the paper width guide in the cassette. If the width guide is set too
wide, the paper may be fed into the printer at an angle.
Also check that the margins set in your document are correct, that you are not
using a type of paper that is causing a feeding problem, and that the paper
cassette isn’t too full.
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Nothing is printed on the paper.

If you get a blank document, try the following steps.
m If the cartridge is new, be sure to remove the plastic tape.
m Redistribute the toner powder by gently rocking the toner cartridge.
If you still get a blank document, the cartridge may have run out of toner and
needs replacing.
The image prints in black and white although the original document is in color or
grayscale.

If the printed image contains only black and white areas instead of grays, try
the following step.
m Check to make sure that grayscale printing is turned on (on a Mac
OS–based computer, select the Color/Grayscale option in the Print Options
dialog box).
The image is too light.

If the printed images are too light, try the following steps.
m Change the print density to a darker level.
m Replace the toner cartridge (if needed).
If you are using a Mac OS–based computer, you can change print density
with the Apple Printer Utility. For more information, see Appendix A. If you
are using an IBM PC or compatible computer, you can change print density
with the Apple LaserWriter Utility for Windows. For more information, see
Appendix A.
The image is too dark.

If the image is too dark, try the following steps.
m Change the print density to a lighter level (see Appendix A).
m Replace the toner cartridge; it may need to be changed.
The page prints solid black.

If your document prints black, turn your printer off and on again. If your
document still prints black, your printer may require service.
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The printer prints on one side even though duplex printing is specified.

If your document prints in simplex mode (only on one side) instead of duplex
mode, check the following:
m Is the optional duplex printing unit installed?
m Is duplex printing selected in the Print dialog box?
Unwanted lines or stripes appear.

If white or dark vertical or horizontal lines or stripes appear on the page, try
the following remedies. (Each procedure is described in detail in “Replacing
the Toner Cartridge” in Chapter 10.)
m Gently rock the cartridge to redistribute the toner.
m Replace the toner cartridge.
The image is wavy or distorted.

If a gray shaded area appears wavy or distorted, the toner cartridge may be
low, or the toner may need to be redistributed (see “Replacing the Toner
Cartridge” in Chapter 10).
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Toner smudges appear on the front or back of the paper.

If stains appear on the paper, try the following steps.
m Toner smudges may occur after a paper jam. In most cases, the printer
cleans itself after printing several letter-size pages.
m You may have previously printed using paper that was too small for the
printed document, which may have caused some toner to be deposited
inside the printer instead of on the paper. This can cause smudges on the
paper that goes through later. In most cases, the printer cleans itself after
printing several letter-size pages.
Faded areas or white voids appear on the page.

If portions of the page are faded or are missing, try the following steps:
m Use different paper or transparency material.
m Use paper that has been in a sealed wrapper; paper that has been out for a
long time may have too much moisture in it.
m Redistribute the toner in the cartridge (see “Replacing the Toner Cartridge”
in Chapter 10).
m Use the Apple Printer Utility for the Mac OS or the Apple LaserWriter
Utility for Windows to change the print density to a darker level (see
Appendix A).
m Replace the toner cartridge (see “Replacing the Toner Cartridge” in
Chapter 10).
Blotchy areas or ghost images appear on the page.

If there are blotchy areas within a gray area, or if you see ghost images
within printed areas (particularly on the top few inches of the page), try the
following step.
m Print two or three more copies of your page; these problems often occur
only on the first rotation of the photosensitive drum inside the printer.
The printer isn’t printing from the correct paper tray.

m Check that the correct page size and paper source are selected in the
Mac OS or Windows Page Setup dialog box.
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Troubleshooting with the indicator lights
The Ready / In Use light flashes amber and green.

The demonstration feature of the printer is enabled. To disable this feature,
turn off the printer. Press the Ready/In Use light while turning on the printer.
For more information on diagnosing and fixing problems by checking the
indicator lights on the front of the printer, see Chapter 11.

Mac OS–based computer troubleshooting
If you are using the printer from a Mac OS–based computer, use this section
for troubleshooting tips.
The Chooser does not appear in the Apple (K) menu.

If the Chooser isn’t listed in the Apple menu, the System file on your startup
disk may be outdated, or you may have removed the Chooser from the Apple
Menu Items folder in the System Folder on your startup disk. You can obtain
the current system software from an Apple-authorized dealer.
Make sure that you have only one System Folder on your startup disk.
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Paper is not taken from the correct tray when AutoSelect is turned on.

m Check the paper orientation in the cassette trays. Some trays may have
been loaded LEF while others may have been loaded SEF.
m To select paper from the multipurpose tray, make sure that the
multipurpose tray paper size is set correctly (use the Apple Printer Utility
to set the multipurpose tray paper size).
m If you have both A4 and letter paper sizes loaded in separate trays, specify
the tray that you want to use. Do not use AutoSelect.
No LaserWriter 8 icon appears in the Chooser.

Make sure that the LaserWriter 8 driver is properly installed. The printer
driver may be on your startup disk but may have been moved to the wrong
location. If necessary, drag the driver into the Extensions folder inside the
System Folder.
Also make sure that you have only one System Folder on your startup disk.
Refer to the information that came with your computer.
The printer is not listed in the Chooser or the Desktop Printer Utility.

If you’ve selected the LaserWriter 8 icon but your printer is not named in the
list of printers, one of the following may be the cause.
m The printer has been turned off. Make sure it is plugged in and turned on,
and wait for the Ready light to turn on.
m The communication settings are not set correctly. See “Adjusting
Communication Settings” in Chapter 1 and “Viewing and Changing the
Communication Settings” in Appendix A. See also Appendix D for a list of
acceptable values. To reset the communication settings to their factory
default values, set the communication switch to the Reset (out) position.
Turn the printer off and back on again. Set the communication switch to
the Normal (in) position.
m Someone may have renamed the printer. Check the startup page to see if
the name has changed.
m If you are using an AppleTalk network that contains zones, you may not
have selected the correct zone for the printer.
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m There’s a problem in the network cable system somewhere between your
computer and the printer you want to use. Make sure that all the cables are
properly connected. If you still can’t resolve the problem, the printer’s
electronics or the network connector boxes may not be functioning
properly. Call an your network administrator or an Apple-authorized
dealer.
m The printer has the same name as other printers on the network. If that’s
the case, the printer automatically appends a number to the end of its name
when it’s turned on. The number may change each time you turn on the
printer. The printer administrator can change the name using the Apple
Printer Utility for the Mac OS or the Apple LaserWriter Utility for
Windows, as described in Appendix A. You can identify your printer by
looking for the printer with the same Ethernet address (use the Apple
Printer Utility for the Mac OS or the Apple LaserWriter Utility for
Windows) that is printed on the startup page.
m Check the Network control panel to make sure the correct network
is selected.
The Desktop Printer Utility cannot be found.

The Desktop Printer Utility is not supported on Mac OS 7.6, 7.6.1, or 8.0. It
will not be installed.
The printer appears more than once in your Chooser (for example, LaserWriter 8500 and
LaserWriter 8500 1).

Your printer may be connected to a LocalTalk network and an EtherTalk
network with a router that connects them as one logical zone. Apple
recommends that you disconnect the LocalTalk port.
An “out of memory” message appears on your screen when you try to print.

The printer may have insufficient memory to print if
m the document contains too many fonts that need to be downloaded from
your computer to the printer
m the document contains complex images
m you use a lot of fonts in your document but have not selected Unlimited
Downloadable Fonts in the Page Setup Printer Options dialog box
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If a page contains very complex images, try to remove some of the complex
detail from that page (or spread the information over two pages) and try again
to print it. Also, find Desktop PrintMonitor in the Extensions folder in the
System Folder and use the Get Info command to increase its memory size.
If you encounter the “out of memory” message frequently, you can remedy
this by increasing the amount of memory in the printer. See Chapter 5.
Printer-specific options don’t appear in the Print dialog box.

Make sure the hardware options are properly installed in the printer, as
described in Chapter 5 and the instructions that came with the options.
If the Desktop Printer extension is turned on, select a desktop printer icon.
Choose Change Setup from the Printing menu, then click Auto Setup in the
dialog box that appears.
If the Desktop Printer extension is turned off, open the Chooser and click the
LaserWriter 8 icon. Click the Setup button, then click Auto Setup in the
dialog box that appears.
Nothing is printed; no paper comes out of the printer.

If you don’t get any response from the printer when you try to print a
document, try the following steps:
m Make sure you printed on the printer you intended to use.
m Check your desktop printer for error messages. Double-click the desktop
printer icon to open the Desktop PrintMonitor.
m Try printing again, but select the Print Detailed Report option. (Choose the
Print command. Choose PostScript Error Handling, then select Print
Detailed Report.)
m Check the Chooser to be sure the printer is selected. Be sure to select the
printer’s name, as well as the LaserWriter 8 icon and, if necessary, the
AppleTalk network zone.
m Check the Paper Out light. If it is on, add paper and replace the paper
cassette.
m Check for a paper jam as described in Chapter 11.
m Check the network cables.
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m Turn the printer off and back on. Check the startup page.
m Reset the communication settings to their factory default values by setting
the communication switch to the Reset (out) position. Turn the printer off
and back on again. Set the communication switch to the Normal (in)
position.
m Reinstall the printer software on your computer’s startup disk.
A message on the screen says the printer can’t print.

If you get such a message, try these steps:
m Make sure that the printer is turned on.
m Check the network cables.
m Make sure your startup disk has the LaserWriter 8 driver in the Extensions
folder, which is inside the System Folder.
m Make sure the printer is selected in the Chooser. Be sure to select the
printer’s name as well as the LaserWriter 8 icon and, if your network has
zones, the correct AppleTalk network zone.
m Make sure that the printer has paper correctly installed.
Sometimes printing the first page takes longer than I expect.

The printer automatically goes into an energy-saving mode after it’s been idle
for a while. When you print while it’s in this mode, the printer takes up to
three minutes to warm up before it can print the first page.
A desktop printer icon appears again as soon as you drag it to the Trash.

You must always have at least one desktop printer icon. If you drag your last
desktop printer to the Trash, the computer instantly creates another one just
like it. To remove all desktop printer icons, turn off the Desktop Printing
extension and then restart your computer.
The desktop printer icons appear as folders.

If you restart the computer using a startup disk that doesn’t contain up-to-date
LaserWriter printing software, your desktop printer icons will appear as
folders. Though they won’t work as usual, they will return to normal when
you restart from a disk with the latest printing software.
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The desktop printer icon has an X drawn through it.

The X indicates that the desktop printing software is turned off or the
LaserWriter 8 extension is not in the Extensions folder.
m You may have started the computer using a different startup disk or
temporarily turned off all the software extensions. When you restart the
computer as usual, the icons will return to normal.
m You may have removed the desktop printing software that created the
printer icons. If you meant to do so, you can drag the icons to the Trash or
to any folder outside the Extensions folder. If not, you can reinstall the
software as explained in Chapter 2.
A message says desktop printing software needs more memory.

If the Desktop PrintMonitor needs more memory, try closing open windows
and quitting open programs. Each desktop printer that you use also requires
memory, so try reducing the number of desktop printer icons on your desktop
by dragging desktop printers you no longer need to the Trash. You can also
allocate more memory to the Desktop PrintMonitor. To allocate more
memory, open the Extensions folder in your System Folder and select the
Desktop PrintMonitor icon. Choose Get Info from the File menu and enter
a larger amount of memory in the Preferred Size box. Then close the
Get Info box.
I want to turn the manual feed message on or off.

When you install the printer software, the Desktop PrintMonitor is set up to
notify you about manually feeding paper the same way your PrintMonitor
was set. For example, if you turned off notification for manual feeding in your
PrintMonitor, the Desktop PrintMonitor will also have manual feed
notification turned off.
If you want to change how the Desktop PrintMonitor notifies you about
manual feeding, follow this procedure:
1

Select the desktop printer icon.

2

Choose Show Manual Feed Alert from the Printing menu.

A checkmark by this command means that the manual feed message is on.
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IBM PC or compatible troubleshooting
If you are using the printer from an IBM PC or compatible computer, use this
section for troubleshooting tips.
A message on the screen says the printer can’t print.

If you get such a message, try the following steps.
m Make sure that the printer is turned on.
m Check the network or parallel cables.
m Make sure that the PostScript printer driver has been installed as described
in Chapter 3.
Nothing is printed; no paper comes out of the printer.

If you don’t get any response from the printer when you try to print a
document, try the following steps:
m The printer is a PostScript printer. Make sure you are using a PostScript
printer driver when trying to print a file. To check if you are using a
PostScript printer driver, open the printer Properties dialog box and click
the Paper tab. Click the About box. A message describes what type of
printer driver you are using.
m Check the Installed Printers list to see that your printer is selected. See
Chapter 7 for details about installing and selecting printer driver options.
m Try printing the document again, but choose Download PostScript Error
Handler in the Printer Setup PostScript Options dialog box.
m Check the Paper Out light. If it is on, add paper and replace the paper
cassette. If it is blinking, make sure the paper cassette is securely in place.
m Check for a paper jam as described in Chapter 11.
m Check the printer cables.
m Check the position of the port communication switch as described in
“Adjusting Communication Settings” in Chapter 1. The port may have been
turned off.
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m Reset the communication settings to their factory default values by setting
the communication switch to the Reset (out) position. Turn the printer off
and back on again. Set the communication switch to the Normal (in)
position.
m Turn the printer off and back on. Check the startup page.
m Reinstall the printer driver. See Chapter 3 for details about installing the
printer driver.
For Windows 95 users, also check the following item:
m Open the Printers folder, select the printer, and click Properties. Click the
PostScript tab and click the Advanced button. Make sure that ASCII data
and “Send CTRL+D after job” are selected.
For Windows 3.1 users, also check the following item:
m Open the Printer Control panel, select the printer, and choose Setup. Select
the PostScript tab in the Properties dialog box. Make sure that Protocol
Options is set to Default if you are using the parallel port, or None if
printing via NetWare.
Sometimes printing the first page takes longer than I expect.

The printer automatically goes into an energy-saving mode after it’s been idle
for a while. When you print while it’s in this mode, the printer takes up to
three minutes to warm up before it can print the first page.
The printer is properly connected and configured, but printing is garbled or displays
unwanted characters.

Check the communication switch and make sure that the Interpreter is set to
the correct value. If you are printing a PostScript document, the Interpreter
mode should be PostScript or AutoSelect.
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Novell NetWare troubleshooting
The printer is properly connected, but the printer’s NetWare printer name doesn’t appear
in the Apple LaserWriter Utility’s list of printers to configure.

If you don’t see the printer’s name in the Apple LaserWriter Utility, try the
following steps:
m Make sure you have the right printer model selected.
m Make sure the NetWare file server is running.
m Turn the printer off and then on again. The printer advertises itself to the
NetWare file servers on its network segment for only five minutes after it is
turned on to reduce network traffic.
m Check that the NetWare file server and the printer are on the same
segment of the network. If they are on different segments, you can
configure the printer by specifying the IPX network number and the
Ethernet node address. See “Connecting to a Network Printer Manually” in
Appendix A.
m Check the printer’s frame type, printed on the startup page. Make sure it
matches your computer’s frame type or your NetWare file server’s frame
type. If the frame type is different, you need to connect to the printer
manually to change the frame type to the desired value. See “Connecting to
a Network Printer Manually” in Appendix A for more information.
The printer is properly connected and configured, but printing is garbled or displays
unwanted characters.

If your printer is connected to the server through a parallel port connection,
display the PostScript Options dialog box and make sure that Protocol
Options is set to Default. This dialog box is available through the Setup
command in your application’s File menu. See “Additional Printer Options” in
Chapter 7 for more information on protocol options.
The printer is properly connected and configured, but nothing prints.

The printer is a PostScript-only printer. Make sure you are using only
PostScript banner pages. If you are using PCL banner pages, for example,
nothing will print.
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My text documents print normally, but I have problems with spreadsheets and graphics.

Try removing the banner page, auto-end capping, tabs expansion, and form
feeds. Use the DOS CAPTURE command to set the following printing
options:
/nb /na /nff /nt /ti=30

UNIX troubleshooting
If you are using the printer from a UNIX workstation, use this section for
troubleshooting tips.
The Ready/In Use LED flashes briefly, but nothing prints.

This printer is a PostScript-only printer. Before you can print ASCII text files,
you must filter them into PostScript.
The banner page prints only the system name and the remote printer name.

The lpd printing protocol does not provide the user name or filename in a
way that can be included in the banner page.
The printer administrator forgot the password for the TCP/IP Printer Configuration Utility.

See the service information that came with your printer to learn how to get in
touch with Apple.
Sometimes printing the first page takes longer than I expect.

The printer automatically goes into an energy-saving mode after it’s been idle
for a while. When you print while it’s in this mode, the printer takes about a
minute to warm up before it can print the first page.
The RARP server is not responding.

If you used a RARP server to assign the printer’s IP address while setting up
the printer, but the server is not responding, follow these steps in order:
Note: UNIX systems vary. Consult your system documentation for details on
RARP and BOOTP.

214

Chapter 12

m Verify that the rarpd daemon is running on the server. On many UNIX
systems, you can verify this by typing ps -e or ps -ax at the UNIX
prompt on the server. If the daemon isn’t running, find the rarpd executable
on your system. It’s usually in /usr/etc. To start it, type path/rarpd
-a (for example, /usr/etc/rarpd -a) to start the daemon. If you
cannot locate a rarpd executable on your system, you may not have RARP
available. Use BOOTP or some other IP address-setting method.
m Make sure that the server running RARP is on the same subnet as the
printer.
m Check the /etc/ethers file to verify that it contains the correct
Ethernet address and hostname.
m Check the /etc/hosts file to verify that it contains a valid IP address
and the same hostname as in the /etc/ethers file.
m Turn the printer off and then back on.
The BOOTP server is not responding.

If you chose to use a BOOTP server to assign the printer’s IP address while
setting up the printer, but the server is not responding, follow these steps
in order:
m Make sure that the server running BOOTP is on the same subnet as the
printer or that BOOTP is properly configured to run on multiple subnets.
m Check the /etc/bootptab file to verify that
m the ip entry is a valid IP address and that it matches the address in the
/etc/hosts file
m the ha entry is the correct Ethernet address (found on the printer’s
startup page) with no colons separating the bytes
m the ht entry is either ether or ethernet
m Turn the printer on and off and immediately verify that the bootpd is
running. On many UNIX systems, you can accomplish this by typing
ps -e or ps -ax at the UNIX prompt on the server. If the daemon is
not running, type bootpd -t15 or consult the UNIX man page on
bootpd.
m Turn the printer off and then back on.
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I can’t ping the printer by IP name or IP address.

Follow these steps in order:
m ping your own system or another host. If this ping fails, your IP
software is not running, or your network is down.
m Turn the printer off and then back on. This sometimes fixes the problem
itself, and it also causes the startup page to print. Use the startup page to
verify the printer’s IP address.
m Verify that the IP address on the configuration page is identical to the IP
address in the /etc/hosts file.
m Check the printer’s network cables to make sure that it is connected to the
network.
m Make sure the IP address is not a duplicate of one already in use on the
network.
I can ping the printer, but I can’t telnet to it.

Only one user at a time can telnet to the printer.
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Appendix A
Configuring the Printer With the Printer Utilities

Though the printer itself has no control panel, you can configure it by using
programs on computers connected to the printer:
m On Mac OS–based computers, use the Apple Printer Utility and the
desktop printer’s setup function.
m On Windows-based computers, use the Apple LaserWriter Utility for
Windows.
m On UNIX-based workstations, log in to the TCP/IP Printer Configuration
Utility using the UNIX telnet program. See Chapter 4 for more
information on using the TCP/IP Printer Configuration Utility and the
telnet program.

219

Using the Apple Printer Utility for the Mac OS
The Apple Printer Utility program allows you to set the default settings that
control how various aspects of the printer work. Use it to choose the printer
settings that you want to use for all documents.
You can also change printer settings without changing the printer’s basic
defaults by changing the settings in the Print and Page Setup dialog boxes.
Network users should use the Print and Page Setup dialog boxes to choose the
individual settings for their documents.
IMPORTANT Changes you make with the Apple Printer Utility affect

everybody who uses the printer.
Use the Apple Printer Utility to
m view information about the printer, such as the AppleTalk printer name and
the total number of pages the printer has printed
m name the printer on AppleTalk networks
m download fonts to the printer
m remove fonts
m print font samples
m turn printing of a startup page or demonstration page on or off
m set the print density to lighten or darken printing
m set paper-handling options
m turn the printer’s FinePrint feature on and off
m turn the printer’s PhotoGrade feature on and off
m set when the printer closes print jobs to provide faster throughput
m set the printer’s EtherTalk zone
m view the Ethernet address
m view and specify the IP address
m view and configure the printer’s communication settings
m send PostScript files to the printer
m restart the printer
m print a printer configuration page
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Opening the Apple Printer Utility
The Apple Printer Utility has two windows: the Printer Selector window,
which is similar to the Chooser, and the printer features window, which you
use to view or change the printer’s settings.
1

Double-click the Apple Printer Utility.

The Installer puts the Apple Printer Utility in the Apple LaserWriter Software
folder. You can move it wherever you like.
2

In the Printer Selector window, select and open the printer you want.

If the network has zones, click the
zone where the printer is located.

Printers in that zone
are listed here. Click the name of the
printer you want.
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3

Click Open Printer.

The printer features window appears with the Printer Information category
displayed.
To send your
changes to the
printer, click Send.

To verify that the printer
received the changes you
sent, click this button.
To restore the original
software settings, click
Set Defaults and then Send.

This category tells
you about the printer
you selected.

4

To view or change settings under a category, click the arrow beside the category name
to open the category and display its information and options.

Additional options may appear that you can also open and work with. When
you are finished changing options in a particular category, you can click the
arrow again to collapse the options.
5

After viewing the information and making changes, click the Send button to send your
changes to the printer.

6

Click the Close box to close the window.

The next sections describe configuration procedures that you can perform
with the Apple Printer Utility. First select and open the printer in the Printer
Selector window. The information and procedures described in each section
then present how to work with the printer features window of the utility.

222

Appendix A

Viewing printer information
You can view information about your printer by displaying the printer
information in the printer features window.
m Open the Printer Information category, if necessary.
Note: The Printer Information category is automatically opened whenever
you open a printer in the Apple Printer Utility.
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Naming the printer
To help users easily select the printer from their computers, give the printer a
unique name based, for example, on its location or the group of users that
commonly access it. Use the following procedure to name or rename any
printer on the AppleTalk network.
IMPORTANT Be sure to tell users what the printer name is and which zone it’s

located in.
1

Open the Name category.

The name panel appears with the selected printer’s current name.

Type a new name here.
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2

Type a new name.

3

Click Send to send the new name setting to the printer.

Initializing a hard disk connected to the printer
If you connect an external hard disk to the printer, you may need to initialize
the disk before you can download fonts to it. (See Chapter 5 for information
about connecting hard disks to the printer.)
The printer recognizes disks formatted for use with the Adobe printer file
system (AFS) format. The printer will not recognize disks using other
formats. If you attach such a disk to the printer, you need to reinitialize the
disk before you can use it and then reload any fonts from your computer.
Reinitializing erases everything, including all fonts previously stored on
the disk.
If you are not sure of the disk format, connect the hard disk to the printer as
described in “Connecting a Single External Hard Disk” in Chapter 5. Start the
Apple Printer Utility. If the hard disk is not listed in the Disks panel, then you
must initialize the hard disk.
IMPORTANT Reinitializing erases all fonts previously stored on the disk.
1

Open the Disks category.

2

In the panel that appears, select the disk you want to initialize and click Initialize.

A message warns that initializing erases the entire contents of the disk—
including any fonts.
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3

Click Initialize to proceed.

It takes some time to complete the initialization process. The printer won’t be
available for printing until the hard disk is initialized.

Downloading fonts to the printer or an attached hard disk
You can download additional fonts to the printer’s RAM or attached hard disk
to speed up printing. You do not have to download fonts to use them in
printed documents, but doing so can make printing faster than storing fonts
only on your computer. Fonts downloaded to the printer’s RAM are lost
whenever the printer is turned off or restarted.
1

Open the Fonts category.

The Fonts panel appears.

The list shows fonts
already available to
the printer. If you see
a font here, you don’t
need to add it.

2

The icons in the Location
column show where fonts
are stored—in the printer’s
ROM, RAM, or hard disk.

Click Add.

A file selection dialog box appears.
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3

Select the fonts you want to download.

Double-click the font name in the list or select the name and click Add.
4

Choose a destination for downloading the fonts from the Destination pop-up menu.

5

Click Send.

Removing fonts
You can remove fonts from the printer’s RAM when you no longer need them.
You cannot remove fonts from the printer’s ROM.
1

Open the Fonts category.

The Fonts panel appears.

The icons in the Location
column show where fonts
are stored—in the printer’s
ROM, RAM, or hard disk.
You cannot remove fonts
from the printer’s ROM.

2

Select the fonts you want to remove.

3

Click Remove.

4

Click OK.

Configuring the Printer With the Printer Utilities

227

Printing font samples
You can print a list of the fonts currently stored in the printer’s memory or
attached hard disk.
m Choose Print Font Samples from the Utilities menu.

Turning the startup or demo page on or off
The printer normally prints a sample page when you turn the printer on. This
page shows the printer’s name, the total number of pages printed, the amount
of memory, installed options, and communication settings. You can turn this
feature off if you wish.
The demo page prints a representative page that illustrates the printer’s
printing capabilities.
1

Open the Startup Page / Demo Page category.

The Startup Page/Demo Page panel appears.
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2

Click the checkboxes to turn the startup page or demonstration page on or off.

When an X appears in the checkbox, the printer is set to print the startup page
or the demonstration page.
Note: You must press the Ready/In Use light to print a demonstration page.
3

Click Send to send the startup page setting to the printer.

Setting the print density
If your documents are printing too light or too dark, you can adjust the print
density of the printer (to a limited degree) to print lighter or darker text and
images.
1

Open the Print Density category.

The Print Density panel appears.

2

Drag the slider to increase or decrease the print density.

3

Click Send to send the Print Density setting to the printer.
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Conserving energy
Your printer automatically reduces its power consumption after 60 minutes of
inactivity. You can lengthen or shorten the time that the printer remains idle
before it reduces its power consumption. Once the printer turns down its
power, it will need to warm up again before printing the next document. You
or other network users may experience a small delay (up to three minutes)
in printing.
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1

Open the Energy Saving Delay category.

2

In the panel that appears, choose a time interval from the pop-up menu.

3

To send the energy-saving delay setting to the printer, click Send.

Setting paper-handling options
When the printer runs out of paper in one tray, it can automatically switch to
and use paper in another paper cassette or the multipurpose tray. By using
automatic tray switching between the 500-sheet paper cassette and the 150sheet multipurpose tray, you can print 650 sheets without reloading paper. If
you have the optional 500-sheet feeder and cassette, and it contains the same
size paper, automatic tray switching includes it as a paper source.
Note: The Paper Handling category sets the default paper-handling options
for the printer. You can change printer settings without changing the printer’s
defaults by changing the settings in the Print and Page Setup dialog boxes.
Network users should use the Print and Page Setup dialog boxes to choose the
individual settings for their documents.
1

Open the Paper Handling category.

The Paper Handling panel appears.

Choose the size of paper in
the multipurpose tray. (If you
print jobs that are a different
size paper, the printer won’t
use the multipurpose tray.)

2

Click the checkbox to turn Automatic Tray Switching on or off.

When an X appears in the checkbox, tray switching is turned on.
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3

Choose a default paper size for the multipurpose tray from the pop-up menu.

The Print dialog box provides the Auto Select option, which allows the printer
to draw paper from any paper source that holds the correct size paper.
Similarly, the automatic tray switching feature allows the printer to select
another paper source that holds the correct size paper when a paper source
runs out. However, the printer is not able to detect the size of paper in the
multipurpose tray, so you must tell it. If the paper size for the multipurpose
tray is the same as the paper in the standard paper cassette (and automatic
tray switching is turned on), the printer automatically uses the multipurpose
tray as a paper source.
4

Choose a default envelope size for the envelope tray from the pop-up menu, if the
envelope cassette option is installed.

5

Choose printing on one side or both sides of the paper from the pop-up menu.

If you want the binding orientation along the side of the paper (as in a book
or magazine), choose “two-sided, no tumbling.” If you want the binding
orientation along the bottom of the paper (as in a calendar), choose “twosided, with tumbling.”
Note: You must have the optional duplex printing unit to print on both sides
of the paper.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
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Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter and
A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes

6

Click the checkbox to turn Job Separation on.

Job Separation staggers the placement of the print jobs in the output tray
when printing multiple print jobs.
7

Click Send to send the paper-handling settings to the printer.

Selecting imaging options
FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting to have FinePrint on or off. Users can change
this setting from the Print Options dialog box. To print high-quality images
with PhotoGrade, turn off FinePrint.
PhotoGrade enhances the look of printed images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. You can set the printer’s default to have PhotoGrade turned on or off.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter and
A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes
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You can also change the way images print by increasing or decreasing the
number of gray levels used to reproduce them. More levels of gray produce a
more natural-looking photographic quality. However, increasing the number
of grays also decreases the resolution of the image. For each level of gray, a
unique pattern of laser pulses is required to produce a printed dot. More gray
levels require more variations in such patterns, which in turn require the
printer to use larger, more noticeable dots. You can experiment with various
settings to find the balance that suits your needs.
1

Open the Imaging Options category.

The Imaging Options panel appears.

2

Click the FinePrint On or Off button.

3

Click the PhotoGrade On or Off button.

4

Drag the slider to change the levels of gray.

5

Click Send to send the Imaging Options setting to the printer.
IMPORTANT When you are printing from a Mac OS computer, PhotoGrade

works only when the Color/Grayscale option is selected in the Print dialog box.
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Setting up job handling
You can specify how the printer handles jobs for each type of network. You
can set the printer to maintain contact with the computer until all pages of a
job are finished printing. This allows users to receive printer messages, such
as a message telling them that the printer is out of paper, while their job is
printing. You can also have the printer break contact with the computer once
the print job has been sent to the printer (but is still being processed). This
provides faster handling of print jobs by allowing the printer to begin
processing the next job before all pages of the previous job are printed.
However, users will not receive feedback about paper outages and problems
such as paper jams if these occur after their job has been processed and the
connection has been broken.
You can set job handling for individual network protocols that you use.
1

Set the communication switch on the printer to the Normal (in) position to select the
custom settings.

The communication switch must be in the Normal (in) position, or the printer
will reset the job-handling settings to the factory defaults when it is turned
off or restarted.
Note: Changing the communication switch setting may alter some of your
network settings. For example, when the switch is in the Reset (out) position,
the default mode for the NetWare, TCP/IP, and parallel interfaces is
PostScript; but when the switch is in the Normal (in) position, the mode can
be Off, depending on how you set the communication settings. To change the
settings, see “Viewing and Changing the Communication Settings,” later in
this appendix.
2

Open the Extended Job Status category.
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3

Click the checkboxes next to the network types to specify when the connection with the
computer should be broken.

An X in a checkbox
means the printer
prints all pages in a
job before closing the
connection with the
computer that
requested the
print job.

4

Click Send to send the job-handling configuration settings to the printer.

Setting the printer’s network zones
You can specify the EtherTalk network zone for the printer.
1

Set the communication switch on the printer to the Normal (in) position.

2

Open the Communication Configuration category.

You see a list of communication settings options.
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3

Open the Printer’s Zone category.

A list of the EtherTalk zones appears.

4

Select the zone you want the printer to appear in.

5

Click Send to send the zone setting to the printer.

Changing TCP/IP configurations
You can specify the IP address of the printer. For information about
determining the printer’s IP address and setting up the printer on a TCP/IP
network, see Chapter 4.
Note: Contact your network administrator before changing the printer’s
IP address.
1

Open the Communication Configuration category.

You see a list of communication settings options.
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2

Open the TCP/IP Configuration category.

A panel appears in which you can enter the IP address.

Drag the slider to
change the printer’s
subnet mask.
You can drag the
slider only if the
printer’s IP address
is not 0.0.0.0.

Type the IP address here.

IP address of the default
gateway used for sending
packets off the local network.

3

Enter the IP address.

4

Drag the slider to set the printer’s subnet mask.

5

Enter the Default Gateway Address.

6

Click Send to send the TCP/IP configuration to the printer.

Viewing and changing the communication settings
The standard communication settings of the printer work for most
environments. To make sure the printer is set up to use the standard settings,
check that the communication switch on the left side of the printer is in the
Normal (in) position. The switch is located below the interface connectors.
You can view and change the standard communication settings for the printer
with the Apple Printer Utility. The NetWare, TCP/IP, and Parallel interfaces
are set to PostScript.

238

Appendix A

You make changes to the communication settings with the printer’s
communication switch set in the Normal (in) position. This makes all
communication settings available for changes.
For more information about connecting the printer to LocalTalk, Ethernet,
and parallel ports, see “Connecting the Printer” in Chapter 1. For more
information about setting the communication switch on the printer, see
“Adjusting Communication Settings” in Chapter 1.
1

Set the communication switch on the printer to the Normal (in) position.

2

Open the Communication Configuration category.

You see a list of communication settings options.
3

Open the Port Configuration category.

A list of port connections and protocol choices appears.
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4

Choose the port settings you want.

m You can set LocalTalk interface to PostScript mode or turn it off.
m You can set the EtherTalk interface to PostScript mode or turn it off.
m You can set the NetWare interface to PostScript mode or turn it off.
m You can set the TCP/IP interface to PostScript mode or turn it off.
m You can set the Parallel interface to PostScript mode or turn it off. You can
also set the Parallel protocol to normal or TBCP.
IMPORTANT If you activate or deactivate the EtherTalk, NetWare, or TCP/IP

interface, the change does not take effect until the printer is restarted.
5

Click Send to send the communication configuration settings to the printer.

Resetting the communication settings
To restore the communication settings to the factory defaults:
1

Set the communication switch on the printer to the Reset (out) position.

2

Turn the printer off and back on again.

3

Set the communication switch on the printer to the Normal (in) position.

Sending PostScript files to the printer
You can download PostScript files to the printer to print a PostScript program
or to run a PostScript program to change the internal settings of the printer.
You can create a PostScript file in a variety of text-editing programs or by
printing any document to a file (click the File button in the Print dialog box).
1

Choose Send PostScript File from the Utilities menu.

The Send File dialog box is displayed for the currently selected printer.
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2

Select the PostScript file that you want to send to the printer.

3

Click Add.

4

Click Send.

5

In the Save As dialog box, give the PostScript log file a name and path, then click OK.

The Apple Printer Utility uses the PostScript log file to record error
information if an error occurs during printing.

Restarting the printer
You may need to restart the printer to clear its memory if you experience any
problems printing.
1

Choose Restart from the Utilities menu.

A dialog box appears asking you to confirm that you want to restart the
selected printer.
2

To confirm that you want to restart the printer, click Restart.

When the printer Ready/In Use light stops blinking, the printer is ready to
print.
The same effect can be achieved by turning the printer off and on again.
IMPORTANT If the printer is on a network shared by other users, make sure
that no one is attempting to use the printer when you restart it. If a printing
job is canceled, the user must resubmit it. Manually downloaded fonts are
removed from the printer’s RAM when you restart the printer.

Printing a configuration page
You can print a listing of the current configuration settings and other
information about the printer. This page serves as a reference whenever you
connect a computer to the printer.
m Choose Print Configuration Page from the Utilities menu.

Quitting the Apple Printer Utility
To quit the Apple Printer Utility:
m Choose Quit from the File menu.
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Using the Apple LaserWriter Utility for Windows
The Apple LaserWriter Utility for Windows program lets you change the
default settings that control how various aspects of the printer work. The
utility is placed in the Apple LaserWriter Software program group when the
printer software is installed (use Custom Installation to install the Apple
LaserWriter Utility for Windows). Use it to set optional printer parameters
that you want to use for all documents.
IMPORTANT Be sure the printer you want to configure is selected as the default

printer before you open the Apple LaserWriter Utility for Windows. If the
printer is on a network shared by other users, make sure no one else is
configuring the printer at the same time.
To change printer settings for a specific document (without changing the
printer’s basic default settings), use the Print and Print Setup dialog boxes.
Network users should use the Print and Print Setup dialog boxes to choose
the individual settings for their documents.
Use the Apple LaserWriter Utility for Windows to
m name the printer
m turn printing of a startup page on and off
m enable or disable printing of the demo page
m set paper-handling options
m print a list of printer fonts
m configure the printer’s communication port settings
m configure the printer for NetWare and TCP/IP
m send PostScript files to the printer
m turn the printer’s FinePrint feature on or off
m turn the printer’s PhotoGrade feature on or off
m print a configuration page
m set the print density to lighten or darken printing
m restart the printer
m print page count
m print the printer’s Ethernet address
IMPORTANT When you use the Apple LaserWriter Utility for Windows to set a

parameter, the setting is stored in the printer and will be used by all Mac OS,
Windows, and UNIX computers on the network.
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Opening and quitting the Apple LaserWriter Utility for Windows
1

Start Windows, if it’s not already running.

2

Start the Apple LaserWriter Utility for Windows.

If you’re using Windows 3.1, go to the Program Manager window and open
the Apple LaserWriter Software program group. Double-click the Apple
LaserWriter Utility icon.
If you’re using Windows 95 or Windows NT, click the Start icon on the TaskBar, and select Programs, Apple LaserWriter Software, and Apple LaserWriter
Utility.
3

In the Printer Selector window that appears, select the printer whose setup you want to
change and click OK.

4

When you’re finished using the utility, choose Exit from the File menu.

Naming the printer on AppleTalk networks
Each printer can be given an individual name for AppleTalk networks. Use
the following procedure to rename the printer.
1

Choose Name Printer from the Utilities menu.

The Name Printer dialog box appears.
2

Type the new name.

3

Click OK.

A page prints confirming the printer’s new name.
Be sure to tell users what the printer name is and its location when you install
the printer software on their computers or instruct them to do so.
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Turning the startup page on or off
The printer normally prints a sample page when you turn the printer on. This
page shows the default NetWare printer’s name, the total number of pages
printed, the amount of memory, and communication settings. You can turn
this feature off if you wish.
1

Choose Set Startup Page from the Utilities menu.

A dialog box appears that allows you to turn the startup page on or off.
2

Click On or Off.

3

Click OK.

A page prints confirming the choice.

Setting paper-handling options
When the printer runs out of paper in one tray, it can automatically switch
and use paper in the paper cassette or multipurpose tray. By using automatic
tray switching between the 500-sheet paper cassette and the 150-sheet
multipurpose tray, you can print 650 sheets without reloading paper. If you
have the optional 500-sheet feeder and cassette, and it contains the same size
paper, automatic tray switching includes it as a paper source.
You can also set the printer to use a particular size paper in the multipurpose
tray.
1

Choose Paper Handling from the Utilities menu.

The Paper Handling dialog box appears.
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2

Choose a default paper size for the multipurpose tray.

The Paper Handling dialog box provides the Auto Select option, which allows
the printer to draw paper from any paper source that holds the correct size
paper. Similarly, the automatic tray switching feature allows the printer to
select another paper source that holds the correct size paper when a paper
source runs out. However, the printer is not able to detect the size of paper in
the multipurpose tray, so you must tell it. If the paper size for the
multipurpose tray is the same as the paper in the standard paper cassette (and
automatic tray switching is turned on), the printer automatically uses the
multipurpose tray as a paper source.
3

Choose a default envelope size for the envelope tray from the list box, if the envelope
cassette option is installed.

4

Click On or Off to turn Automatic Tray Switching on or off.

5

Choose “two-sided, no tumbling” or “two-sided, with tumbling” from the duplex print
list box.

If you want the binding orientation along the side of the paper (as in a book
or magazine), choose “two-sided, no tumbling” If you want the binding
orientation along the bottom of the paper (as in a calendar), choose “twosided, with tumbling.”
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter
and A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes
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6

Click OK.

A page prints confirming the choice.

Printing a list or samples of printer fonts
You can print a list or samples of the PostScript fonts currently stored in the
printer’s memory or attached hard disk.
1

Choose Print PostScript Fonts from the File menu.

2

Click Print Font Catalog or Print Font Samples.

PostScript font samples or a list of PostScript fonts are printed.

Viewing or changing communication settings
The standard communication settings of the printer work for most
environments. To make sure the printer is set up to use the standard settings,
check that the communication switch on the left side of the printer is in the
Normal (in) position. The switch is located below the interface connectors.
You can view and change the standard communication settings for the printer
with the Apple LaserWriter Utility.
You make changes to the communication settings with the printer’s
communication switch set in the Normal (in) position. This makes all
communication settings available for changes.
For more information about connecting the printer to LocalTalk, Ethernet,
and parallel ports, see “Connecting the Printer” in Chapter 1. For more
information about setting the communication switch on the printer, see
“Adjusting Communication Settings” in Chapter 1.
1

Choose Configure Port from the Utilities menu.

2

Choose the port settings you want.

m You can set the Parallel interface to PostScript mode, TBCP, or No Change.
m You can set the LocalTalk interface to PostScript mode or turn it off.
m You can set the EtherTalk interface to PostScript mode or turn it off.
m You can set the NetWare interface to PostScript mode or turn it off.
m You can set the TCP/IP interface to PostScript mode or turn it off.
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3

Click Set Port.

Resetting the communication settings
To restore the communication settings to the factory defaults:
1

Set the communication switch on the printer to the Reset (out) position.

2

Turn the printer off and back on again.

3

Set the communication switch on the printer to the Normal (in) position.

Conserving energy
Your printer automatically reduces its power consumption after 60 minutes of
inactivity. You can lengthen or shorten the time that the printer remains idle
before it reduces its power consumption. Once the printer turns down its
power, it will need to warm up again before printing the next document. You
or other network users may experience a small delay (up to three minutes) in
printing.
1

Choose Energy Saving Delay from the Utilities menu.

2

Select a delay from the Delay pop-up menu.

3

Click OK.

Printing demo pages
You can enable or disable the demo page feature.
1

Choose “Point of Sale” from the Utilities menu.

2

Click On or Off.

3

Click OK.
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Configuring TCP/IP
You can specify the IP address of the printer. For information about
determining the printer’s IP address and setting up the printer on a TCP/IP
network, see Chapter 4.
1

Choose Configure TCP/IP from the Utilities menu.

2

Enter the IP address.

3

Enter the subnet mask.

You can specify a subnet mask only if the printer’s IP address is not 0.0.0.0.
4

Enter the default gateway address.

The IP address of the default gateway is used for sending packets from the
local network.
5

Click OK.

Printing the Ethernet address
To print the printer’s Ethernet address:
m Choose Print Ethernet Address from the Utilities menu.

Sending PostScript files to the printer
You can download PostScript files to the printer to print a PostScript program
or to run a PostScript program to change the internal settings of the printer. A
PostScript file can be created in a variety of text-editing programs.
For more information on setting up the printer for use with Windows and
DOS applications, see Chapter 7 and Chapter 8.
1

Choose Download PostScript File from the Utilities menu.

A dialog box appears.
2

Select the file you want to download.

3

Click OK.

The file is downloaded to the printer.
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Setting imaging options
The LaserWriter Utility allows you to specify some printer imaging options,
including the control of FinePrint and PhotoGrade options and the setting of
screen frequency and angle.
FinePrint provides smoother, less jagged printing of text characters. You can
set the printer’s default setting to have FinePrint on or off. Users can change
this setting from the print Properties dialog box. To print high-quality images,
turn off FinePrint.
PhotoGrade enhances the printed look of images, such as scanned
photographs, by providing more shades of gray and better printed clarity and
contrast. You can set the printer’s default to have PhotoGrade turned on or off.
The following table lists the memory requirements and supported paper sizes
for duplex printing and PhotoGrade:
Memory

Duplex Printing

PhotoGrade

Use both features
at once?

16 MB

Letter, A4, B4, legal

Letter, A4, B5

No

20 MB

Letter, A3, A4, B4,
legal, ledger

Up to ledger and A3

Yes; up to letter
and A4

24 MB

Letter, A3, A4, B4,
legal, ledger

Up to Japan Standard
and Japan Larger

Yes; up to legal

32 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; up to B4

48 MB

Letter, A3, A4, B4,
legal, ledger

All supported paper
sizes

Yes; all supported
paper sizes

You can also change the way the images print by increasing or decreasing the
number of gray levels used to reproduce them. More levels of gray produce a
more natural-looking photographic quality. However, increasing the number
of grays also decreases the resolution of the image. For each level of gray, a
unique pattern of laser pulses is required to produce a printed dot. More gray
levels require more variations in such patterns, which in turn require the
printer to use larger, more noticeable dots. You can experiment with various
settings to find the balance that suits your needs.
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1

Choose Imaging Options from the Utilities menu.

The Imaging Options dialog box appears.
2

Choose the printer resolution.

3

Click the FinePrint on or off button.

4

Click the PhotoGrade on or off button.

5

Drag the Frequency/Angle slider to set the levels of gray.

6

Click OK.

A page prints confirming the choice.

Printing the configuration page
You can print a listing of the current configuration settings and other
information about the printer. This page serves as a reference whenever you
connect a computer to the printer.
m Choose Print Configuration Page from the Utilities menu.

Setting the print density
If your documents are printing too light or too dark, you can adjust the print
density (to a limited degree) of the printer to print lighter or darker text and
images.
1

Choose Print Density from the Utilities menu.

The Print Density dialog box appears.
2

Drag the slider to increase or decrease the print density.

3

Click Set.

A page prints confirming the choice.
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Printing the page count
The printer stores a running total of the number of pages it has printed. This
total is printed on the startup page when you start the printer (if the startup
page option is turned on). You can also print it using the Apple LaserWriter
Utility for Windows.
m Choose Print Page Count from the Utilities menu.
A page prints listing the number of pages printed to date.

Restarting the printer
You may need to restart the printer to clear its memory if you have any
problems printing. For information on troubleshooting printing problems, see
Chapters 11 and 12.
1

Choose Restart Printer from the Utilities menu.

A dialog box appears, asking you to confirm that you want to restart the
selected printer.
2

Click Restart.

It takes a few minutes for the printer to restart and be ready to print.
The same effect can be achieved by turning the printer off and then on again.
IMPORTANT If the printer is on a network shared by other users, make sure
that no one is attempting to use the printer before you restart it.

Connecting to a network printer manually
In certain situations you may need to connect to your printer manually before
you can configure it. For example,
m the printer is on a different network segment from the file server
m the printer’s Ethernet frame type is not the frame type that you want to use
(See the “Novell NetWare Troubleshooting” section in Chapter 12 for more
information.)
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To connect to a network printer manually, follow these steps:
1

Start Windows.

2

Start the Apple LaserWriter Utility for Windows.

3

In the Printer Selection window that appears, select the printer.

4

Choose “Connect to Network Printer” from the Network menu.

5

Enter the eight-digit IPX Network Number and the Node Address.

The Node Address is the same address as the printer’s 12-digit Ethernet
address. The printer’s Ethernet address is printed on the startup page.
Contact your network administrator if you don’t know the IPX network
number.
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6

Once connected, change the printer’s Ethernet frame type to the frame type that you
want.

7

Click Send to send the changes to the printer.

Appendix B Setting Up the Printer
as an ATPS Remote Printer

Setting up your printer as a remote ATPS (AppleTalk Print Spooler) printer
on a NetWare network requires minimal configuration; most of the network
printing capability is built into every Mac OS–based computer. With the
proper software and physical connections, a Mac OS–based computer on a
NetWare network can print on a NetWare-managed printing queue that can
be selected from the Mac OS Chooser.
IMPORTANT ATPS is a part of Novell’s NetWare for Macintosh NetWare
Loadable Module (NLM), which must be loaded and configured on your
NetWare server. The configurations described in this appendix can be
performed only after the Mac OS NLM has been installed.
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Configuring ATPS for the first time on a NetWare 4 server
If you are setting up the printer for access by Mac OS–based computers on a
NetWare 4 network and this is the first time you are configuring ATPS, follow
these instructions.
You can configure ATPS from the server console, or by running RCONSOLE
(remote console) from a client computer.
1

At the console prompt, type
load install

The Install utility starts and a list of installation options appears.
2

Choose the Maintenance/Selective Install option and press Enter.

An additional list of options appears.
3

Select Product Options from the list and press Enter.

A list of product options appears. If the NLM is installed and operating, a
NW-MAC option is available.
4

Select the NW-MAC option and press Enter.

A list of configuration files appears.
5

Select Configure Printer Services and press Enter.

A list of print service configuration options appears.
6

Select Quick Configuration and press Enter.

A list of lookup parameter options appears.
7

Select the Printer Model entry and press Enter.

A list of printer types appears.
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8

Select the LaserWriter Pro 630 option and press Enter.

9

In the lookup parameter list, change the zone name to the zone in which the printer is
currently located.

10

Select the Perform Lookup option and press Enter.

11

In the list of installed printers, locate and select the newly installed printer from the list.
(It should be identified as “LaserWriter Pro 630.”)

12

If necessary, edit the Spooler’s AppleTalk Name field and press Esc to complete
the setup.

Note: You can also edit information about the print server or spooler. See the
documentation provided with NetWare for more information.
13

Press Esc to exit the utility.

A prompt appears, asking if you want to create a new file.
14

Select Edit SYS:\SYSTEM\AUTOEXEC.BAT from the list of options and press Enter.

A window appears, displaying the field’s contents.
15

Insert the following line after the load afp statement.
load atps

This command instructs the NetWare server to load the ATPS service
automatically at startup time.
16

Press Esc until the Install utility quits.

17

At the service console prompt, type load atps and press Enter.

The service is loaded and immediately becomes available to network users. A
message appears confirming the load, and the console returns to the
command-line prompt.

Configuring ATPS for the first time on a NetWare 3.x server
If you are setting up the printer for access by Mac OS–based computers on a
NetWare 3.x network and this is the first time you are configuring ATPS,
follow these instructions.
You can configure ATPS from the server console, or by running RCONSOLE
(remote console) from a client computer.
1

At the console prompt, type
load install

The Install utility starts and a list of installation options appears.
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2

Select Product Options from the list and press Enter.

A list of product options appears. If the Mac OS NLM is installed and
operating properly, a NW-MAC option will be available.
3

Select the NW-MAC option and press Enter.

A list of configuration files appears.
4

From the list, select the file SYS:\SYSTEM\ATPS.CFG and press Enter.

A prompt appears, asking if you want to create a new file.
5

Type y and press Enter.

An empty window appears, providing an area in which to enter configuration
information.
6

Enter a line of configuration information for each printer. (Enclose the printer name and
zone in quotation marks.)
Example
"Sales Printer:Ethernet Zone"

This example identifies the printer “Sales Printer” located in the zone
“Ethernet Zone.”
You can include a -h option at the end of the line to instruct ATPS to make
the printer unavailable for direct Mac OS printing; that is, the printer will be
accessible only through ATPS queues.
Example
"Sales Printer:Ethernet Zone" -h

Note: Other ATPS options are available for configuring the printer. See
Novell’s NetWare for Macintosh documentation for more information on these
options.
7

Press Esc to quit editing.

A prompt appears, asking if you want to save your changes.
8

Type y and press Enter.

The list of configuration files reappears.

256

Appendix B

9

Select the SYS:\SYSTEM\AUTOEXEC.NCF file and press Enter.

A window appears, displaying the file’s contents.
10

Insert the following line after the load afp statement:
load atps

This command instructs the NetWare server to automatically load the ATPS
service at startup time.
11

Press Esc to exit the editor. Then type y and press Enter to confirm the changes.

12

Press Esc three times to exit the Install utility.

13

At the system console prompt, type load atps and press Enter.

The service is loaded and immediately becomes available to network users. A
message appears confirming the load, and the console displays its prompt.

Modifying an existing ATPS configuration on a NetWare 3.x server
The procedure for modifying an existing ATPS configuration is similar to the
procedure for creating a new configuration. The primary difference is that
you are modifying an existing AUTOEXEC.NCF file instead of creating a
new one.
1

At the console prompt, type
load install

The Install utility starts and a list of installation options appears.
2

Select Product Options from the list and press Enter.

A list of product options appears. If the NLM is installed and operating
properly, a NW-MAC option will be available.
3

Select the NW-MAC option and press Enter.

A list of configuration files appears.
4

From the list, select the file SYS:\SYSTEM\ATPS.CFG and press Enter.

A prompt appears, asking if you want to create a new file.
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5

Type y and press Enter.

An empty window appears, providing an area for entering configuration
information.
6

Enter a line of configuration information for each printer. (Enclose the printer name and
zone name in quotation marks.)
Example
"Sales Printer:Ethernet Zone"

This example identifies the printer “Sales Printer” located in the zone
“Ethernet Zone.”
You can include a -h option at the end of the line to instruct ATPS to make
the printer unavailable for direct Mac OS printing; this makes the printer
accessible only through ATPS queues.
Example
"Sales Printer:Ethernet Zone" -h

Note: Other ATPS options are available for configuring the printer. See the
NetWare for Macintosh documentation for more information on these options.
7

Press Esc to quit the editor.

A prompt appears, asking if you want to save your changes.
8

Type y and press Enter.

The list of configuration files reappears.
9

Press Esc until the Install utility exits.

10

At the system console prompt, type unload atps and press Enter.

This command unloads the previous version of ATPS configuration. Now you
can reload ATPS using the modified configuration.
11

At the system console prompt, type load atps and press Enter.

The new configuration is immediately available.
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Appendix C
Printing Demonstration Pages

Demonstration pages show representative text and graphic samples of the
printer’s output capabilities.
To enable the printing of demo pages:
1

Turn off the printer.

2

Press the Ready/In Use LED while turning the printer on.

The Ready/In Use LED flashes amber and green to indicate that the
demonstration page feature is turned on.
3

Press the Ready/In Use LED to print the demonstration pages.

Note: Energy saving is turned off when the demonstration feature is
turned on.
Your printer can be connected to a network with the demonstration feature
on, and can accept print jobs.
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To disable the printing of demo pages:
1

Turn off the printer.

2

Press the Ready/In Use LED while turning the printer on.

The Ready/In Use LED stays green to indicate that the demonstration page
feature is turned off.
You can also turn the demonstration page feature on and off with the Apple
Printer Utility for Mac OS–based computers. For more information, see
Appendix A.
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Appendix D
Technical Information

Specifications
Marking engine

m Fuji Xerox P880 laser-xerographic
Laser

m Type: Semiconductor laser diode
m Wavelength: 780 nanometers (nm)
m Output power: 5 milliwatts (mW) maximum
Controller

m AMD Am29040 30/60-MHz RISC microprocessor
m 8 megabytes (MB) of ROM (including 136 fonts)
m 16 MB of RAM (expandable to 48 MB)
m 80C186 I/O processor
m 8 kilobytes (KB) parameter EEPROM
m LocalTalk port
m Parallel port
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m AAUI Ethernet port with three protocols:
EtherTalk
Novell NetWare IPX (PSERVER or RPRINTER)
TCP/IP (lpd)
m External Ethernet transceivers available for
thin coaxial (10BASE-2)
thick coaxial (10BASE-5)
m Ethernet twisted-pair cable (10BASE-T) can connect directly to a hub
m Two-position communication switch
m All ports and protocols simultaneously active (but only one Ethernet
connector)
m 600 dots per inch (dpi) resolution
m 600 dpi FinePrint (edge enhancement for text and line art)
m Enhanced 600 dpi grayscale imaging:
Standard
m 85 lines/inch dithered halftone, 101 gray levels
m 106 lines/inch dithered halftone, 129 gray levels
m 141 lines/inch dithered halftone, 73 gray levels
PhotoGrade (with 12 MB of RAM)
m 106 lines/inch halftone, 201 gray levels
m 141 lines/inch halftone, 257 gray levels
m 150 lines/inch halftone, 145 gray levels
m PostScript 3
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Printer fonts

One hundred thirty-six PostScript fonts are provided with the printer,
including such fonts as Albertus, Antique Olive, Apple Chancery, Arial, ITC
Avant Garde®, Bondoni, ITC Bookman®, Carta, Chicago, Clarendon,
CooperBlack, Copperplate, Coronet, Courier, Eurostile, Geneva, GillSans,
Goudy, Helvetica, Helvetica Black, Helvetica Compressed, Helvetica Narrow,
Hoefler Text, Joanna, LetterGothic, Lubalin Graph, Marigold, Monaco,
MonaLisa, New Century Schoolbook, New York, Optima, Oxford, Palatino®,
StempelGaramond, Symbol, Tekton, Times, Univers, Univers Condensed,
WingDings, ITC Zapf Chancery®, and ITC Zapf Dingbats®.
Speed

m one-sided—20 pages per minute maximum using long-edge feed U.S. letter
or A4-size paper. Actual speed depends on the images printed.
m two-sided—13 pages per minute maximum using long-edge feed U.S. letter
or A4-size paper. Actual speed depends on the images printed.
m envelopes—9.7 envelopes per minute maximum.
Printer reliability (MTBF)

m Average number of impressions between failure is 180,000 pages.
Note: A single sheet is defined as two impressions in the duplex mode.
Toner cartridge life expectancy

m Life expectancy is 14,000 pages when printing text documents with average
page coverage (5% black). An example of a 5% black page coverage is a
page consisting of double-spaced 14-point Courier type. Printing images
and other graphics may shorten toner cartridge life expectancy.
Printing materials

16- to 28-pound laser-quality bond (60 to 105 g/m2); up to 36-pound
(135 g/m2) stock when fed manually through the multipurpose tray. Accepts
most textured and colored stock. Accepts medium-weight photocopier
transparencies and labels. Envelopes can be printed from the multipurpose
tray or from the optional envelope feeder.
The paper used should not scorch, melt, transfer material, or release
hazardous emissions when heated to 200° C (400° F) for 0.1 seconds.
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Paper sizes and capacity

The paper cassette holds 500 sheets of 20-pound (75 g/m2) paper. The
multipurpose tray can hold up to 150 sheets of standard U.S. letter paper, and
other paper sizes from postcard up to U.S. legal. An optional 500-sheet feeder
and cassette is available. An envelope feeder that can automatically feed up to
50 envelopes is also available.
Standard 500-sheet cassette
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Paper Type

Size

U.S. Letter (Long Edge Feed)

8-1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Letter Small (LEF)

8-1/2" x 11" (215.9 mm x 279.4 mm)

Statement (LEF)

8.48" x 5.48" (215.9 mm x 139.7 mm)

Executive (LEF)

10.5" x 7.25" (266.7 mm x 184.2 mm)

A4 (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A4 Small (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A5 (LEF)

5.84" x 8.26" (148 mm x 210 mm)

B5 (LEF)

7.17" x 10.12" (182 mm x 257 mm)

Multipurpose tray
Paper Type

Size

U.S. Letter (LEF)

8 1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Letter Small (LEF)

8 1/2" x 11" (215.9 mm x 279.4 mm)

A4 (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A4 Small (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A5 (LEF)

5.84" x 8.26" (148 mm x 210 mm)

Executive (LEF)

10.5" x 7.25" (266.7 mm x 184.2 mm)

B5 (LEF)

7.17" x 10.12" (182 mm x 257 mm)

Statement (LEF)

8.48" x 5.48" (215.9 mm x 139.7 mm)

U.S. Legal (SEF)

8.5" x 14" (215.9 mm x 355.6 mm)

U.S. Legal Small (SEF)

8.5" x 14" (215.9 mm x 355.6 mm)

Tabloid (SEF)

11" x 17" (279.4 mm x 431.8 mm)

A3 (SEF)

11.69" x 16.54" (297 mm x 420.2 mm)

Large (SEF)

13" x 18" (330 mm x 457.2 mm)

Large (SEF)

13" x 18.5" (330 mm x 470 mm)

Large (SEF)

13" x 20" (330 mm x 508 mm)

COM10 (SEF)

4.125" x 9.5" (104.8 mm x 241.3 mm)

Monarch (SEF)

3.875" x 7.5" (98.4 mm x 190.5 mm)

DL (SEF)

4.33" x 8.66" (110 mm x 220 mm)

C5 (SEF)

6.38" x 9.02" (162 mm x 229 mm)

Hagaki Postcard (SEF)

3.94" x 5.83" (100 mm x 148 mm)

Technical Information

265

Optional 500-sheet A3 cassette
Paper Type

Size

U.S. Letter (LEF)

8-1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Letter Small (LEF)

8-1/2" x 11" (215.9 mm x 279.4 mm)

Statement (LEF)

8.48" x 5.48" (215.9 mm x 139.7 mm)

Executive (LEF)

10.5" x 7.25" (266.7 mm x 184.2 mm)

A4 (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A4 Small (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A5 (LEF)

5.84" x 8.26" (148 mm x 210 mm)

B5 (LEF)

7.17" x 10.12" (182 mm x 257 mm)

U.S. Legal (SEF)

8.5" x 14" (215.9 mm x 355.6 mm)

Tabloid (SEF)

11" x 17" (279.4 mm x 431.8 mm)

A3 (SEF)

11.69" x 16.54" (297 mm x 420.2 mm)

Large (SEF)

13" x 18" (330 mm x 457.2 mm)

Large (SEF)

13" x 18.5" (330 mm x 470 mm)

Optional envelope sizes and weights
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Envelope

Weight

Size

COM10 (SEF)

24 lb

4 1/8" x 9 1/2" (104.8 mm x 241.3 mm)

Monarch (SEF)

24 lb

3 7/8" x 7 1/2" (98.4 mm x 190.5 mm)

DL (SEF)

80 g/m2

110 mm x 220 mm

C5 (SEF)

90 g/m2

162 mm x 229 mm

Optional duplex printing unit
Paper Type

Size

U.S. Letter (LEF)

8 1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Letter Small (LEF)

8 1/2" x 11" (215.9 mm x 279.4 mm)

U.S. Legal (SEF)

8.5" x 14" (215.9 mm x 355.6 mm)

U.S. Legal Small (SEF)

8.5" x 14" (215.9 mm x 355.6 mm)

A4 (LEF)

8.27" x 11.69" (210 mm x 297 mm)

A4 Small (LEF)

8.27" x 11.69" (210 mm x 297 mm)

B5 (LEF)

7.17" x 10.12" (182 mm x 257 mm)

Ledger (SEF)

11" x 17" (279.4 mm x 431.8 mm)

A3 (SEF)

11.69" x 16.54" (297 mm x 420.2 mm)

Dimensions
Printer with A4 cassette

m Height: 16.2 in. (41.1 cm)
m Width: 23.2 in. (58.9 cm)
m Depth: 17.9 in. (45.5 cm)
Additional dimension when adding the duplex printing unit

m Height: 2.9 in. (7.4 cm)
m Depth: 3.0 in. (7.6 cm)
Additional dimension when adding the 500-sheet feeder with the A3 universal cassette

m Height: 5.2 in. (13.2 cm)
m Depth: 5.9 in. (15.0 cm)
Additional dimension when adding the 500-sheet feeder with the
letter/A4 universal cassette

m Height: 5.2 in. (13.2 cm)
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Space requirements
About 4 in.
or 10 cm

Note: Vertical clearance
is about 16 in. or 40 cm

About 13 in.
or 32 cm

Exhaust vent

About 8 in.
or 20 cm

About 30 in.
or 76 cm

Weight

m Approximately 30 lb. (14 kg)

Environmental information
Operating

m Temperature: 41° to 95° F (5° to 35° C)
m Humidity: 15 to 85 percent relative humidity noncondensing
m Altitude: 0 to 8200 feet (0 to 2500 meters)
Storage (toner cartridge)

m Temperature: 32° to 95° F (0° to 35° C)
m Humidity: 15 to 80 percent relative humidity noncondensing
Storage (printer)

m Temperature: 32° to 95° F (0° to 35° C)
m Humidity: 15 to 80 percent relative humidity noncondensing
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Voltage requirements
U.S.

m 90 to 132 VAC, 47 to 63 Hz
m 100 to 120 nominal voltage, 50 to 60 nominal Hz
Europe and Australia

m 198 to 264 VAC, 47 to 63 Hz
m 220 to 240 nominal voltage, 50 to 60 nominal Hz
IMPORTANT The printer does not contain a universal power supply.

Power consumption
Energy-saving mode

m 26 watts (W)
Standby average

m 100/120 volts (V), approximately 125 W
m 220/240 V, approximately 120 W
Operating average

m 110/120 V, approximately 390 W
m 220/240 V, approximately 370 W
Maximum power consumption

m 120 V, approximately 840 W, 6.3 amperes (A)
m 240 V, approximately 860 W, 3.2 A
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About PostScript Printer Description (PPD) files
Installing the Mac OS printer software also installs PPD files to support the
following Apple LaserWriter printers:
m LaserWriter 8500
m LaserWriter
m LaserWriter Plus
m Personal LaserWriter NT
m Personal LaserWriter NTR
m Personal LaserWriter 320
m LaserWriter II NT
m LaserWriter II NTX
m LaserWriter II NTXJ
m LaserWriter IIf
m LaserWriter IIg
m LaserWriter Select 360
m LaserWriter Select 360f
m LaserWriter Select 610
m LaserWriter Pro 400
m LaserWriter Pro 405
m LaserWriter Pro 600
m LaserWriter Pro 630
m LaserWriter Pro 810
m LaserWriter Pro 810f
m LaserWriter 4/600 PS
m LaserWriter 16/600 PS
m LaserWriter 16/600 PSf
m LaserWriter Color 12/600 PS
m LaserWriter Color 12/660 PS
m LaserWriter 12/640 PS
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You can install the Windows PPD files for these Apple LaserWriter printers:
m LaserWriter 8500
m LaserWriter Select 360
m LaserWriter Pro 600
m LaserWriter Pro 630
m LaserWriter Color 12/600 PS
m LaserWriter Color 12/660 PS
m LaserWriter 16/600 PS
m LaserWriter 12/640 PS

RAM upgrade specifications
To increase the printer’s RAM, purchase Single Inline Memory Modules
(SIMMs) with the following specifications:
SIMM dimensions

m Length: 107.95 mm +/– 0.20 mm (4.25 in. +/– .008 in.)
m Height: 25.53 mm (1.005 in.) maximum
SIMM sizes and speeds
Size

Configuration

Speed

Connector type

4 MB SIMM

1 M X 32 bit (one 4 MB bank)

70 ns or less

72-pin

8 MB SIMM

2 M X 32 bit (two 4 MB banks)

70 ns or less

72-pin

16 MB SIMM*

4 M X 32 bit (one 16 MB bank)

70 ns or less

72-pin

32 MB SIMM*

8 M X 32 bit (two 16 MB banks)

70 ns or less

72-pin

* Must have a 2 KB row (11 bit x 11 bit) refresh rate. 16 MB SIMMs with a 4 KB row (12 bit x 10 bit) refresh rate are not
compatible with the printer.
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Ozone emission
Ozone gas is emitted by almost all laser printers and photocopiers. The
printer technology allows it to emit practically no ozone gas (less than .002
parts of ozone per million parts of air). The current OSHA permissible
exposure limit for ozone is 0.1 parts of ozone per million parts of air (ppm).
The ozone emissions from the printer comply with Underwriters Laboratory
(UL) safety limits.
Depending on the levels of concentration, ozone can be a mild to severe
irritant with known effects ranging from dry throat and nose, headache, and
sore eyes to nausea, vomiting, and pulmonary congestion. For this reason
various regulatory agencies have established limits regarding the amount of
ozone to which employees may be exposed. The employer is responsible for
providing a work environment that meets these standards.
You can usually identify ozone by its characteristic odor, even in
concentrations well below the permissible exposure limit. However, as the
concentration of ozone or the duration of exposure increases, your ability to
smell it may decrease.
To minimize ozone exposure, install the printer in a well-ventilated area and
keep the equipment properly maintained. If there are other laser printers or
photocopying machines in the same area, additional air circulation may be
required. Do not place the printer in a small, enclosed space that lacks
adequate ventilation. Position the printer so that the fan exhaust does not
blow directly into a person’s face. Finally, maintain the relative humidity
between 30 and 70 percent. Extremely low humidity can slow the natural
breakdown of ozone in the air.
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Communication settings
The following table shows the default communication settings. For
information about using the communication switch to adjust communication
settings, see “Adjusting Communication Settings” in Chapter 1. To change or
view the current communication settings, use the Apple Printer Utility for
Mac OS computers (see Appendix A) or the Apple LaserWriter Utility for
Windows on IBM PC or compatible computers (see Appendix A).
Normal (in) switch position

These settings can be changed to the following modes:
Port

Protocol

Mode

LocalTalk

LocalTalk

PostScript, Off

Ethernet

EtherTalk

PostScript, Off

NetWare

PostScript, Off

TCP/IP

PostScript, Off

TBCP

PostScript, Off

Parallel

Reset (out) switch position

When the communication switch is in the Reset (out) position, the following
values are used:
Port

Protocol

Mode

LocalTalk

LocalTalk

PostScript

Ethernet

EtherTalk

PostScript

NetWare

PostScript

TCP/IP

PostScript

TBCP

PostScript

Parallel

Note: When the communication switch is in the Reset (out) position, a
startup page is printed each time the printer is turned on and the Extended
Job Status settings are removed.
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Options and accessories
In the U.S.A., to locate your local Apple-authorized reseller, call
1-800-538-9696.
In the U.S.A., you can order toner cartridges directly from Apple by calling
1-800-600-7805.
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Item

Part Number

Apple Ethernet Thin Coax Transceiver

M0329Z/B

Apple Ethernet Twisted-Pair Transceiver

M0437Z/B

Apple Ethernet AUI Adapter

M0432LL/A

LaserWriter 8500 High Capacity Toner Cartridge

M5893G/A

LaserWriter 8500 500-Sheet Feeder and Cassette

M5895G/A

LaserWriter 8500 500-Sheet A3 Feeder and Cassette

M5894G/A

LaserWriter 8500 Envelope Cassette

M5897G/A

LaserWriter 8500 Duplex Printing Unit

M5896G/A

Index

A
AAUI Ethernet port 18
accessories, part numbers for 274
address, Ethernet (Windows) 248
addressing envelopes 184
Adobe Acrobat PDF files, saving
documents as (Mac OS) 135
Adobe PostScript. See PostScript
Adobe Type Manager, installing
(Windows, DOS, NetWare) 85
Advanced PostScript Options dialog box
(Windows 95) 176
alias for desktop printer icon
(Mac OS) 141
Apple LaserWriter Software folder
(Mac OS) 31
Apple LaserWriter Utility for Windows
242–252
configuring TCP/IP with 248
connecting to network printer
manually with 251–252
conserving energy with 247
naming printer on AppleTalk
networks with 243
opening 243
printing demo pages with 247
printing Ethernet address with 248

printing list or samples of printer fonts
with 246
purpose of 242
quitting 243
restarting printer with 251
sending PostScript files to the printer
with 248
setting paper-handling options with
244–246
setting print density with 250
turning startup page on and off
with 244
viewing or changing communication
settings with 246–247
Apple Printer Utility for the Mac OS
220–241
communications settings, viewing and
changing with 238–240
configuration page, printing with 241
demo page, turning on or off with
228–229
energy, conserving with 230
fonts, downloading and removing with
226–227
font samples, printing with 228
hard disk, initializing with 225–226
imaging options, selecting with
233–234
IP address, setting with 39, 88, 91
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job handling, setting with 235–236
naming the printer with 224
network zones, setting with 236–237
opening 221
paper-handling options, setting with
231–233
PostScript files, sending to the printer
with 240–241
print density, setting with 229
printer features window in 222
printer information, viewing with 223
purpose of 220
quitting 241
startup page, turning on or off with
228–229
TCP/IP configurations, changing with
237–238
AppleTalk
choosing new printer on 40
initial setup for 29
naming printer on (Windows) 243
renaming printer on 38
AppleTalk Print Spooler mode
(NetWare) 72–73
applications, printing from
DOS 165
Windows 147–156
Archive format option
(Windows 95) 175
art. See graphics
ASCII files, saving documents as
(Mac OS) 135
ATPS configuration, modifying on a
NetWare 3.x server 257–258
ATPS mode (NetWare) 72–73
ATPS remote printer, setting up the
printer as 253–258
configuring ATPS for the first time on
a NetWare 3.x server 255–257
configuring ATPS for the first time on
a NetWare 4 server 254–255
modifying an existing ATPS
configuration on a NetWare 2.x
server 257–258
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Index

Auto Select option (Mac OS) 129, 206
A/UX-based workstations, configuring
95–97

B
background printing (Mac OS) 130,
135–136
banner page 105, 214
binary files, saving documents as
(Mac OS) 135
binding orientation (Mac OS) 134–135
bitmapped graphics, aligning
(Mac OS) 127
black-and-white reversed image
(Mac OS) 127
BOOTP server
fails to respond 215
IP address for 88, 92
BSD systems, configuring 95–97

C
cables
Ethernet 6, 22, 23
LocalTalk 6, 19, 20
parallel interface 6, 25
SCSI peripheral 111
SCSI system 111
twisted-pair 23
canceling print request (Mac OS) 142
case, cleaning 190
cassette. See envelope cassette; 500sheet cassette; paper cassette
Change Setup command (Mac OS) 143
Chooser (Mac OS) 35–37
changing printer setup with 145–146
choosing printer on AppleTalk
network 40
choosing printer on non-AppleTalk
network 41
choosing printer with 35–37

LaserWriter 8 icon fails to appear
in 206
printer appears more than once in 207
printer is not listed in 206
cleaning the printer’s exterior 190
Collate option (Mac OS) 129
Color Matching option (Mac OS) 130
color printing, controlling
(Windows) 151
communication protocol, setting
(Windows) 151
communication settings
customizing 28
default, table of 273
resetting to default values (IBM PC or
compatible) 212
viewing and changing (Mac OS)
238–240
viewing and changing (Windows)
246–247
communications regulation
information vii
communication switch 18, 26
computers. See specific system
configuration page, printing
Mac OS 241
TCP/IP 194
UNIX 104
Windows 250
configuring ATPS for the first time
on a NetWare 3.x server 255–257
on a NetWare 4 server 254–255
configuring the printer
for a Mac OS–based computer 44,
119–120, 220–241
for a Windows 95–based or
Windows NT computer 121
for a Windows 3.1-based
computer 121
using Apple LaserWriter Utility for
Windows 242–252
using Apple Printer Utility for Mac
OS 220–241
using TCP/IP (Windows) 248

configuring users’ workstations 92–102.
See also specific type
of workstation
connecting
hard disks to the printer 111–113
power 26
printer 18–27
printer to Ethernet network 22–24
printer to LocalTalk network 19–20
printer to Mac OS–based computer
21–22
printer to Windows or DOS computer
with parallel cable 25–26
to a network printer manually
(Windows) 251–252
connectivity options 1
connector box 19–21
controller specifications 261–263
Control Panel (Windows), opening 149
Control Strip (Mac OS), selecting new
printer from 140
cover. See side cover; top cover
cover page, printing (Mac OS) 130–131

D
default printer, changing (Mac OS)
138–140
demonstration page
disabling 205
printing, general information about
259–260
printing with Windows 247
turning on or off (Mac OS) 228–229
desktop printer icon (Mac OS) 37
appears as folder 209–210
creating 42–43, 140
creating an alias for 141
dragging documents to 139
monitoring printing with 141
moving 141
printer status indicated by 141
printing with 137–138
reappears after dragging to Trash 209

Index
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renaming 140
selecting printer using 139
throwing away 140
with X drawn through it 210
working with 140–143
Desktop Printer Utility (Mac OS) 40–43
cannot be found 207
changing printer setup with 43
choosing printer on AppleTalk
with 40
choosing printer on non-AppleTalk
network with 41
configuring printer with 44
creating special desktop printers with
42–43
installing software from a server with
44–46
location of 40–43
printer is not listed in 206–207
selecting new printer with 140
desktop printing software, memory
requirements of (Mac OS) 210
Desktop PrintMonitor (Mac OS)
removing 144–146
turning off 144
Details tab dialog box
(Windows 95) 180
Device Options dialog box
(Windows 95) 173
dimensions of printer and optional
features 267
DOC Class B compliance viii
documents. See also files; printing or
specific topic
icons for (Mac OS) 137, 139
PostScript language descriptions
of 162
printing with Mac OS–based
computers 125–146
printing with Windows applications
147–156
printing with Windows 95– and
Windows NT–based computers
167–182
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Index

problems printing 201–204. See also
troubleshooting
saving as PostScript, EPS, or PDF
files (Mac OS) 135
setting margins in (Windows 95) 170
sorting list of (Mac OS) 143
DOS-based computers
connecting to 25–26
printing instructions for 147–165
setting printer up for 51
DOS PostScript driver, installing 51
double-sided printing. See
duplex printing
downloading fonts
in Mac OS 127, 226–227
in Windows 3.1 and DOS 156–159
dragging document icon to desktop
printer icon (Mac OS) 139
duplex printing
Mac OS and 130, 134–135
memory requirements for 114
supported paper sizes for 114
troubleshooting 203
Windows 95 and 171
duplex printing unit
paper jams in 199–200
paper types and sizes for 267

E
Edit Watermark dialog box (Windows)
156, 165, 177
Encapsulated PostScript (EPS) files
printing (Windows) 162
saving documents as (Mac OS) 135
Encapsulated PostScript option
(Windows 95) 175
energy, conserving 1, 27
with Mac OS 230
with Windows 247
envelope cassette 2, 184–187
envelopes
addressing 184
jams and wrinkling 200

printing 183–187
quality of 10
sizes and weights of 266
stacking in multipurpose tray 183
warning about 184
environmental information 268
EPS files
printing (Windows) 162
saving documents as (Mac OS) 135
Error Handling option
in Mac OS 137
in Windows 154
errors. See also troubleshooting
reporting (Mac OS) 136–137
wait time before reporting
(Windows 95) 180
Ethernet address, printing
(Windows) 248
Ethernet AUI adapter 22, 23
Ethernet cable 6, 22, 23
Ethernet network, connecting to 22–24
Ethernet port 18, 23, 273
Ethernet thin coaxial transceiver 23
Ethernet twisted-pair transceiver 23
EtherTalk 22
EtherTalk network zones
setting 38, 236–239
setting IP address for 39
exterior of printer, cleaning 190
external hard disks, adding to the printer
111–113

F
FCC compliance vii
Features tab dialog box (Windows) 153
files. See also documents
ASCII files, saving documents as
(Mac OS) 135
binary files, saving documents as
(Mac OS) 135
converting files to PostScript
format 42

EPS files (Mac OS) 135
EPS files (Windows) 162
PDF files (Mac OS) 135
PostScript files (Mac OS) 130, 135,
139, 240–241
PostScript files (Windows) 135,
162–165, 248
PostScript Printer Description (PPD)
files 270–271
Finder (Mac OS), printing without
leaving 137
FinePrint
in Mac OS 132–133
in Windows 95 173
“First page from” option (Mac OS) 129
500-sheet feeder and cassette. See also
paper cassette
paper jams in 197–198
paper types and sizes for 266
switching between multipurpose tray
and 174
using as preferred paper source 120
fixing roller assembly 189
flashing lights 194, 205, 259–260
Flip Horizontal option (Mac OS) 127
Flip Vertical option (Mac OS) 127
font inclusion (Mac OS) 135
fonts
downloading manually to RAM or to a
hard disk (Windows) 158–159
downloading to printer or attached
hard disk (Mac OS) 226–227
downloading (Windows 3.1 and DOS)
111, 156–159
installing (Windows, DOS,
NetWare) 85
PostScript (Windows 95) 178
printing samples of (Mac OS) 228
printing samples of (Windows) 246
removing (Mac OS) 227
specifications for 263
storing on hard disk 111
substituting (Mac OS) 127
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TrueType, controlling printing of
(Windows) 152, 178
types supported 1
Fonts dialog box (Windows 95) 178
Fonts tab dialog box (Windows) 152
font substitution, controlling
(Windows 95) 178
Font Substitution Table
(Windows 95) 178
foreground printing (Mac OS) 135–136
format, controlling (Windows 95) 175

G
gateway address, setting default
(TCP/IP) 106
General tab dialog box
(Windows 95) 179
Get Printer Info command (Mac OS) 143
graphics
bitmapped graphics, aligning
(Mac OS) 127
problems printing (NetWare) 214
smoothing (Mac OS) 132–133
troubleshooting 201
Graphics tab dialog box
(Windows 95) 172
grayscale documents, printing
(Mac OS) 132
grayscale images
printing (Mac OS) 130
troubleshooting 201
grounding 3

H
hard disks
adding to devices list (Windows 3.1
and DOS) 159–160
adding to the printer 111–113
downloading fonts to (Mac OS)
226–227
initializing (Mac OS) 225–226
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initializing (Windows 3.1 and
DOS) 161
using (Windows 3.1 and DOS)
159–161
Hold Job button (Mac OS) 142
HP-UX version 9.x–based workstations,
configuring 98–100

I
IBM AIX version 3.x–based
workstations, configuring
100–102
IBM PC or compatible computers,
troubleshooting 211–212. See
also Windows-based computers
and related topics
imaging options
Mac OS 130, 233–234
Windows 249–250
indicator lights. See lights
initializing hard disk connected to the
printer (Mac OS) 225–226
ink. See toner
Installer program (Mac OS) 33–35
installing fonts 85
installing memory 113–118
installing printer software for Mac OS–
based computers 30–35
from CD-ROM disc 30–33
from floppy disks 33–34
installing printer software for UNIX
workstations or TCP/IP
users 87
installing printer software for
Windows 95, Windows NT, and
Windows 3.1 51–70
creating floppy disks from CD-ROM
disc 58–59
installing from CD-ROM disc 51–57
installing from floppy disks 59–69
installing on a server for users to share
58–69

installing onto a Windows NT 3.5x
server or non-Intel computer
69–70
installing printer software from a server
(Mac OS) 44–45
installing toner cartridge 6–9
Invert Image option (Mac OS) 127
IP address
assigning to the printer 88–92
assigning using a RARP or BOOTP
server 92
assigning with Mac OS utilities
39, 91
assigning with ping method 88–91
assigning with Windows utilities 91
changing (Mac OS) 237
for BOOTP servers 88, 92
for RARP servers 88, 92
how the printer obtains during normal
operation 89
obtaining for the printer 88
problems with 88
viewing or changing 105–106

J, K
Job Control tab dialog box
(Windows) 154
job handling (Mac OS) 235–236

L
Landscape orientation (Windows) 148
laser information viii, 261
LaserWriter Utility for Windows. See
Apple LaserWriter Utility for
Windows
Layout option (Mac OS) 130
LEF orientation 10
length guide 12

letterhead paper
loading into cassette 15
loading into multipurpose tray 17
License Agreement 30–31
lights
flashing 259–260
location of 26
purpose of 194
troubleshooting with 205
loading paper 9–17
into cassette 11–16
into multipurpose tray 16–17
LocalTalk connecting kit 6, 19, 21
LocalTalk connector box 21
LocalTalk network
connecting to 19–20
setting IP address for 39
LocalTalk port 18, 19, 21, 273
long-edge feed (LEF) orientation 10

M
Macintosh OS–based computers
Apple Printer Utility for 220–241
changing printer setup for 43
choosing printer for 25–27
configuring printer for 44, 119–120,
220–241
connecting directly to a single
computer 21–22
Desktop Printer Utility and 40–43
envelope cassette and 186
installing printer software for 30–35
installing printer software from a
server 44–46
multipurpose tray and 185
naming printer and setting zones
for 38
printing envelopes on 184
printing with. See printing with
Mac OS–based computers
setting up for TCP/IP 39
setting up the printer for 29–47
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system requirements for 29
troubleshooting 205–210
maintenance 189–190
manual feed alert (Mac OS) 143, 210
margins, setting (Windows 95) 170
marking engine 261
mean time between failure (MTBF) 263
memory
specifications for 271
upgrading 113–118
Microsoft Network, sharing printers
over 181
More Paper Options dialog box
(Windows 95) 171
multiplatform support 1
multiple pages on one sheet
(Mac OS) 130
multipurpose tray
capacity of 9, 16
closing 17
loading 16–17
opening 7, 16
paper types and sizes for 265
printing envelopes from 183–185
setting program to print with 185
stacking envelopes in 183
switching between 500-sheet paper
cassette and 174

N
naming the printer
in Mac OS 38, 224
on AppleTalk networks
(Windows) 243
NetWare
ATPS (AppleTalk Print Spooler)
mode for 72–73
initial NetWare 4.1 setup 72–84
operating modes for 72–75, 79–82
PostScript driver for NetWare clients
83–84
PSERVER mode for 72–73
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Index

RPRINTER mode for 72–73, 79–82
troubleshooting 213–214
NetWare Directory Services (NDS) 72
NetWare 3.x servers
configuring ATPS for the first time on
255–257
modifying ATPS configuration on
257–258
NetWare 4 servers, configuring ATPS for
the first time on 254–255
NetWare 4.1, initial setup for 72–84
assigning a password for the print
server 82–83
choosing an operating mode 72–75
setting up the PostScript printer driver
for NetWare clients 83–84
setting up the printer as a print server
(using PCONSOLE) 75–78
setting up the printer as a remote
printer (RPRINTER mode)
79–82
network path (Windows 95) 180
network printer, connecting to manually
(Windows) 251–252
network protocols 22–23
networks. See AppleTalk; Ethernet;
LocalTalk; NetWare; TCP/IP
network zones (Mac OS) 36, 38,
236–238
non-Intel computers, installing printer
software on 69–70
Novell NetWare. See NetWare

O
on/off switch 26–27
operating modes for NetWare
ATPS (AppleTalk Print Spooler)
mode 72–73
PSERVER mode 72–73
RPRINTER mode 72–73, 79–82
operation environment 268

Optimize for Portability option
(Windows 95) 175
Optimize for Speed option
(Windows 95) 175
options. See also specific option
dimensions of 267
installing 109–121
part numbers for 274
orientation. See paper orientation
“out of memory” message (Mac OS)
207–208
output format, controlling
(Windows 95) 175
ozone emission 272

P, Q
page count, printing (Windows) 251
page order (Mac OS) 130
Page Setup command (Windows) 148
Page Setup dialog box
Mac OS 126–127
Windows 167
page setup options
Mac OS 126–127
Windows 148
pages per sheet, choosing (Mac OS)
130, 134
paper
choosing 10
length of 13
letterhead 15, 17
loading into cassette 11–16
loading into multipurpose tray 16–17
problems with, avoiding 10–11. See
also troubleshooting
quality of 10
sizes of 264
three-hole punched 15, 17
width of 12
paper cassette. See also 500-sheet feeder
and cassette
capacity of 9, 11, 64

loading paper into 11–16
switching to another cassette
(Mac OS) 136–137
types and sizes of paper for 264
paper-handling options 2
Mac OS 231–233
Windows 244–246
Paper Jam light
location of 26
purpose of 194
paper jams 194–200
after initial setup 194
avoiding 13, 200
envelope jams 200
in duplex printing unit 199–200
in 500-sheet feeder and cassette
197–198
in printer 194–196
resetting printer after 196
wrinkled paper and 200
paper orientation
binding orientation (Mac OS)
134–135
Landscape (Windows) 148
LEF (long-edge feed) 10
Portrait (Windows) 148
Rotated Landscape (Windows) 150
SEF (short-edge feed) 10
selecting (Mac OS) 126
Paper Out light
location of 26
purpose of 26
paper size, selecting (Mac OS) 127
paper source, selecting (Mac OS) 129
Paper tab dialog box (Windows)
150, 169
paper trays
switching between (Windows 95) 174
troubleshooting 204
paper width guide 201
parallel interface cable 6
parallel port 18, 25, 51, 273
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password
for print servers (NetWare) 82–83
for TCP/IP Printer Configuration
Utility 107
PCONSOLE utility (DOS, NetWare)
assigning a password for the print
server with 82–83
purpose of 74
setting up printer as print server with
74–78
PDF files, saving documents as
(Mac OS) 135
PhotoGrade
Mac OS and 130, 132–133
memory requirements for 114, 134
supported paper sizes for 114, 134
Windows 95 and 173
ping assignment of IP address
88–91, 216
placement of printer 2
plugging in the printer 26
Portrait orientation (Windows) 148
ports
AAUI Ethernet port 18
adding (Windows 95) 180
Ethernet port 18, 23, 273
LocalTalk port 18, 19, 21, 273
location of 18
mapping to a network path
(Windows 95) 180
parallel port 18, 25, 273
printer port 21
removing from a network path
(Windows 95) 180
SCSI port 111
twisted–pair Ethernet port 18
PostScript
advanced PostScript options
(Windows 95) 176
printing PostScript files as text
(Mac OS) 139
PostScript driver
for NetWare clients 83–84
installing for DOS 51
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Index

PostScript error (Mac OS) 136
PostScript error handler (Windows) 154
PostScript files
printing to (Windows 3.1 and DOS)
162–165
saving documents as (Mac OS) 135
sending to printer (Mac OS) 240–241
sending to printer (Windows) 248
PostScript fonts 156–159
installing 85
specifying how to send 178
substituting for TrueType fonts 178
updating list of 178
PostScript format, converting files to 42
PostScript Header options
(Windows) 154
PostScript Level 2 features, controlling
(Windows) 151
PostScript Options (Mac OS) 126
PostScript output format options
(Windows 95) 175
PostScript Printer Description (PPD) files
270–271
PostScript printer driver 168, 211
PostScript printer driver options,
changing (Windows) 148–149
PostScript tab dialog box (Windows)
151, 175
PostScript 3 1
power
connecting 26
consumption of 1, 269
disconnecting 3
power switch 26–27
PPD files 270–271
Precision Bitmap Alignment option
(Mac OS) 127
print density
setting in Mac OS 229
setting in Windows 250
troubleshooting 202
Print dialog box
Mac OS 128, 208
Windows 147, 168

Printer menu (Mac OS), selecting new
printer from 140
printer driver options (Windows)
changing PostScript printer driver
default options 148–149
selecting printer options in the Setup
dialog box 150
printer driver Setup dialog box
(Windows) 148–149
printer icon, dragging documents to
(Mac OS) 137
printer information, viewing
(Mac OS) 223
printer materials, specifications for 263.
See also envelopes; paper;
transparencies
printer options, setting (Windows) 150,
168–169
printer port 21
printer settings
changing in Windows 95 169–181
changing in Windows NT 182
printer setup, changing (Mac OS) 143,
145–146
printer software
installing for Mac OS–based
computers 30–35
installing from server (Mac OS) 46
printer utilities. See Apple LaserWriter
Utility for Windows; Apple
Printer Utility for the Mac OS
Printer Utility for the Mac OS. See Apple
Printer Utility for the Mac OS
printing with Mac OS–based computers
125–146
background printing 134–135
printing cover page automatically 131
printing documents 128–130
printing envelopes 185–186
printing grayscale documents 132
printing on both sides of the paper
134–135
printing to a file 135
printing with a desktop printer
137–138

printing with FinePrint or PhotoGrade
132–133
printing with special effects 127–128
reporting errors 136–137
selecting page setup options 126–127
switching between printers 138–140
turning off or removing desktop
printing software 144–146
working with desktop printer icons
140–143
printing with Windows 95– and
Windows NT–based computers
167–182
changing printer settings in
Windows 95 169–181
printing documents 168
printing envelopes with 184, 186
printing from multipurpose tray 185
selecting page setup options 167
setting printing properties 168–169
printing with Windows 3.1– and
DOS–based computers 147–165
downloading fonts 156–159
printing envelopes with 184, 186
printing from DOS applications 165
printing from multipurpose tray 185
printing from Windows applications
147–156
printing to a PostScript file 162–165
Print on Both Sides option
(Mac OS) 134
print order, changing (Mac OS) 143
print quality, enhancing (Mac OS)
132–133
print queue
capturing for DOS printing 165
creating (NetWare) 80–82
print request (Mac OS)
canceling 142
indicating urgency of 142
moving from one printer to
another 143
putting on hold 142
setting print time for 142
Print Setup command (Windows) 148

Index
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print speed 1
print test (Mac OS) 38
print time, setting (Mac OS) 135–136,
142–143
problems. See troubleshooting
Program Manager (Windows) 158
Properties dialog box (Windows 95)
168–169, 174
protocols 22–23
PSERVER mode (NetWare) 72–73

R
radio and television interference vii
RAM
increasing 113–118
upgrade specifications for 271
RARP servers
failure to respond 214–215
IP address for 88, 92
Ready/In Use light
flashing 205, 214, 259–260
location of 26
purpose of 27
reliability (MTBF) 263
Remove button (Mac OS) 142
removing side cover 115
renaming
desktop printer icon (Mac OS) 140
printer on AppleTalk 38
reporting errors (Mac OS) 136–137
resetting communication settings to
default values (IBM PC or
compatible) 212
resetting printer after paper jams 196
resolution 1, 172
restarting the printer (Windows) 251
Resume Job button (Mac OS) 142
reversed image (Mac OS) 127
RPRINTER mode (NetWare) 72–73,
79–82
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Index

S
safety precautions
cleaning printer 190
electrical hazards, avoiding 4
general precautions 3–4
grounding 3
installing SIMMs 116
laser viii
maintenance 189
saving documents as PostScript, EPS, or
PDF files (Mac OS) 135
SCSI chain 111
SCSI hard disk 1, 111–113
SCSI ID number, setting 112–113
SCSI peripheral cable 111
SCSI port 111
SCSI system cable 111
SCSI terminator 111
SCSI voltage 111
SEF orientation 10
selecting printer
from the Printer menu or Control Strip
(Mac OS) 140
using Chooser (Mac OS) 139
using desktop printer icon
(Mac OS) 139
using Desktop Printer Utility
(Mac OS) 140
separator page between print jobs
(Windows 95) 179
servers. See specific type of server
service, indications of need for 194, 202
Set Print Time button (Mac OS) 142
setting imaging options with 249–250
setting up PostScript driver for NetWare
clients 83–84
setting up the printer
as ATPS remote printer 253–258
as print server (NetWare) 75–78
as remote printer (NetWare) 79–82
for DOS-based printing 51
for Mac OS users 29–47

for parallel port printing 51
for UNIX workstations or TCP/IP
users 87–108
for Windows, DOS, and NetWare
users 49–85
general instructions for 1–28
Setup dialog box (Windows) 149–150
Sharing tab dialog box
(Windows 95) 181
sheet feeder. See 500-sheet feeder and
cassette
short-edge feed (SEF) orientation 10
Show Manual Feed Alert command
(Mac OS) 143
side cover
removing 115
replacing 117
Silicon Graphics IRIX v5.3–based
workstations, configuring 102
SIMMs. See also memory
dimensions of 271
installing 115–117
removing 117
sizes and speeds of 271
SIMM slot 114–115
Smooth Graphics option (Mac OS) 127
smoothing text and graphics (Mac OS)
132–133
Smooth Text option (Mac OS) 127
software. See Apple LaserWriter Utility
for Windows; Apple Printer
Utility for the Mac OS;
printer software
sorting list of documents waiting to print
(Mac OS) 143
space requirements 268
special effects (Mac OS) 127–128
specifications 261–268
speed of print 1, 263
spreadsheets, problems printing
(NetWare) 214
Start Print Queue command
(Mac OS) 143

startup page 26
turning on or off (Mac OS) 228–229
turning on or off (Windows) 244
stationery, quality of 10
status lights. See lights
Stop Print Queue command
(Mac OS) 143
storage 268
subnet mask, setting (TCP/IP) 106
substituting fonts (Mac OS) 127
Sun OS version 4.1–based workstations,
configuring 95–97
Sun Solaris CDE–based workstations,
configuring 94
Sun Solaris OpenWindows–based
workstations, configuring
93–94
switching between printers (Mac OS)
138–140
system requirements
for Mac OS–based computers 29
for Windows 95 49
for Windows NT 50
for Windows 3.1 50

T
TCP/IP
configuring for Mac OS 237–238
configuring for Windows 248
configuring the printer for 102–108
Ethernet cable and 22
setting up for Mac OS 39
setting up for Windows 95 and
Windows NT 71
setting up the printer for 87–102
TCP/IP interface
displaying information about 104
resetting 107
TCP/IP Printer Configuration Utility
103–108
changing password for 107

Index
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displaying information about printer’s
TCP/IP interface with 104
enabling or disabling connection
timeout checking with 107
forgotten password for 214
logging in to 104
printing configuration page with 104
quitting 108
resetting printer’s TCP/IP interface
with 107
restoring settings to factory defaults
with 108
setting default gateway address with
106–107
setting subnet mask with 106
turning banner page on or off
with 105
viewing or changing printer’s IP
address with 105–106
television interference vii
telnet 103–104, 216
text, smoothing (Mac OS) 132–133
three-hole punched paper
loading into cassette 15
loading into multipurpose tray 17
timeout checking, enabling or disabling
(TCP/IP) 107
toner, smudged 204
toner cartridge
installing 6–9
life expectancy of 263
replacing 190
Toner Low light
location of 26
purpose of 194
top cover, closing 9
traffic control 1
transparencies 10
Trash, dragging desktop printer icon to
(Mac OS) 140
tray. See multipurpose tray
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troubleshooting
banner page prints only system name
and remote printer name
(UNIX) 214
blank document 202
blotchy areas 204
BOOTP server does not respond 215
can ping printer but can’t telnet
to it (UNIX) 216
can’t ping printer by IP name or IP
address (UNIX) 216
Chooser fails to appear in Apple menu
(Mac OS) 205
desktop printer icon has X drawn
through it (Mac OS) 210
desktop printer icon reappears after
dragging to Trash
(Mac OS) 209
desktop printer icons appear as folders
(Mac OS) 209
Desktop Printer Utility cannot be
found (Mac OS) 207
desktop printing software needs more
memory (Mac OS) 210
document doesn’t print 39
duplex printing 203
envelope jams 194
faded areas or white voids 204
flashing lights 194, 205
garbled print (IBM PC or
compatible) 212
garbled print (NetWare) 213
ghost images 204
grayscale art 201
image is too dark 202
image is too light 202
image prints black and white instead
of color or grayscale 202
images out of place 201
IP address 88
LaserWriter 8 icon fails to appear in
Chooser (Mac OS) 206
lights, meaning of 194

lines or stripes on page 203
manual feed message, turning on or
off (Mac OS) 210
message on screen says printer can’t
print (IBM PC or
compatible) 211
message on screen says printer can’t
print (Mac OS) 209
NetWare printer name doesn’t appear
in Apple LaserWriter Utility’s
list of printers to configure 213
nothing is printed (NetWare) 213
nothing is printed; no paper comes out
of printer (IBM PC or
compatible) 211
nothing is printed; no paper comes out
of printer (Mac OS) 208–209
“out of memory” message appears
when you try to print (Mac OS)
207–208
page prints solid black 202
paper curls 201
paper is not taken from correct tray
when AutoSelect is turned on
(Mac OS) 206
Paper Jam light is on 194
paper jams after initial setup 194
paper jams in duplex printing unit
199–200
paper jams in 500-sheet feeder and
cassette 197–198
paper jams in printer 194–196
Paper Out light is on 194
paper problems, avoiding 10–11
print appears on only part of
paper 201
print density 202
printer administrator forgot password
to TCP/IP Printer Configuration
Utility (UNIX) 214
printer appears more than once in
Chooser (Mac OS) 207

printer doesn’t print from correct
paper tray 204
printer is not listed in Chooser or
Desktop Printer Utility
(Mac OS) 206
printer-specific options don’t appear
in Print dialog box
(Mac OS) 208
printing first page takes longer than
expected (IBM PC or
compatible) 212
printing first page takes longer than
expected (Mac OS) 209
printing first page takes longer than
expected (UNIX) 214
print is off-center 201
RARP server does not respond
(UNIX) 214–215
Ready/In Use light flashes 194
Ready/In Use light flashes amber and
green 205
Ready/In Use light flashes briefly, but
nothing prints (UNIX) 214
Ready/In Use light is off 194
spreadsheets and graphics, problems
printing (NetWare) 214
toner does not stay fixed 201
Toner Low light is on 194
toner needs to be redistributed 202
toner smudges 204
UNIX workstations 214–216
unwanted characters are displayed
(IBM PC or compatible) 212
unwanted characters are displayed
(NetWare) 213
wavy or distorted image 203
wrinkled paper and envelopes 200
TrueType fonts
controlling printing of
(Windows) 152
specifying how to send
(Windows 95) 178
substituting PostScript fonts for 178

Index
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turning on the printer 27
twisted-pair cable 23
twisted-pair Ethernet port 18
twisted-pair Ethernet 22
two-sided printing. See duplex printing

U
UNIX workstations
A/UX-based, configuring 92
BSD-based, configuring 95–97
configuring 93–102
HP-UX 9.x–based, configuring
98–100
IBM AIX version 3.x–based,
configuring 100–102
initial TCP/IP setup for 87–102
setting up the printer for 87–108
Silicon Graphics IRIX v5.3–based,
configuring 102
Sun OS version 4.1–based,
configuring 95–97
Sun Solaris CDE–based,
configuring 94
Sun Solaris OpenLook–based,
configuring 93–94
troubleshooting 214–216
Unlimited Downloadable Fonts option
(Mac OS) 127
unpacking the printer 4–6
Unprintable Area button
(Windows 95) 170
using a hard disk 159–161
utilities. See Apple LaserWriter Utility
for Windows; Apple Printer
Utility for the Mac OS

V
voltage requirements 269
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Index

W, X, Y
watermarks, defining, editing, and
deleting (Windows) 155–156
Watermark tab dialog box
(Windows) 155
weight of printer 4, 268
width guide 201
Windows applications, printing from
147–156
selecting page options 148
selecting printer options 150–156
setting printer driver options 148–149
Windows-based computers. See also
Windows 95-based computers;
Windows NT-based computers;
Windows 3.1-based computers
configuring the printer from 242–252
connecting to 25–26
Windows 95–based computers
changing printer settings in 169–181
configuring the printer from 121
envelope cassette and 186
initial TCP/IP setup for 71
installing printer software for 51–70
multipurpose tray and 185
printing envelopes on 184
printing with. See printing with
Windows 95– and
Windows NT–based computers
system requirements for 49
Windows NT–based computers
changing printer settings in 182
configuring the printer from 121
envelope cassette and 186
initial TCP/IP setup for 71
installing printer software for 51–70
multipurpose tray and 185
printing envelopes on 184
printing with. See printing with
Windows 95– and
Windows NT–based computers
system requirements for 50

Windows NT 3.5x server, installing
printer software onto 69
Windows Page Setup dialog box 148
Windows 3.1–based computers
configuring the printer from 121
envelope cassette and 186
installing printer software for 51–70
multipurpose tray and 185
printing envelopes on 184
printing with. See printing with
Windows 3.1– and
DOS–based computers
system requirements for 50
workstations. See UNIX workstations or
specific type of
UNIX workstation

Z
zones. See network zones
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Communications regulation information
FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.
You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)
If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.
IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.

Communications Regulation Information
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DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.
Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.

Laser information
WARNING Making adjustments or performing procedures other than those specified in your

equipment’s manual may result in hazardous radiation exposure.
WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in

this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider.
Your printer is a Class 1 laser product. The Class 1 label, located in a user-accessible area,
indicates that the printer meets minimum safety requirements. A service warning label is
located in a service-accessible area. The labels on your product may differ slightly from the
ones shown here.

Class 1 label
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Laser Information

Service warning label

Setting Up the Printer
Chapter 1

Setting Up the LaserWriter 8500

Chapter 2

Setting Up the Printer for Mac OS Users

Chapter 3

Setting Up the Printer for Windows, DOS,
and NetWare Users

Chapter 4

Setting Up the Printer for UNIX Workstations
or TCP/IP Users

Chapter 5

Installing Options

Part I of this book provides the information you need to
set up the printer for your workgroup.
If you want to use a printer that has already been set up,
see Part II.
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